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Installing


Boards Manager

This is the suggested installation method for end users.


Prerequisites


	Internet connection


	Arduino IDE 1.x or 2.x (https://www.arduino.cc/en/software)


	(macOS/Linux only) Python ≥3.7 (https://python.org)







Instructions


	Start Arduino and open Preferences window.


	Enter
https://arduino.esp8266.com/stable/package_esp8266com_index.json
into Additional Board Manager URLs field. You can add multiple
URLs, separating them with commas.


	Open Boards Manager from Tools > Board menu and find esp8266
platform.


	Select the version you need from a drop-down box.


	Click install button.


	Don’t forget to select your ESP8266 board from Tools > Board menu
after installation.




For more information on the Arduino Board Manager, see:


	https://www.arduino.cc/en/guide/cores









Using git version

This is the suggested installation method for contributors and library
developers.


Prerequisites


	Internet connection


	Arduino IDE 1.x or 2.x (https://www.arduino.cc/en/software)


	git (https://git-scm.com)


	Python ≥3.7 (https://python.org)


	terminal, console, or command prompt (depending on your OS)


	Uninstalling any core version installed via Board Manager







Instructions - Windows 10


	First, make sure you don’t already have an ESP8266 core version installed
using the Board Manager (see above). If you do, uninstall it from the
Board Manager before proceeding. It is also advisable to erase the Arduino15
contents.


	Install git for Windows (if not already; see https://git-scm.com/download/win)


	Open a command prompt (cmd) and go to Arduino default directory. This is typically the
sketchbook directory (usually C:\Users\{username}\Documents\Arduino where the environment variable %USERPROFILE% usually contains C:\Users\{username})


	Clone this repository into hardware/esp8266com/esp8266 directory.

cd %USERPROFILE%\Documents\Arduino\
if not exist hardware mkdir hardware
cd hardware
if not exist esp8266com mkdir esp8266com
cd esp8266com
git clone https://github.com/esp8266/Arduino.git esp8266





You should end up with the following directory structure in

C:\Users\{your username}\Documents\

Arduino
|
--- libraries
--- hardware
    |
    --- esp8266com
        |
        --- esp8266
            |
            --- bootloaders
            --- cores
            --- doc
            --- libraries
            --- package
            --- tests
            --- tools
            --- variants
            --- platform.txt
            --- programmers.txt
            --- README.md
            --- boards.txt
            --- LICENSE







	Initialize submodules to fetch external libraries

cd %USERPROFILE%\Documents\Arduino\hardware\esp8266com\esp8266
git submodule update --init










Not doing this step would cause build failure when attempting to include SoftwareSerial.h, Ethernet.h, etc.
See our .gitmodules file [https://github.com/esp8266/Arduino/blob/master/.gitmodules] for the full list.





	Download binary tools

cd tools
python3 get.py







	Restart Arduino


	If using the Arduino IDE for Visual Studio (https://www.visualmicro.com/), be sure to click Tools - Visual Micro - Rescan Toolchains and Libraries


	When later updating your local library, goto the esp8266 directory and do a git pull

cd %USERPROFILE%\Documents\Arduino\hardware\esp8266com\esp8266
git status
git pull









Note that you could, in theory install in C:\Program Files (x86)\Arduino\hardware however this has security implications, not to mention the directory often gets blown away when re-installing Arduino IDE. It does have the benefit (or drawback, depending on your perspective) - of being available to all users on your PC that use Arduino.




Instructions - Other OS


	First, make sure you don’t already have an ESP8266 core version installed
using the Board Manager (see above). If you do, uninstall it from the
Board Manager before proceeding. It is also advisable to erase the .arduino15 (Linux)
or Arduino15 (MacOS) contents.


	Open the console and go to Arduino directory. This can be either your
sketchbook directory (usually <Documents>/Arduino), or the
directory of Arduino application itself, the choice is up to you.


	Clone this repository into hardware/esp8266com/esp8266 directory.
Alternatively, clone it elsewhere and create a symlink, if your OS
supports them.

cd hardware
mkdir esp8266com
cd esp8266com
git clone https://github.com/esp8266/Arduino.git esp8266





You should end up with the following directory structure:

Arduino
|
--- hardware
    |
    --- esp8266com
        |
        --- esp8266
            |
            --- bootloaders
            --- cores
            --- doc
            --- libraries
            --- package
            --- tests
            --- tools
            --- variants
            --- platform.txt
            --- programmers.txt
            --- README.md
            --- boards.txt
            --- LICENSE







	Initialize submodules to fetch external libraries

cd esp8266
git submodule update --init










Not doing this step would cause build failure when attempting to include SoftwareSerial.h, Ethernet.h, etc.
See our .gitmodules file [https://github.com/esp8266/Arduino/blob/master/.gitmodules] for the full list.





	Download binary tools

cd tools
python3 get.py










If you get an error message stating that python3 is not found, you will need to install it (most modern UNIX-like OSes provide Python 3 as
part of the default install).  To install you will need to use sudo yum install python3, sudo apt install python3, or brew install python3
as appropriate.  On the Mac you may get an error message like:


python3 get.py
Platform: x86_64-apple-darwin
Downloading python3-macosx-placeholder.tar.gz
Traceback (most recent call last):
  File "/Library/Frameworks/Python.framework/Versions/3.7/lib/python3.7/urllib/request.py", line 1317, in do_open
    encode_chunked=req.has_header('Transfer-encoding'))
  ...
  File "/Library/Frameworks/Python.framework/Versions/3.7/lib/python3.7/ssl.py", line 1117, in do_handshake
    self._sslobj.do_handshake()
ssl.SSLCertVerificationError: [SSL: CERTIFICATE_VERIFY_FAILED] certificate verify failed: unable to get local issuer certificate (_ssl.c:1056)








This is because Homebrew on the Mac does not always install the required SSL certificates by default.  Install them manually (adjust the Python 3.7 as needed) with:


cd "/Applications/Python 3.7/" && sudo "./Install Certificates.command"












	Restart Arduino


	When later updating your local library, goto the esp8266 directory and do a git pull

cd hardware\esp8266com\esp8266
git status
git pull












Maintaining

To keep up with the development branch

git switch --recurse-submodules --discard-changes master
git pull --recurse-submodules
cd tools
python3 get.py








Pull requests

To test not yet merged Pull Request, first you have to find its ID number. This is the sequence of digits right after the pull request title.

Open terminal and cd into the directory where the repository was previously cloned. For example, 12345 is the Pull Request ID

git fetch origin pull/12345/head
git switch --detach --recurse-submodules --discard-changes FETCH_HEAD





When Pull Request updates packaged tools, make sure to also fetch their latest versions.

cd tools
python3 get.py





To go back to using the development branch

git switch --recurse-submodules --discard-changes master
git pull --recurse-submodules










Using PlatformIO

PlatformIO [https://platformio.org?utm_source=arduino-esp8266]
is an open source ecosystem for IoT development with a cross-platform
build system, a library manager, and full support for Espressif
(ESP8266) development. It works on the following popular host operating
systems: macOS, Windows, Linux 32/64, and Linux ARM (like Raspberry Pi,
BeagleBone, CubieBoard).


	What is PlatformIO? [https://docs.platformio.org/en/latest/what-is-platformio.html?utm_source=arduino-esp8266]


	PlatformIO IDE [https://platformio.org/platformio-ide?utm_source=arduino-esp8266]


	PlatformIO Core [https://docs.platformio.org/en/latest/core.html?utm_source=arduino-esp8266] (command line tool)


	Advanced usage [https://docs.platformio.org/en/latest/platforms/espressif8266.html?utm_source=arduino-esp8266] - custom settings, uploading to LittleFS, Over-the-Air (OTA), staging version


	Using Arduino Framework Staging Version [https://docs.platformio.org/en/stable/platforms/espressif8266.html?utm_source=arduino-esp8266#using-arduino-framework-with-staging-version] - install development version of the Core


	Integration with Cloud and Standalone IDEs [https://docs.platformio.org/en/latest/ide.html?utm_source=arduino-esp8266] - Cloud9, Codeanywhere, Eclipse Che (Codenvy), Atom, CLion, Eclipse, Emacs, NetBeans, Qt Creator, Sublime Text, VIM, Visual Studio, and VSCode


	Project Examples [https://docs.platformio.org/en/latest/platforms/espressif8266.html?utm_source=arduino-esp8266#examples]










            

          

      

      

    

  

    
      
          
            
  
esp8266 configuration


Overview

There are a number of specific options for esp8266 in the Arduino IDE Tools
menu.  Not all of them are available for every board.  If one is needed and
not visible, please try using the generic esp8266 or esp8285 board.

In every menu entry, the first option is the default one and is suitable for
most users (except for flash size in the generic ESP8266 board).




Note about PlatformIO

PlatformIO specific documentation [https://docs.platformio.org/en/latest/platforms/espressif8266.html#espressif-8266]
is also available.  Note that this link is available here for reference and
is not maintained by the esp8266 Arduino core platform team.




Arduino IDE Tools Menu


Board

Most of the time there is only one type of ESP8266 chip and only one type of
ESP8285(1M) chip shipped with hardware or DIY boards.  Capabilities are the
same everywhere.  Hardware devices differ only on routed GPIO and external
components.

If a specific hardware is not available in this list, “Generic ESP82xx”
always work.




Upload Speed

This the UART speed setup for flashing the ESP.  It is not related with the
UART(Serial) speed programmed from inside the sketch, if enabled.  Default
values are legacy.  The highest speed option (around 1Mbaud) should always
work.  For specific boards, defaults can be updated using the board.txt
generator.




CPU Frequency

Any ESP82xx can run at 80 or 160MHz.




Crystal Frequency

This is the on-board crystal frequency (26 or 40Mhz).  Default is 26MHz.
But the chip was designed with 40MHz.  It explains the default strange 74880
baud rate at boot, which is 115200*26/40 (115200 being quite a lot used
by default nowadays).




Flash Size

With the Arduino core, ESP82xx can use at most 1MB to store the main sketch
in flash memory.

ESP8285 has 1MB internal flash capacity.  ESP8266 is always shipped with an
external flash chip that is most often 1MB (esp01, esp01s, lots of
commercial appliances), 4MB (DIY boards like wemos/lolin D1 mini or nodemcu)
or 16MB (lolin D1 mini pro).  But configurations with 2MB and 8MB also
exist.  This core is also able to use older 512KB chips that are today not
much used and officially deprecated by Espressif.

Flash space is divided into 3 main zones.  The first is the user program
space, 1MB at most.  The second is enough space for the OTA ability.  The
third, the remaining space, can be used to hold a filesystem (LittleFS).

This list proposes many different configurations.  In the generic board
list, the first one of each size is the default and suitable for many cases.

Example: 4MB (FS:2MB OTA:~1019KB):


	4MB is the flash chip size (= 4 MBytes, sometimes oddly noted 32Mbits)


	OTA:~1019KB (around 1MB) is used for Over The Air flashing (note that OTA binary can be gzip-ed)


	FS:2MB means that 2MBytes are used for an internal filesystem (LittleFS).







Flash Mode

There are four options.  The most compatible and slowest is DOUT.  The
fasted is QIO.  ESP8266 mcu is able to use any of these modes, but
depending on the flash chips capabilities and how it is connected to the
esp8266, the fastest mode may not be working.  Note that ESP8285 requires
the DOUT mode.

Here is some more insights about that in esp32 forums [https://www.esp32.com/viewtopic.php?t=1250#p5523].




Reset Method


On some boards (commonly NodeMCU, Lolin/Wemos) an electronic trick allows to
use the UART DTR line to reset the esp8266 and put it in flash mode.  This
is the default dtr (aka nodemcu) option.  It provides an extra-easy way of
flashing from serial port.

When not available, the no dtr option can be
used in conjunction with a flash button on the board (or by driving the ESP
dedicated GPIOs to boot in flash mode at power-on).






Debug Port

There are three UART options:


	disabled


	Serial


	Serial1




When on Serial or Serial1 options (see
reference), messages are sent at 74880 bauds at
boot time then baud rate is changed to user configuration in sketch.  These
messages are generated by the internal bootloader.  Subsequent serial data
are coming either from the firmware, this Arduino core, and user application.




Debug Level

There are a number of options.


	The first (None) is explained by itself.


	The last (NoAssert - NDEBUG) is even quieter than the first (some
internal guards are skipped to save more flash).


	The other ones may be used when asked by a maintainer or if you are a
developer trying to debug some issues.







Debug Optimization

Due to the limited resources on the device, our default compiler optimizations
focus on creating the smallest code size (.bin file). That is fine for
release but not ideal for debugging.

Debug Optimization use to improve Exception Decoder results.


	Lite impact on code size uses -fno-optimize-sibling-calls to alter
the -Os compiler option to place more caller addresses on the Stack.


	Optimum offers better quality stack content for the Exception Decoder at
the expense of a larger code size. It uses the -Og compiler option, which
turns off optimizations that can make debugging difficult while keeping
others.


	None no changes for debugging continue using -Os.




Take note some sketches may start working after changing the optimization. Or
fail less often. And it is also possible (not likely) that source code that
was working with -Os may break with -Og.

For more topic depth, read Improving Exception Decoder Results




lwIP variant

lwIP [https://en.wikipedia.org/wiki/LwIP] is the internal network
software stack.  It is highly configurable and comes with features that can
be enabled, at the price of RAM or FLASH space usage.

There are 6 variants.  As always, the first and default option is a good
compromise.  Note that cores v2.x were or could be using the lwIP-v1 stack.
Only lwIP-v2 is available on cores v3+.


	v2 Lower Memory

This is lwIP-v2 with MSS=536 bytes.  MSS is TCP’s Maximum Segment Size,
and different from MTU (IP’s Maximum Transfer Unit) which is always 1480
in our case.
Using such value for MSS is 99.9% compatible with any TCP peers, allows to
store less data in RAM, and is consequently slower when transmitting large
segments of data (using TCP) because of a larger overhead and latency due to
smaller payload and larger number of packets.

UDP and other IP protocols are not affected by MSS value.



	v2 Higher Bandwidth

When streaming large amount of data, prefer this option.  It uses more
memory (MSS=1460) so it allows faster transfers thanks to a smaller number
of packets providing lower overhead and higher bandwidth.



	… (no features)

Disabled features to get more flash space and RAM for users are:


	No IP Forwarding (=> no NAT),


	No IP Fragmentation and reassembly,


	No AutoIP (not getting 169.254.x.x on DHCP request when there is no DHCP answer),


	
No SACK-OUT (= no Selective ACKnowledgements for OUTput):

no better stability with long distance TCP transfers,





	No listen backlog (no protection against DOS attacks for TCP server).






	IPv6 …

With these options, IPv6 is enabled, with features.  It uses about 20-30KB
of supplementary flash space.








VTable location

This is the mechanism used in C++ to support dynamic dispatch of virtual
methods.  By default these tables are stored in flash to save precious RAM
bytes, but in very specific cases they can be stored in Heap space, or IRAM
space (both in RAM).




C++ Exceptions


	C++ exceptions are disabled by default.  Consequently the new
operator will cause a general failure and a reboot when memory is full.

Note that the C-malloc function always returns nullptr when
memory is full.



	Enabled: on this Arduino core, exceptions are possible.  Note that they
are quite ram and flash consuming.







Stack protection


	This is disabled by default


	When Enabled, the compiler generated extra code to check for stack
overflows.  When this happens, an exception is raised with a message and
the ESP reboots.







Erase Flash


	Only sketch: When WiFi is enabled at boot and persistent WiFi
credentials are enabled, these data are preserved across flashings.
Filesystem is preserved.


	Sketch + WiFi settings: persistent WiFi settings are not
preserved accross flashings. Filesystem is preserved.


	All Flash: WiFi settings and Filesystems are erased.







NONOS SDK Version

Our Core is based on [Espressif NONOS SDK](https://github.com/espressif/ESP8266_NONOS_SDK).


	2.2.1+100 (190703) (default)


	2.2.1+119 (191122)


	2.2.1+113 (191105)


	2.2.1+111 (191024)


	2.2.1+61 (190313)


	2.2.1 (legacy)


	3.0.5 (experimental)




See our issue tracker in regards to default version selection.


	#6724 (comment) [https://github.com/esp8266/Arduino/pull/6724#issuecomment-556243781]


	#6826 [https://github.com/esp8266/Arduino/pull/6826]




Notice that 3.x.x is provided as-is and remains experimental.




SSL Support

The first and default choice (All SSL ciphers) is good.  The second
option enables only the main ciphers and can be used to lower flash
occupation.




MMU (Memory Management Unit)

Head to its specific documentation.  Note that there is an option
providing an additional 16KB of IRAM to your application which can be used
with new and malloc.




Non-32-Bit Access

On esp82xx architecture, DRAM can be accessed byte by byte, but read-only
flash space (PROGMEM variables) and IRAM cannot.  By default they can
only be safely accessed in a compatible way using special macros
pgm_read_some().

With the non-default option Byte/Word access, an exception manager
allows to transparently use them as if they were byte-accessible.  As a
result, any type of access works but in a very slow way for the usually
illegal ones.  This mode can also be enabled from the MMU options.









            

          

      

      

    

  

    
      
          
            
  
Reference


Interrupts

Interrupts can be used on the ESP8266, but they must be used with care
and have several limitations:


	Interrupt callback functions must be in IRAM, because the flash may be
in the middle of other operations when they occur.  Do this by adding
the IRAM_ATTR attribute on the function definition.  If this
attribute is not present, the sketch will crash when it attempts to
attachInterrupt with an error message.




IRAM_ATTR void gpio_change_handler(void *data) {...






	Interrupts must not call delay() or yield(), or call any routines
which internally use delay() or yield() either.


	Long-running (>1ms) tasks in interrupts will cause instabilty or crashes.
WiFi and other portions of the core can become unstable if interrupts
are blocked by a long-running interrupt.  If you have much to do, you can
set a volatile global flag that your main loop() can check each pass
or use a scheduled function (which will be called outside of the interrupt
context when it is safe) to do long-running work.


	Heap API operations can be dangerous and should be avoided in interrupts.
Calls to malloc should be minimized because they may require a long
running time if memory is fragmented.  Calls to realloc and free
must NEVER be called. Using any routines or objects which call free or
realloc themselves is also forbidden for the same reason. This means
that String, std::string, std::vector and other classes which
use contiguous memory that may be resized must be used with extreme care
(ensuring strings aren’t changed, vector elements aren’t added, etc.).
The underlying problem, an allocation address could be actively in use at
the instant of an interrupt. Upon return, the address actively in use may
be invalid after an ISR uses realloc or free against the same
allocation.


	The C++ new and delete operators must NEVER be used in an ISR. Their
call path is not in IRAM. Using any routines or objects that use the new
or delete operator is also forbidden.







Digital IO

Pin numbers in Arduino correspond directly to the ESP8266 GPIO pin
numbers. pinMode, digitalRead, and digitalWrite functions
work as usual, so to read GPIO2, call digitalRead(2).

Digital pins 0—15 can be INPUT, OUTPUT, or INPUT_PULLUP. Pin
16 can be INPUT, OUTPUT or INPUT_PULLDOWN_16. At startup,
pins are configured as INPUT.

Pins may also serve other functions, like Serial, I2C, SPI. These
functions are normally activated by the corresponding library. The
diagram below shows pin mapping for the popular ESP-12 module.


[image: Pin Functions]
Pin Functions



Digital pins 6—11 are not shown on this diagram because they are used to
connect flash memory chip on most modules. Trying to use these pins as
IOs will likely cause the program to crash.

Note that some boards and modules (ESP-12ED, NodeMCU 1.0) also break out
pins 9 and 11. These may be used as IO if flash chip works in DIO mode
(as opposed to QIO, which is the default one).

Pin interrupts are supported through attachInterrupt,
detachInterrupt functions. Interrupts may be attached to any GPIO
pin, except GPIO16. Standard Arduino interrupt types are supported:
CHANGE, RISING, FALLING. ISRs need to have
IRAM_ATTR before the function definition.




Analog input

NOTE:
Calling analogRead() too frequently causes WiFi to stop working.  When
WiFi is under operation, analogRead() result may be cached for at least
5ms between effective calls.

ESP8266 has a single ADC channel available to users. It may be used
either to read voltage at ADC pin, or to read module supply voltage
(VCC).

To read external voltage applied to ADC pin, use analogRead(A0).
Input voltage range of bare ESP8266 is 0 — 1.0V, however some
boards may implement voltage dividers. To be on the safe side, <1.0V
can be tested. If e.g. 0.5V delivers values around ~512, then maximum
voltage is very likely to be 1.0V and 3.3V may harm the ESP8266.
However values around ~150 indicates that the maximum voltage is
likely to be 3.3V.

To read VCC voltage, use ESP.getVcc() and ADC pin must be kept
unconnected. Additionally, the following line has to be added to the
sketch:

ADC_MODE(ADC_VCC);





This line has to appear outside of any functions, for instance right
after the #include lines of your sketch.




Analog output

analogWrite(pin, value) enables software PWM on the given pin. PWM
may be used on pins 0 to 16. Call analogWrite(pin, 0) to disable PWM
on the pin.

value may be in range from 0 to 255 (which is the Arduino default).
PWM range may be changed by calling analogWriteRange(new_range) or
analogWriteResolution(bits).  new_range may be from 15…65535
or bits may be from 4…16.

The function analogWriteMode(pin, value, openDrain) allows to sets
the pin mode to OUTPUT_OPEN_DRAIN instead of OUTPUT.

NOTE: The default analogWrite range was 1023 in releases before
3.0, but this lead to incompatibility with external libraries which
depended on the Arduino core default of 256.  Existing applications which
rely on the prior 1023 value may add a call to analogWriteRange(1023)
to their setup() routine to return to their old behavior.  Applications
which already were calling analogWriteRange need no change.

PWM frequency is 1kHz by default. Call
analogWriteFreq(new_frequency) to change the frequency. Valid values
are from 100Hz up to 40000Hz.

The ESP doesn’t have hardware PWM, so the implementation is by software.
With one PWM output at 40KHz, the CPU is already rather loaded. The more
PWM outputs used, and the higher their frequency, the closer you get to
the CPU limits, and the fewer CPU cycles are available for sketch execution.




Timing and delays

millis() and micros() return the number of milliseconds and
microseconds elapsed after reset, respectively.

delay(ms) pauses the sketch for a given number of milliseconds and
allows WiFi and TCP/IP tasks to run. delayMicroseconds(us) pauses
for a given number of microseconds.

Remember that there is a lot of code that needs to run on the chip
besides the sketch when WiFi is connected. WiFi and TCP/IP libraries get
a chance to handle any pending events each time the loop() function
completes, OR when delay is called. If you have a loop somewhere in
your sketch that takes a lot of time (>50ms) without calling delay,
you might consider adding a call to delay function to keep the WiFi
stack running smoothly.

There is also a yield() function which is equivalent to
delay(0). The delayMicroseconds function, on the other hand,
does not yield to other tasks, so using it for delays more than 20
milliseconds is not recommended.




Serial

The Serial object works much the same way as on a regular Arduino. Apart
from the hardware FIFO (128 bytes for TX and RX), Serial has an
additional customizable 256-byte RX buffer. The size of this software buffer can
be changed by the user. It is suggested to use a bigger size at higher receive speeds.

The ::setRxBufferSize(size_t size) method changes the RX buffer size as needed. This
should be called before ::begin(). The size argument should be at least large enough
to hold all data received before reading.

For transmit-only operation, the 256-byte RX buffer can be switched off to save RAM by
passing mode SERIAL_TX_ONLY to Serial.begin(). Other modes are SERIAL_RX_ONLY and
SERIAL_FULL (the default).

Receive is interrupt-driven, but transmit polls and busy-waits. Blocking behavior is as follows:
The ::write() call does not block if the number of bytes fits in the current space available
in the TX FIFO. The call blocks if the TX FIFO is full and waits until there is room before
writing more bytes into it, until all bytes are written. In other words, when the call returns,
all bytes have been written to the TX FIFO, but that doesn’t mean that all bytes have been sent
out through the serial line yet.
The ::read() call doesn’t block, not even if there are no bytes available for reading.
The ::readBytes() call blocks until the number of bytes read complies with the number of
bytes required by the argument passed in.
The ::flush() call blocks waiting for the TX FIFO to be empty before returning. It is
recommended to call this to make sure all bytes have been sent before doing configuration changes
on the serial port (e.g. changing baudrate) or doing a board reset.

Serial uses UART0, which is mapped to pins GPIO1 (TX) and GPIO3
(RX). Serial may be remapped to GPIO15 (TX) and GPIO13 (RX) by calling
Serial.swap() after Serial.begin. Calling swap again maps
UART0 back to GPIO1 and GPIO3.

Serial1 uses UART1, TX pin is GPIO2. UART1 can not be used to
receive data because normally it’s RX pin is occupied for flash chip
connection. To use Serial1, call Serial1.begin(baudrate).

If Serial1 is not used and Serial is not swapped - TX for UART0
can be mapped to GPIO2 instead by calling Serial.set_tx(2) after
Serial.begin or directly with
Serial.begin(baud, config, mode, 2).

By default the diagnostic output from WiFi libraries is disabled when
you call Serial.begin. To enable debug output again, call
Serial.setDebugOutput(true). To redirect debug output to Serial1
instead, call Serial1.setDebugOutput(true).

You also need to use Serial.setDebugOutput(true) to enable output
from printf() function.

Both Serial and Serial1 objects support 5, 6, 7, 8 data bits,
odd (O), even (E), and no (N) parity, and 1 or 2 stop bits. To set the
desired mode, call Serial.begin(baudrate, SERIAL_8N1),
Serial.begin(baudrate, SERIAL_6E2), etc.
Default configuration mode is SERIAL_8N1. Possibilities are SERIAL_[5678][NEO][12].
Example: SERIAL_8N1 means 8bits No parity 1 stop bit.

A new method has been implemented on both Serial and Serial1 to
get current baud rate setting. To get the current baud rate, call
Serial.baudRate(), Serial1.baudRate(). Return a int of
current speed. For example

// Set Baud rate to 57600
Serial.begin(57600);

// Get current baud rate
int br = Serial.baudRate();

// Will print "Serial is 57600 bps"
Serial.printf("Serial is %d bps", br);






Serial and Serial1 objects are both instances of the
HardwareSerial class.

This is also done for official ESP8266 Software
Serial
library, see this pull
request [https://github.com/plerup/espsoftwareserial/pull/22].

Note that this implementation is only for ESP8266 based boards,
and will not works with other Arduino boards.



To detect an unknown baudrate of data coming into Serial use Serial.detectBaudrate(time_t timeoutMillis). This method tries to detect the baudrate for a maximum of timeoutMillis ms. It returns zero if no baudrate was detected, or the detected baudrate otherwise. The detectBaudrate() function may be called before Serial.begin() is called, because it does not need the receive buffer nor the SerialConfig parameters.

The uart can not detect other parameters like number of start- or stopbits, number of data bits or parity.

The detection itself does not change the baudrate, after detection it should be set as usual using Serial.begin(detectedBaudrate).

Detection is very fast, it takes only a few incoming bytes.

SerialDetectBaudrate.ino is a full example of usage.




Progmem

The Program memory features work much the same way as on a regular
Arduino; placing read only data and strings in read only memory and
freeing heap for your application.

In core versions prior to 2.7, the important difference is that on the
ESP8266 the literal strings are not pooled.  This means that the same
literal string defined inside a F("") and/or PSTR("") will take up
space for each instance in the code.  So you will need to manage the
duplicate strings yourself.

Starting from v2.7, this is no longer true: duplicate literal strings within
r/o memory are now handled.

There is one additional helper macro to make it easier to pass
const PROGMEM strings to methods that take a __FlashStringHelper
called FPSTR(). The use of this will help make it easier to pool
strings. Not pooling strings…

String response1;
response1 += F("http:");
...
String response2;
response2 += F("http:");





using FPSTR would become…

const char HTTP[] PROGMEM = "http:";
...
{
    String response1;
    response1 += FPSTR(HTTP);
    ...
    String response2;
    response2 += FPSTR(HTTP);
}








C++


	About C++ exceptions, operator new, and Exceptions menu option

The C++ standard says the following about the new operator behavior when encountering heap shortage (memory full):


	has to throw a std::bad_alloc C++ exception when they are enabled


	will abort() otherwise




There are several reasons for the first point above, among which are:


	guarantee that the return of new is never a nullptr


	guarantee full construction of the top level object plus all member subobjects


	guarantee that any subobjects partially constructed get destroyed, and in the correct order, if oom is encountered midway through construction




When C++ exceptions are disabled, or when using new(nothrow), the above guarantees can’t be upheld, so the second point (abort()) above is the only std::c++ viable solution.

Historically in Arduino environments, new is overloaded to simply return the equivalent malloc() which in turn can return nullptr.

This behavior is not C++ standard, and there is good reason for that: there are hidden and very bad side effects. The class and member constructors are always called, even when memory is full (this == nullptr).
In addition, the memory allocation for the top object could succeed, but allocation required for some member object could fail, leaving construction in an undefined state.
So the historical behavior of Ardudino’s new, when faced with insufficient memory, will lead to bad crashes sooner or later, sometimes unexplainable, generally due to memory corruption even when the returned value is checked and managed.
Luckily on esp8266, trying to update RAM near address 0 will immediately raise an hardware exception, unlike on other uC like avr on which that memory can be accessible.

As of core 2.6.0, there are 3 options: legacy (default) and two clear cases when new encounters oom:


	new returns nullptr, with possible bad effects or immediate crash when constructors (called anyway) initialize members (exceptions are disabled in this case)


	C++ exceptions are disabled: new calls abort() and will “cleanly” crash, because there is no way to honor memory allocation or to recover gracefully.


	C++ exceptions are enabled: new throws a std::bad_alloc C++ exception, which can be caught and handled gracefully.
This assures correct behavior, including handling of all subobjects, which guarantees stability.




History: #6269 [https://github.com/esp8266/Arduino/issues/6269] #6309 [https://github.com/esp8266/Arduino/pull/6309] #6312 [https://github.com/esp8266/Arduino/pull/6312]








Streams

Arduino API


Stream is one of the core classes in the Arduino API.  Wire, serial, network and
filesystems are streams, from which data are read or written.

Making a transfer with streams is quite common, like for example the
historical WiFiSerial sketch:

//check clients for data
//get data from the telnet client and push it to the UART
while (serverClient.available()) {
  Serial.write(serverClient.read());
}

//check UART for data
if (Serial.available()) {
  size_t len = Serial.available();
  uint8_t sbuf[len];
  Serial.readBytes(sbuf, len);
  //push UART data to all connected telnet clients
  if (serverClient && serverClient.connected()) {
    serverClient.write(sbuf, len);
  }
}





One will notice that in the network to serial direction, data are transferred
byte by byte while data are available.  In the other direction, a temporary
buffer is created on stack, filled with available serial data, then
transferred to network.

The readBytes(buffer, length) method includes a timeout to ensure that
all required bytes are received.  The write(buffer, length) (inherited
from Print::) function is also usually blocking until the full buffer is
transmitted. Both functions return the number of transmitted bytes.

That’s the way the Stream class works and is commonly used.

Classes derived from Stream:: also usually introduce the read(buffer,
len) method, which is similar to readBytes(buffer, len) without
timeout: the returned value can be less than the requested size, so special
care must be taken with this function, introduced in the Arduino
Client:: class (cf. AVR reference implementation).
This function has also been introduced in other classes
that don’t derive from Client::, e.g.  HardwareSerial::.




Stream extensions


Stream extensions are designed to be compatible with Arduino API, and
offer additional methods to make transfers more efficient and easier to
use.

The serial to network transfer above can be written like this:

serverClient.sendAvailable(Serial); // chunk by chunk
Serial.sendAvailable(serverClient); // chunk by chunk





An echo service can be written like this:

serverClient.sendAvailable(serverClient); // tcp echo service

Serial.sendAvailable(Serial);             // serial software loopback





Beside reducing coding time, these methods optimize transfers by avoiding
buffer copies when possible.


	User facing API: Stream::send()

The goal of streams is to transfer data between producers and consumers,
like the telnet/serial example above.  Four methods are provided, all of
them return the number of transmitted bytes:


	Stream::sendSize(dest, size [, timeout])

This method waits up to the given or default timeout to transfer
size bytes to the the dest Stream.



	Stream::sendUntil(dest, delim [, timeout])

This method waits up to the given or default timeout to transfer data
until the character delim is met.
Note: The delimiter is read but not transferred (like readBytesUntil)



	Stream::sendAvailable(dest)

This method transfers all already available data to the destination.
There is no timeout and the returned value is 0 when there is nothing
to transfer or no room in the destination.



	Stream::sendAll(dest [, timeout])

This method waits up to the given or default timeout to transfer all
available data.  It is useful when source is able to tell that no more
data will be available for this call, or when destination can tell
that it will no be able to receive anymore.

For example, a source String will not grow during the transfer, or a
particular network connection supposed to send a fixed amount of data
before closing.  ::sendAll() will receive all bytes.  Timeout is
useful when destination needs processing time (e.g.  network or serial
input buffer full = please wait a bit).







	String, flash strings helpers

Two additional classes are provided.


	StreamConstPtr:: is designed to hold a constant buffer (in ram or flash).

With this class, a Stream:: can be made from const char*,
F("some words in flash") or PROGMEM strings.  This class makes
no copy, even with data in flash.  For flash content, byte-by-byte
transfers is a consequence when “memcpy_P” cannot be used.  Other
contents can be transferred at once when possible.

StreamConstPtr css(F("my long css data")); // CSS data not copied to RAM
server.sendAll(css);







	S2Stream:: is designed to make a Stream:: out of a String:: without copy.

String helloString("hello");
S2Stream hello(helloString);
hello.reset(0);        // prevents ::read() to consume the string

hello.sendAll(Serial); // shows "hello"
hello.sendAll(Serial); // shows nothing, content has already been read
hello.reset();         // reset content pointer
hello.sendAll(Serial); // shows "hello"
hello.reset(3);        // reset content pointer to a specific position
hello.sendAll(Serial); // shows "lo"

hello.setConsume();    // ::read() will consume, this is the default
Serial.println(helloString.length()); // shows 5
hello.sendAll(Serial);                // shows "hello"
Serial.println(helloString.length()); // shows 0, string is consumed





StreamString:: derives from S2Stream

StreamString contentStream;
client.sendSize(contentStream, SOME_SIZE); // receives at most SOME_SIZE bytes

// equivalent to:

String content;
S2Stream contentStream(content);
client.sendSize(contentStream, SOME_SIZE); // receives at most SOME_SIZE bytes
// content has the data











	Internal Stream API: peekBuffer

Here is the method list and their significations.  They are currently
implemented in HardwareSerial, WiFiClient and
WiFiClientSecure.


	virtual bool hasPeekBufferAPI () returns true when the API is present in the class


	virtual size_t peekAvailable () returns the number of reachable bytes


	virtual const char* peekBuffer () returns the pointer to these bytes

This API requires that any kind of "read" function must not be called after peekBuffer()
and until peekConsume() is called.



	virtual void peekConsume (size_t consume) tells to discard that number of bytes


	virtual bool inputCanTimeout ()

A StringStream will return false. A closed network connection returns false.
This function allows Stream::sendAll() to return earlier.



	virtual bool outputCanTimeout ()

A closed network connection returns false.
This function allows Stream::sendAll() to return earlier.



	virtual ssize_t streamRemaining()

It returns -1 when stream remaining size is unknown, depending on implementation
(string size, file size..).


















            

          

      

      

    

  

    
      
          
            
  
Libraries


WiFi (ESP8266WiFi library)

ESP8266WiFi library has been developed basing on ESP8266 SDK, using naming convention and overall functionality philosophy of the Arduino WiFi Shield library [https://www.arduino.cc/en/Reference/WiFi]. Over time the wealth Wi-Fi features ported from ESP8266 SDK to this library outgrew the APIs of WiFi Shield library and it became apparent that we need to provide separate documentation on what is new and extra.

ESP8266WiFi library documentation




Ticker

Library for calling functions repeatedly with a certain period. Three examples [https://github.com/esp8266/Arduino/tree/master/libraries/Ticker/examples] included.

It is currently not recommended to do blocking IO operations (network, serial, file) from Ticker callback functions. Instead, set a flag inside the ticker callback and check for that flag inside the loop function.

Here is library to simplificate Ticker usage and avoid WDT reset:
TickerScheduler [https://github.com/Toshik/TickerScheduler]




EEPROM

This is a bit different from standard EEPROM class. You need to call EEPROM.begin(size) before you start reading or writing, size being the number of bytes you want to use. Size can be anywhere between 4 and 4096 bytes.

EEPROM.write does not write to flash immediately, instead you must call EEPROM.commit() whenever you wish to save changes to flash. EEPROM.end() will also commit, and will release the RAM copy of EEPROM contents.

EEPROM library uses one sector of flash located just after the embedded filesystem.

Three examples [https://github.com/esp8266/Arduino/tree/master/libraries/EEPROM]  included.

Note that the sector needs to be re-flashed every time the changed EEPROM data needs to be saved, thus will wear out the flash memory very quickly even if small amounts of data are written. Consider using one of the EEPROM libraries mentioned down below.




I2C (Wire library)

Wire library currently supports master mode up to approximately 450KHz. Before using I2C, pins for SDA and SCL need to be set by calling Wire.begin(int sda, int scl), i.e. Wire.begin(0, 2) on ESP-01, else they default to pins 4(SDA) and 5(SCL).




SPI

SPI library supports the entire Arduino SPI API including transactions, including setting phase (CPHA). Setting the Clock polarity (CPOL) is not supported, yet (SPI_MODE2 and SPI_MODE3 not working).

The usual SPI pins are:


	MOSI = GPIO13


	MISO = GPIO12


	SCLK = GPIO14




There’s an extended mode where you can swap the normal pins to the SPI0 hardware pins.
This is enabled  by calling SPI.pins(6, 7, 8, 0) before the call to SPI.begin(). The pins would
change to:


	MOSI = SD1


	MISO = SD0


	SCLK = CLK


	HWCS = GPIO0




This mode shares the SPI pins with the controller that reads the program code from flash and is
controlled by a hardware arbiter (the flash has always higher priority). For this mode the CS
will be controlled by hardware as you can’t handle the CS line with a GPIO, you never actually
know when the arbiter is going to grant you access to the bus so you must let it handle CS
automatically.




SoftwareSerial

An ESP8266 port of SoftwareSerial library done by Peter Lerup (@plerup) supports baud rate up to 115200 and multiples SoftwareSerial instances. See https://github.com/plerup/espsoftwareserial if you want to suggest an improvement or open an issue related to SoftwareSerial.




ESP-specific APIs

Some ESP-specific APIs related to deep sleep, RTC and flash memories are available in the ESP object.

ESP.deepSleep(microseconds, mode) will put the chip into deep sleep. mode is one of WAKE_RF_DEFAULT, WAKE_RFCAL, WAKE_NO_RFCAL, WAKE_RF_DISABLED. (GPIO16 needs to be tied to RST to wake from deepSleep.) The chip can sleep for at most ESP.deepSleepMax() microseconds. If you implement deep sleep with WAKE_RF_DISABLED and require WiFi functionality on wake up, you will need to implement an additional WAKE_RF_DEFAULT before WiFi functionality is available.

ESP.deepSleepInstant(microseconds, mode) works similarly to ESP.deepSleep but  sleeps instantly without waiting for WiFi to shutdown.

ESP.rtcUserMemoryWrite(offset, &data, sizeof(data)) and ESP.rtcUserMemoryRead(offset, &data, sizeof(data)) allow data to be stored in and retrieved from the RTC user memory of the chip respectively. offset is measured in blocks of 4 bytes and can range from 0 to 127 blocks (total size of RTC memory is 512 bytes). data should be 4-byte aligned. The stored data can be retained between deep sleep cycles, but might be lost after power cycling the chip. Data stored in the first 32 blocks will be lost after performing an OTA update, because they are used by the Core internals.

ESP.restart() restarts the CPU.

ESP.getResetReason() returns a String containing the last reset reason in human readable format.

ESP.getFreeHeap() returns the free heap size.

ESP.getHeapFragmentation() returns the fragmentation metric (0% is clean, more than ~50% is not harmless)

ESP.getMaxFreeBlockSize() returns the largest contiguous free RAM block in the heap, useful for checking heap fragmentation.  NOTE: Maximum malloc() -able block will be smaller due to memory manager overheads.

ESP.getChipId() returns the ESP8266 chip ID as a 32-bit integer.

ESP.getCoreVersion() returns a String containing the core version.

ESP.getSdkVersion() returns the SDK version as a char.

ESP.getCpuFreqMHz() returns the CPU frequency in MHz as an unsigned 8-bit integer.

ESP.getSketchSize() returns the size of the current sketch as an unsigned 32-bit integer.

ESP.getFreeSketchSpace() returns the free sketch space as an unsigned 32-bit integer.

ESP.getSketchMD5() returns a lowercase String containing the MD5 of the current sketch.

ESP.getFlashChipId() returns the flash chip ID as a 32-bit integer.

ESP.getFlashChipSize() returns the flash chip size, in bytes, as seen by the SDK (may be less than actual size).

ESP.getFlashChipRealSize() returns the real chip size, in bytes, based on the flash chip ID.

ESP.getFlashChipSpeed(void) returns the flash chip frequency, in Hz.

ESP.getCycleCount() returns the cpu instruction cycle count since start as an unsigned 32-bit. This is useful for accurate timing of very short actions like bit banging.

ESP.random() should be used to generate true random numbers on the ESP. Returns an unsigned 32-bit integer with the random number. An alternate version is also available that fills an array of arbitrary length. Note that it seems as though the WiFi needs to be enabled to generate entropy for the random numbers, otherwise pseudo-random numbers are used.

ESP.checkFlashCRC() calculates the CRC of the program memory (not including any filesystems) and compares it to the one embedded in the image.  If this call returns false then the flash has been corrupted.  At that point, you may want to consider trying to send a MQTT message, to start a re-download of the application, blink a LED in an SOS pattern, etc.  However, since the flash is known corrupted at this point there is no guarantee the app will be able to perform any of these operations, so in safety critical deployments an immediate shutdown to a fail-safe mode may be indicated.

ESP.getVcc() may be used to measure supply voltage. ESP needs to reconfigure the ADC at startup in order for this feature to be available. Add the following line to the top of your sketch to use getVcc:

ADC_MODE(ADC_VCC);





TOUT pin has to be disconnected in this mode.

Note that by default ADC is configured to read from TOUT pin using analogRead(A0), and ESP.getVCC() is not available.




mDNS and DNS-SD responder (ESP8266mDNS library)

Allows the sketch to respond to multicast DNS queries for domain names like “foo.local”, and DNS-SD (service discovery) queries. See attached example for details.




SSDP responder (ESP8266SSDP)

SSDP is another service discovery protocol, supported on Windows out of the box. See attached example for reference.




DNS server (DNSServer library)

Implements a simple DNS server that can be used in both STA and AP modes. The DNS server currently supports only one domain (for all other domains it will reply with NXDOMAIN or custom status code). With it, clients can open a web server running on ESP8266 using a domain name, not an IP address.




Servo

This library exposes the ability to control RC (hobby) servo motors. It will support up to 24 servos on any available output pin. By default the first 12 servos will use Timer0 and currently this will not interfere with any other support. Servo counts above 12 will use Timer1 and features that use it will be affected. While many RC servo motors will accept the 3.3V IO data pin from a ESP8266, most will not be able to run off 3.3v and will require another power source that matches their specifications. Make sure to connect the grounds between the ESP8266 and the servo motor power supply.




Other libraries (not included with the IDE)

Libraries that don’t rely on low-level access to AVR registers should work well. Here are a few libraries that were verified to work:


	Adafruit_ILI9341 [https://github.com/Links2004/Adafruit_ILI9341] - Port of the Adafruit ILI9341 for the ESP8266


	arduinoVNC [https://github.com/Links2004/arduinoVNC] - VNC Client for Arduino


	arduinoWebSockets [https://github.com/Links2004/arduinoWebSockets] - WebSocket Server and Client compatible with ESP8266 (RFC6455)


	aREST [https://github.com/marcoschwartz/aREST] - REST API handler library.


	Blynk [https://github.com/blynkkk/blynk-library] - easy IoT framework for Makers (check out the Kickstarter page [https://tiny.cc/blynk-kick]).


	DallasTemperature [https://github.com/milesburton/Arduino-Temperature-Control-Library.git]


	DHT-sensor-library [https://github.com/adafruit/DHT-sensor-library] - Arduino library for the DHT11/DHT22 temperature and humidity sensors. Download latest v1.1.1 library and no changes are necessary. Older versions should initialize DHT as follows: DHT dht(DHTPIN, DHTTYPE, 15)


	DimSwitch [https://github.com/krzychb/DimSwitch] - Control electronic dimmable ballasts for fluorescent light tubes remotely as if using a wall switch.


	Encoder [https://github.com/PaulStoffregen/Encoder] - Arduino library for rotary encoders. Version 1.4 supports ESP8266.


	esp8266_mdns [https://github.com/mrdunk/esp8266_mdns] - mDNS queries and responses on esp8266. Or to describe it another way: An mDNS Client or Bonjour Client library for the esp8266.


	ESP-NOW [https://github.com/yoursunny/WifiEspNow] - Wrapper lib for ESP-NOW (See #2227 [https://github.com/esp8266/Arduino/issues/2227])


	ESPAsyncTCP [https://github.com/me-no-dev/ESPAsyncTCP] - Asynchronous TCP Library for ESP8266 and ESP32/31B


	ESPAsyncWebServer [https://github.com/me-no-dev/ESPAsyncWebServer] - Asynchronous Web Server Library for ESP8266 and ESP32/31B


	Homie for ESP8266 [https://github.com/marvinroger/homie-esp8266] - Arduino framework for ESP8266 implementing Homie, an MQTT convention for the IoT.


	NeoPixel [https://github.com/adafruit/Adafruit_NeoPixel] - Adafruit’s NeoPixel library, now with support for the ESP8266 (use version 1.0.2 or higher from Arduino’s library manager).


	NeoPixelBus [https://github.com/Makuna/NeoPixelBus] - Arduino NeoPixel library compatible with ESP8266. Use the “DmaDriven” or “UartDriven” branches for ESP8266. Includes HSL color support and more.


	PubSubClient [https://github.com/Imroy/pubsubclient] - MQTT library by @Imroy.


	RTC [https://github.com/Makuna/Rtc] - Arduino Library for Ds1307 & Ds3231 compatible with ESP8266.


	Souliss, Smart Home [https://github.com/souliss/souliss] - Framework for Smart Home based on Arduino, Android and openHAB.


	ST7735 [https://github.com/nzmichaelh/Adafruit-ST7735-Library] - Adafruit’s ST7735 library modified to be compatible with ESP8266. Just make sure to modify the pins in the examples as they are still AVR specific.


	Task [https://github.com/Makuna/Task] - Arduino Nonpreemptive multitasking library. While similar to the included Ticker library in the functionality provided, this library was meant for cross Arduino compatibility.


	TickerScheduler [https://github.com/Toshik/TickerScheduler] - Library provides simple scheduler for Ticker to avoid WDT reset


	Teleinfo [https://github.com/hallard/LibTeleinfo] - Generic French Power Meter library to read Teleinfo energy monitoring data such as consuption, contract, power, period, … This library is cross platform, ESP8266, Arduino, Particle, and simple C++. French dedicated post [https://hallard.me/libteleinfo/] on author’s blog and all related information about Teleinfo [https://hallard.me/category/tinfo/] also available.


	UTFT-ESP8266 [https://github.com/gnulabis/UTFT-ESP8266] - UTFT display library with support for ESP8266. Only serial interface (SPI) displays are supported for now (no 8-bit parallel mode, etc). Also includes support for the hardware SPI controller of the ESP8266.


	WiFiManager [https://github.com/tzapu/WiFiManager] - WiFi Connection manager with web captive portal. If it can’t connect, it starts AP mode and a configuration portal so you can choose and enter WiFi credentials.


	OneWire [https://github.com/PaulStoffregen/OneWire] - Library for Dallas/Maxim 1-Wire Chips.


	Adafruit-PCD8544-Nokia-5110-LCD-Library [https://github.com/WereCatf/Adafruit-PCD8544-Nokia-5110-LCD-library] - Port of the Adafruit PCD8544 - library for the ESP8266.


	PCF8574_ESP [https://github.com/WereCatf/PCF8574_ESP] - A very simplistic library for using the PCF857//PCF8574A I2C 8-pin GPIO-expander.


	Dot Matrix Display Library 2 [https://github.com/freetronics/DMD2] - Freetronics DMD & Generic 16 x 32 P10 style Dot Matrix Display Library


	SdFat-beta [https://github.com/greiman/SdFat-beta] - SD-card library with support for long filenames, software- and hardware-based SPI and lots more.


	FastLED [https://github.com/FastLED/FastLED] - a library for easily & efficiently controlling a wide variety of LED chipsets, like the Neopixel (WS2812B), DotStar, LPD8806 and many more. Includes fading, gradient, color conversion functions.


	OLED [https://github.com/klarsys/esp8266-OLED] - a library for controlling I2C connected OLED displays. Tested with 0.96 inch OLED graphics display.


	MFRC522 [https://github.com/miguelbalboa/rfid] - A library for using the Mifare RC522 RFID-tag reader/writer.


	Ping [https://github.com/dancol90/ESP8266Ping] - lets the ESP8266 ping a remote machine.


	AsyncPing [https://github.com/akaJes/AsyncPing] - fully asynchronous Ping library (have full ping statistic and hardware MAC address).


	ESP_EEPROM [https://github.com/jwrw/ESP_EEPROM] - This library writes a new copy of your data when you save (commit) it and keeps track of where in the sector the most recent copy is kept using a bitmap. The flash sector only needs to be erased when there is no more space for copies in the flash sector.


	EEPROM Rotate [https://github.com/xoseperez/eeprom_rotate] - Instead of using a single sector to persist the data from the emulated EEPROM, this library uses a number of sectors to do so: a sector pool.










            

          

      

      

    

  

    
      
          
            
  
Filesystem


Flash layout

Even though file system is stored on the same flash chip as the program,
programming new sketch will not modify file system contents. This allows
to use file system to store sketch data, configuration files, or content
for Web server.

The following diagram illustrates flash layout used in Arduino
environment:

|--------------|-------|---------------|--|--|--|--|--|
^              ^       ^               ^     ^
Sketch    OTA update   File system   EEPROM  WiFi config (SDK)





File system size depends on the flash chip size. Depending on the board
which is selected in IDE, the following table shows options for flash size.

Another option called Mapping defined by Hardware and Sketch is available.
It allows a sketch, not the user, to select FS configuration at boot
according to flash chip size.

This option is also enabled with this compilation define: -DFLASH_MAP_SUPPORT=1.

There are three possible configurations:


	FLASH_MAP_OTA_FS: largest available space for onboard FS, allowing OTA (noted ‘OTA’ in the table)


	FLASH_MAP_MAX_FS: largest available space for onboard FS (noted ‘MAX’ in the table)


	FLASH_MAP_NO_FS: no onboard FS




Sketch can invoke a particular configuration by adding this line:

FLASH_MAP_SETUP_CONFIG(FLASH_MAP_OTA_FS)
void setup () { ... }
void loop () { ... }












	Board

	Flash chip size (bytes)

	File system size (bytes)





	Any

	512KBytes

	32KB(OTA), 64KB, 128KB(MAX)



	Any

	1MBytes

	64KB(OTA), 128KB, 144KB, 160KB, 192KB, 256KB, 512KB(MAX)



	Any

	2MBytes

	64KB, 128KB, 256KB(OTA), 512KB, 1MB(MAX)



	Any

	4MBytes

	1MB, 2MB(OTA), 3MB(MAX)



	Any

	8MBytes

	6MB(OTA), 7MB(MAX)



	Any

	16MBytes

	14MB(OTA), 15MB(MAX)






Note: to use any of file system functions in the sketch, add the
following include to the sketch:

//#include "FS.h" // SPIFFS is declared
#include "LittleFS.h" // LittleFS is declared
//#include "SDFS.h" // SDFS is declared








SPIFFS Deprecation Warning

SPIFFS is currently deprecated and may be removed in future releases of
the core.  Please consider moving your code to LittleFS.  SPIFFS is not
actively supported anymore by the upstream developer, while LittleFS is
under active development, supports real directories, and is many times
faster for most operations.




SPIFFS and LittleFS

There are two filesystems for utilizing the onboard flash on the ESP8266:
SPIFFS and LittleFS.

SPIFFS is the original filesystem and is ideal for space and RAM
constrained applications that utilize many small files and care
about static and dynamic wear levelling and don’t need true directory
support.  Filesystem overhead on the flash is minimal as well.

LittleFS is recently added and focuses on higher performance and
directory support, but has higher filesystem and per-file overhead
(4K minimum vs. SPIFFS’ 256 byte minimum file allocation unit).

They share a compatible API but have incompatible on-flash
implementations, so it is important to choose one or the other per project
as attempting to mount a SPIFFS volume under LittleFS may result
in a format operation and definitely will not preserve any files,
and vice-versa.

The actual File and Dir objects returned from either
filesystem behave in the same manner and documentation is applicable
to both.  To convert most applications from SPIFFS to LittleFS
simply requires changing the SPIFFS.begin() to LittleFS.begin()
and SPIFFS.open() to LittleFS.open() with the rest of the
code remaining untouched.




SDFS and SD

FAT filesystems are supported on the ESP8266 using the old Arduino wrapper
“SD.h” which wraps the “SDFS.h” filesystem transparently.

Any commands discussed below pertaining to SPIFFS or LittleFS are
applicable to SD/SDFS.

For legacy applications, the classic SD filesystem may continue to be used,
but for new applications, directly accessing the SDFS filesystem is
recommended as it may expose additional functionality that the old Arduino
SD filesystem didn’t have.

Note that in earlier releases of the core, using SD and SPIFFS in the same
sketch was complicated and required the use of NO_FS_GLOBALS.  The
current design makes SD, SDFS, SPIFFS, and LittleFS fully source compatible
and so please remove any NO_FS_GLOBALS definitions in your projects
when updgrading core versions.




SPIFFS file system limitations

The SPIFFS implementation for ESP8266 had to accommodate the
constraints of the chip, among which its limited RAM.
SPIFFS [https://github.com/pellepl/spiffs] was selected because it
is designed for small systems, but that comes at the cost of some
simplifications and limitations.

First, behind the scenes, SPIFFS does not support directories, it just
stores a “flat” list of files. But contrary to traditional filesystems,
the slash character '/' is allowed in filenames, so the functions
that deal with directory listing (e.g. openDir("/website"))
basically just filter the filenames and keep the ones that start with
the requested prefix (/website/). Practically speaking, that makes
little difference though.

Second, there is a limit of 32 chars in total for filenames. One
'\0' char is reserved for C string termination, so that leaves us
with 31 usable characters.

Combined, that means it is advised to keep filenames short and not use
deeply nested directories, as the full path of each file (including
directories, '/' characters, base name, dot and extension) has to be
31 chars at a maximum. For example, the filename
/website/images/bird_thumbnail.jpg is 34 chars and will cause some
problems if used, for example in exists() or in case another file
starts with the same first 31 characters.

Warning: That limit is easily reached and if ignored, problems might
go unnoticed because no error message will appear at compilation nor
runtime.

For more details on the internals of SPIFFS implementation, see the
SPIFFS readme
file [https://github.com/esp8266/Arduino/blob/master/cores/esp8266/spiffs/README.md].




LittleFS file system limitations

The LittleFS implementation for the ESP8266 supports filenames of up
to 31 characters + terminating zero (i.e. char filename[32]), and
as many subdirectories as space permits.

Filenames are assumed to be in the root directory if no initial “/” is
present.

Opening files in subdirectories requires specifying the complete path to
the file (i.e. open("/sub/dir/file.txt");).  Subdirectories are
automatically created when you attempt to create a file in a subdirectory,
and when the last file in a subdirectory is removed the subdirectory
itself is automatically deleted.  This is because there was no mkdir()
method in the existing SPIFFS filesystem.

Unlike SPIFFS, the actual file descriptors are allocated as requested
by the application, so in low memory conditions you may not be able to
open new files.  Conversely, this also means that only file descriptors
used will actually take space on the heap.

Because there are directories, the openDir method behaves differently
than SPIFFS.  Whereas SPIFFS will return files in “subdirectories” when
you traverse a Dir::next() (because they really aren’t subdirs but
simply files with “/”s in their names), LittleFS will only return files
in the specific subdirectory.  This mimics the POSIX behavior for
directory traversal most C programmers are used to.




Uploading files to file system

ESP8266FS is a tool which integrates into the Arduino IDE. It adds a
menu item to Tools menu for uploading the contents of sketch data
directory into ESP8266 flash file system.

Warning: Due to the move from the obsolete esptool-ck.exe to the
supported esptool.py upload tool, upgraders from pre 2.5.1 will need to
update the ESP8266FS tool referenced below to 0.5.0 or later.  Prior versions
will fail with a “esptool not found” error because they don’t know how to
use esptool.py.


	Download the tool: https://github.com/esp8266/arduino-esp8266fs-plugin/releases/download/0.5.0/ESP8266FS-0.5.0.zip


	In your Arduino sketchbook directory, create tools directory if
it doesn’t exist yet.


	Unpack the tool into tools directory (the path will look like
<home_dir>/Arduino/tools/ESP8266FS/tool/esp8266fs.jar)
If upgrading, overwrite the existing JAR file with the newer version.


	Restart Arduino IDE.


	Open a sketch (or create a new one and save it).


	Go to sketch directory (choose Sketch > Show Sketch Folder).


	Create a directory named data and any files you want in the file
system there.


	Make sure you have selected a board, port, and closed Serial Monitor.


	If your board requires you to press a button (or other action) to enter
bootload mode for flashing a sketch, do that now.


	Select Tools > ESP8266 Sketch Data Upload. This should start
uploading the files into ESP8266 flash file system. When done, IDE
status bar will display SPIFFS Image Uploaded message.




ESP8266LittleFS is the equivalent tool for LittleFS.


	Download the 2.6.0 or later version of the tool: https://github.com/earlephilhower/arduino-esp8266littlefs-plugin/releases


	Install as above


	To upload a LittleFS filesystem use Tools > ESP8266 LittleFS Data Upload







File system object (SPIFFS/LittleFS/SD/SDFS)


setConfig

SPIFFSConfig cfg;
cfg.setAutoFormat(false);
SPIFFS.setConfig(cfg);





This method allows you to configure the parameters of a filesystem
before mounting.  All filesystems have their own *Config (i.e.
SDFSConfig or SPIFFSConfig with their custom set of options.
All filesystems allow explicitly enabling/disabling formatting when
mounts fail.  If you do not call this setConfig method before
perforing begin(), you will get the filesystem’s default
behavior and configuration. By default, SPIFFS will autoformat the
filesystem if it cannot mount it, while SDFS will not.




begin

SPIFFS.begin()
or LittleFS.begin()





This method mounts file system. It must be called before any
other FS APIs are used. Returns true if file system was mounted
successfully, false otherwise.  With no options it will format SPIFFS
if it is unable to mount it on the first try.

Note that both methods will automatically format the filesystem
if one is not detected.  This means that if you attempt a
SPIFFS.begin() on a LittleFS filesystem you will lose all data
on that filesystem, and vice-versa.




end

SPIFFS.end()
or LittleFS.end()





This method unmounts the file system. Use this method before updating
the file system using OTA.




format

SPIFFS.format()
or LittleFS.format()





Formats the file system. May be called either before or after calling
begin. Returns true if formatting was successful.




open

SPIFFS.open(path, mode)
or LittleFS.open(path, mode)





Opens a file. path should be an absolute path starting with a slash
(e.g. /dir/filename.txt). mode is a string specifying access
mode. It can be one of “r”, “w”, “a”, “r+”, “w+”, “a+”. Meaning of these
modes is the same as for fopen C function.

r      Open text file for reading.  The stream is positioned at the
       beginning of the file.

r+     Open for reading and writing.  The stream is positioned at the
       beginning of the file.

w      Truncate file to zero length or create text file for writing.
       The stream is positioned at the beginning of the file.

w+     Open for reading and writing.  The file is created if it does
       not exist, otherwise it is truncated.  The stream is
       positioned at the beginning of the file.

a      Open for appending (writing at end of file).  The file is
       created if it does not exist.  The stream is positioned at the
       end of the file.

a+     Open for reading and appending (writing at end of file).  The
       file is created if it does not exist.  The initial file
       position for reading is at the beginning of the file, but
       output is always appended to the end of the file.





Returns File object. To check whether the file was opened
successfully, use the boolean operator.

File f = SPIFFS.open("/f.txt", "w");
if (!f) {
    Serial.println("file open failed");
}








exists

SPIFFS.exists(path)
or LittleFS.exists(path)





Returns true if a file with given path exists, false otherwise.




mkdir

LittleFS.mkdir(path)





Returns true if the directory creation succeeded, false otherwise.




rmdir

LittleFS.rmdir(path)





Returns true if the directory was successfully removed, false otherwise.




openDir

SPIFFS.openDir(path)
or LittleFS.openDir(path)





Opens a directory given its absolute path. Returns a Dir object.
Please note the previous discussion on the difference in behavior between
LittleFS and SPIFFS for this call.




remove

SPIFFS.remove(path)
or LittleFS.remove(path)





Deletes the file given its absolute path. Returns true if file was
deleted successfully.




rename

SPIFFS.rename(pathFrom, pathTo)
or LittleFS.rename(pathFrom, pathTo)





Renames file from pathFrom to pathTo. Paths must be absolute.
Returns true if file was renamed successfully.




gc

SPIFFS.gc()





Only implemented in SPIFFS.  Performs a quick garbage collection operation on SPIFFS,
possibly making writes perform faster/better in the future.  On very full or very fragmented
filesystems, using this call can avoid or reduce issues where SPIFFS reports free space
but is unable to write additional data to a file.  See this discussion
<https://github.com/esp8266/Arduino/pull/6340#discussion_r307042268> for more info.




check

SPIFFS.begin();
SPIFFS.check();





Only implemented in SPIFFS.  Performs an in-depth check of the filesystem metadata and
correct what is repairable.  Not normally needed, and not guaranteed to actually fix
anything should there be corruption.




info

FSInfo fs_info;
SPIFFS.info(fs_info);
or LittleFS.info(fs_info);





Fills FSInfo structure with
information about the file system. Returns true if successful,
false otherwise.






Filesystem information structure

struct FSInfo {
    size_t totalBytes;
    size_t usedBytes;
    size_t blockSize;
    size_t pageSize;
    size_t maxOpenFiles;
    size_t maxPathLength;
};





This is the structure which may be filled using FS::info method. -
totalBytes — total size of useful data on the file system -
usedBytes — number of bytes used by files - blockSize — filesystem
block size - pageSize — filesystem logical page size - maxOpenFiles
— max number of files which may be open simultaneously -
maxPathLength — max file name length (including one byte for zero
termination)


info64

FSInfo64 fsinfo;
SD.info(fsinfo);
or LittleFS(fsinfo);





Performs the same operation as info but allows for reporting greater than
4GB for filesystem size/used/etc.  Should be used with the SD and SDFS
filesystems since most SD cards today are greater than 4GB in size.




setTimeCallback(time_t (*cb)(void))

time_t myTimeCallback() {
    return 1455451200; // UNIX timestamp
}
void setup () {
    LittleFS.setTimeCallback(myTimeCallback);
    ...
    // Any files will now be made with Pris' incept date
}





The SD, SDFS, and LittleFS filesystems support a file timestamp, updated when the file is
opened for writing.  By default, the ESP8266 will use the internal time returned from
time(NULL) (i.e. local time, not UTC, to conform to the existing FAT filesystem), but this
can be overridden to GMT or any other standard you’d like by using setTimeCallback().
If your app sets the system time using NTP before file operations, then
you should not need to use this function.  However, if you need to set a specific time
for a file, or the system clock isn’t correct and you need to read the time from an external
RTC or use a fixed time, this call allows you do to so.

In general use, with a functioning time() call, user applications should not need
to use this function.






Directory object (Dir)

The purpose of Dir object is to iterate over files inside a directory.
It provides multiple access methods.

The following example shows how it should be used:

Dir dir = SPIFFS.openDir("/data");
// or Dir dir = LittleFS.openDir("/data");
while (dir.next()) {
    Serial.print(dir.fileName());
    if(dir.fileSize()) {
        File f = dir.openFile("r");
        Serial.println(f.size());
    }
}






next

Returns true while there are files in the directory to
iterate over. It must be called before calling fileName(), fileSize(),
and openFile() functions.




fileName

Returns the name of the current file pointed to
by the internal iterator.




fileSize

Returns the size of the current file pointed to
by the internal iterator.




fileTime

Returns the time_t write time of the current file pointed
to by the internal iterator.




fileCreationTime

Returns the time_t creation time of the current file
pointed to by the internal iterator.




isFile

Returns true if the current file pointed to by
the internal iterator is a File.




isDirectory

Returns true if the current file pointed to by
the internal iterator is a Directory.




openFile

This method takes mode argument which has the same meaning as
for SPIFFS/LittleFS.open() function.




rewind

Resets the internal pointer to the start of the directory.




setTimeCallback(time_t (*cb)(void))

Sets the time callback for any files accessed from this Dir object via openNextFile.
Note that the SD and SDFS filesystems only support a filesystem-wide callback and
calls to  Dir::setTimeCallback may produce unexpected behavior.






File object

SPIFFS/LittleFS.open() and dir.openFile() functions return a File object.
This object supports all the functions of Stream, so you can use
readBytes, findUntil, parseInt, println, and all other
Stream methods.

There are also some functions which are specific to File object.


seek

file.seek(offset, mode)





This function behaves like fseek C function. Depending on the value
of mode, it moves current position in a file as follows:


	if mode is SeekSet, position is set to offset bytes from
the beginning.


	if mode is SeekCur, current position is moved by offset
bytes.


	if mode is SeekEnd, position is set to offset bytes from
the end of the file.




Returns true if position was set successfully.




position

file.position()





Returns the current position inside the file, in bytes.




size

file.size()





Returns file size, in bytes.




name

String name = file.name();





Returns short (no-path) file name, as const char*. Convert it to String for
storage.




fullName

// Filesystem:
//   testdir/
//           file1
Dir d = LittleFS.openDir("testdir/");
File f = d.openFile("r");
// f.name() == "file1", f.fullName() == "testdir/file1"





Returns the full path file name as a const char*.




getLastWrite

Returns the file last write time, and only valid for files opened in read-only
mode.  If a file is opened for writing, the returned time may be indeterminate.




getCreationTime

Returns the file creation time, if available.




isFile

bool amIAFile = file.isFile();





Returns true if this File points to a real file.




isDirectory

bool amIADir = file.isDir();





Returns true if this File points to a directory (used for emulation
of the SD.* interfaces with the openNextFile method).




close

file.close()





Close the file. No other operations should be performed on File object
after close function was called.




openNextFile  (compatibiity method, not recommended for new code)

File root = LittleFS.open("/");
File file1 = root.openNextFile();
File files = root.openNextFile();





Opens the next file in the directory pointed to by the File.  Only valid
when File.isDirectory() == true.




rewindDirectory  (compatibiity method, not recommended for new code)

File root = LittleFS.open("/");
File file1 = root.openNextFile();
file1.close();
root.rewindDirectory();
file1 = root.openNextFile(); // Opens first file in dir again





Resets the openNextFile pointer to the top of the directory.  Only
valid when File.isDirectory() == true.




setTimeCallback(time_t (*cb)(void))

Sets the time callback for this specific file.  Note that the SD and
SDFS filesystems only support a filesystem-wide callback and calls to
Dir::setTimeCallback may produce unexpected behavior.









            

          

      

      

    

  

    
      
          
            
  
ESP8266WiFi library

ESP8266 is all about Wi-Fi. If you are eager to connect your new ESP8266 module to a Wi-Fi network to start sending and receiving data, this is a good place to start. If you are looking for more in depth details of how to program specific Wi-Fi networking functionality, you are also in the right place.


Introduction

The Wi-Fi library for ESP8266 [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] has been developed based on ESP8266 SDK [https://github.com/espressif/ESP8266_NONOS_SDK], using the naming conventions and overall functionality philosophy of the Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi]. Over time, the wealth of Wi-Fi features ported from ESP8266 SDK to esp8266 /
Arduino [https://github.com/esp8266/Arduino] outgrew Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] and it became apparent that we would need to provide separate documentation on what is new and extra.

This documentation will walk you through several classes, methods and properties of the ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] library. If you are new to C++ and Arduino, don’t worry. We will start from general concepts and then move to detailed description of members of each particular class including usage examples.

The scope of functionality offered by the ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] library is quite extensive and therefore this description has been broken up into separate documents marked with :arrow_right:.


Quick Start

Hopefully, you are already familiar how to load the Blink.ino [https://github.com/esp8266/Arduino/blob/master/libraries/esp8266/examples/Blink/Blink.ino] sketch to an ESP8266 module and get the LED blinking. If not, please use this tutorial [https://learn.adafruit.com/adafruit-huzzah-esp8266-breakout/using-arduino-ide] by Adafruit or another great tutorial [https://learn.sparkfun.com/tutorials/esp8266-thing-hookup-guide/introduction] developed by Sparkfun.

To hook up the ESP module to Wi-Fi (like hooking up a mobile phone to a hot spot), you need only a couple of lines of code:

#include <ESP8266WiFi.h>

void setup()
{
  Serial.begin(115200);
  Serial.println();

  WiFi.begin("network-name", "pass-to-network");

  Serial.print("Connecting");
  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
  Serial.println();

  Serial.print("Connected, IP address: ");
  Serial.println(WiFi.localIP());
}

void loop() {}





In the line WiFi.begin("network-name", "pass-to-network") replace network-name and pass-to-network with the name and password of the Wi-Fi network you would like to connect to. Then, upload this sketch to ESP module and open the serial monitor. You should see something like:


[image: Connection log on Arduino IDE's Serial Monitor]


How does it work? In the first line of the sketch, #include <ESP8266WiFi.h> we are including the ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] library. This library provides ESP8266 specific Wi-Fi routines that we are calling to connect to the network.

The actual connection to Wi-Fi is initialized by calling:

WiFi.begin("network-name", "pass-to-network");





The connection process can take couple of seconds and we are checking for whether this has completed in the following loop:

while (WiFi.status() != WL_CONNECTED)
{
  delay(500);
  Serial.print(".");
}





The while() loop will keep looping as long as WiFi.status() is other than WL_CONNECTED. The loop will exit only if the status changes to WL_CONNECTED.

The last line will then print out the IP address assigned to the ESP module by DHCP [https://whatismyipaddress.com/dhcp]:

Serial.println(WiFi.localIP());





If you don’t see the last line but just more and more dots ........., then likely name or password to the Wi-Fi network is entered incorrectly in the sketch. Verify the name and password by connecting from scratch to this Wi-Fi network with a PC or a mobile phone.

Note: if connection is established, and then lost for some reason, ESP will automatically reconnect to the last used access point once it is again back on-line. This will be done automatically by Wi-Fi library, without any user intervention.

That’s all you need to connect ESP8266 to Wi-Fi. In the following chapters we will explain what cool things can be done by the ESP once it’s connected.




Who is Who

Devices that connect to Wi-Fi networks are called stations (STA). Connection to Wi-Fi is provided by an access point (AP), that acts as a hub for one or more stations. The access point on the other end is connected to a wired network. An access point is usually integrated with a router to provide access from a Wi-Fi network to the internet. Each access point is recognized by a SSID (Service Set IDentifier), that essentially is the name of network you select when connecting a device (station) to the Wi-Fi.

ESP8266 modules can operate as a station, so we can connect it to the Wi-Fi network. It can also operate as a soft access point (soft-AP), to establish its own Wi-Fi network. When the ESP8266 module is operating as a soft access point, we can connect other stations to the ESP module. ESP8266 is also able to operate as both a station and a soft access point mode. This provides the possibility of building e.g. mesh networks [https://en.wikipedia.org/wiki/Mesh_networking].


[image: ESP8266 operating in the Station + Soft Access Point mode]


The ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] library provides a wide collection of C++
methods [https://en.wikipedia.org/wiki/Method_(computer_programming)] (functions) and properties [https://en.wikipedia.org/wiki/Property_(programming)] to configure and operate an ESP8266 module in station and / or soft access point mode. They are described in the following chapters.






Class Description

The ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] library is broken up into several classes. In most of cases, when writing the code, the user is not concerned with this classification. We are using it to break up description of this library into more manageable pieces.


[image: Index of classes of ESP8266WiFi library]


Chapters below describe all function calls (methods [https://en.wikipedia.org/wiki/Method_(computer_programming)] and properties [https://en.wikipedia.org/wiki/Property_(programming)] in C++ terms) listed in particular classes of ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi]. The description is illustrated with application examples and code snippets to show how to use functions in practice. This information is broken up into the following documents.


Station

Station (STA) mode is used to get the ESP module connected to a Wi-Fi network established by an access point.


[image: ESP8266 operating in the Station mode]


Station class has several features to facilitate the management of a Wi-Fi connection. In case the connection is lost, the ESP8266 will automatically reconnect to the last used access point, once it is available again. The same happens on module reboot. This is possible since ESP saves the credentials to the last used access point in flash (non-volatile) memory. Using the saved data ESP will also reconnect if sketch has been changed but code does not alter the Wi-Fi mode or credentials.

Station Class documentation

Check out separate section with examples.




Soft Access Point

An access point (AP) [https://en.wikipedia.org/wiki/Wireless_access_point] is a device that provides access to a Wi-Fi network to other devices (stations) and connects them to a wired network. The ESP8266 can provide similar functionality, except it does not have interface to a wired network. Such mode of operation is called soft access point (soft-AP). The maximum number of stations that can simultaneously be connected to the soft-AP can be set from 0 to 8 [https://bbs.espressif.com/viewtopic.php?f=46&t=481&p=1832&hilit=max_connection#p1832], but defaults to 4.


[image: ESP8266 operating in the Soft Access Point mode]


The soft-AP mode is often used and an intermediate step before connecting ESP to a Wi-Fi in a station mode. This is when SSID and password to such network is not known upfront. ESP first boots in soft-AP mode, so we can connect to it using a laptop or a mobile phone. Then we are able to provide credentials to the target network. Then, the ESP is switched to the station mode and can connect to the target Wi-Fi.

Another handy application of soft-AP mode is to set up mesh networks [https://en.wikipedia.org/wiki/Mesh_networking]. The ESP can operate in both soft-AP and Station mode so it can act as a node of a mesh network.

Soft Access Point Class documentation

Check out the separate section with examples.




Scan

To connect a mobile phone to a hot spot, you typically open Wi-Fi settings app, list available networks and pick the hot spot you need. Then enter a password (or not) and you are in. You can do the same with the ESP. Functionality of scanning for, and listing of available networks in range is implemented by the Scan Class.

Scan Class documentation

Check out the separate section with examples.




Client

The Client class creates clients [https://en.wikipedia.org/wiki/Client_(computing)] that can access services provided by servers [https://en.wikipedia.org/wiki/Server_(computing)] in order to send, receive and process data.


[image: ESP8266 operating as the Client]


Check out the separate section with list of functions




WiFi Multi

ESP8266WiFiMulti.h can be used to connect to a WiFi network with strongest WiFi signal (RSSI). This requires registering one or more access points with SSID and password. It automatically switches to another WiFi network when the WiFi connection is lost.

Example:

#include <ESP8266WiFiMulti.h>

ESP8266WiFiMulti wifiMulti;

// WiFi connect timeout per AP. Increase when connecting takes longer.
const uint32_t connectTimeoutMs = 5000;

void setup()
{
  // Set in station mode
  WiFi.mode(WIFI_STA);

  // Register multi WiFi networks
  wifiMulti.addAP("ssid_from_AP_1", "your_password_for_AP_1");
  wifiMulti.addAP("ssid_from_AP_2", "your_password_for_AP_2");
  wifiMulti.addAP("ssid_from_AP_3", "your_password_for_AP_3");
}

void loop()
{
  // Maintain WiFi connection
  if (wifiMulti.run(connectTimeoutMs) == WL_CONNECTED) {
      ...
  }
}








BearSSL Client Secure and Server Secure

BearSSL::WiFiClientSecure and BearSSL::WiFiServerSecure are extensions of the standard Client and Server classes where connection and data exchange with servers and clients using secure protocol [https://en.wikipedia.org/wiki/Transport_Layer_Security].  It supports TLS 1.2 [https://en.wikipedia.org/wiki/Transport_Layer_Security#TLS_1.2] using a wide variety of modern ciphers, hashes, and key types.


[image: ESP8266 operating as the Client Secure]


Secure clients and servers require significant amounts of additional memory and processing to enable their cryptographic algorithms.  In general, only a single secure client or server connection at a time can be processed given the little RAM present on the ESP8266, but there are methods of reducing this RAM requirement detailed in the relevant sections.

BearSSL::WiFiClientSecure contains more information on using and configuring TLS connections.

BearSSL::WiFiServerSecure discusses the TLS server mode available.  Please read and understand the BearSSL::WiFiClientSecure first as the server uses most of the same concepts.

Check out the separate section with examples .




Server

The Server Class creates servers [https://en.wikipedia.org/wiki/Server_(computing)] that provide functionality to other programs or devices, called clients [https://en.wikipedia.org/wiki/Client_(computing)].


[image: ESP8266 operating as the Server]


Clients connect to sever to send and receive data and access provided functionality.

Check out separate section with examples / list of functions.




UDP

The UDP Class enables the User Datagram Protocol (UDP) [https://en.wikipedia.org/wiki/User_Datagram_Protocol] messages to be sent and received. The UDP uses a simple “fire and forget” transmission model with no guarantee of delivery, ordering, or duplicate protection. UDP provides checksums for data integrity, and port numbers for addressing different functions at the source and destination of the datagram.

Check out separate section with examples / list of functions.




Generic

There are several functions offered by ESP8266’s SDK [https://bbs.espressif.com/viewtopic.php?f=51&t=1023] and not present in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi]. If such function does not fit into one of classes discussed above, it will likely be in Generic Class. Among them is handler to manage Wi-Fi events like connection, disconnection or obtaining an IP, Wi-Fi mode changes, functions to manage module sleep mode, hostname to an IP address resolution, etc.

Check out separate section with examples / list of functions.






Diagnostics

There are several techniques available to diagnose and troubleshoot issues with getting connected to Wi-Fi and keeping connection alive.


Check Return Codes

Almost each function described in chapters above returns some diagnostic information.

Such diagnostic may be provided as a simple boolean type true or false to indicate operation result. You may check this result as described in examples, for instance:

Serial.printf("Wi-Fi mode set to WIFI_STA %s\n", WiFi.mode(WIFI_STA) ? "" : "Failed!");





Some functions provide more than just a binary status information. A good example is WiFi.status().

Serial.printf("Connection status: %d\n", WiFi.status());





This function returns following codes to describe what is going on with Wi-Fi connection:


	0 : WL_IDLE_STATUS when Wi-Fi is in process of changing between statuses


	1 : WL_NO_SSID_AVAILin case configured SSID cannot be reached


	3 : WL_CONNECTED after successful connection is established


	4 : WL_CONNECT_FAILED if connection failed


	6 : WL_CONNECT_WRONG_PASSWORD if password is incorrect


	7 : WL_DISCONNECTED if module is not configured in station mode




It is a good practice to display and check information returned by functions. Application development and troubleshooting will be easier with that.




Use printDiag

There is a specific function available to print out key Wi-Fi diagnostic information:

WiFi.printDiag(Serial);





A sample output of this function looks as follows:

Mode: STA+AP
PHY mode: N
Channel: 11
AP id: 0
Status: 5
Auto connect: 1
SSID (10): sensor-net
Passphrase (12): 123!$#0&*esP
BSSID set: 0





Use this function to provide snapshot of Wi-Fi status in these parts of application code, that you suspect may be failing.




Enable Wi-Fi Diagnostic

By default the diagnostic output from Wi-Fi libraries is disabled when you call Serial.begin. To enable debug output again, call Serial.setDebugOutput(true). To redirect debug output to Serial1 instead, call Serial1.setDebugOutput(true). For additional details regarding diagnostics using serial ports please refer to the documentation.

Below is an example of output for sample sketch discussed in Quick Start above with Serial.setDebugOutput(true):

Connectingscandone
state: 0 -> 2 (b0)
state: 2 -> 3 (0)
state: 3 -> 5 (10)
add 0
aid 1
cnt

connected with sensor-net, channel 6
dhcp client start...
chg_B1:-40
...ip:192.168.1.10,mask:255.255.255.0,gw:192.168.1.9
.
Connected, IP address: 192.168.1.10





The same sketch without Serial.setDebugOutput(true) will print out only the following:

Connecting....
Connected, IP address: 192.168.1.10








Enable Debugging in IDE

Arduino IDE provides convenient method to enable debugging for specific libraries.






What’s Inside?

If you like to analyze in detail what is inside of the ESP8266WiFi library, go directly to the ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi/src] folder of esp8266 / Arduino repository on the GitHub.

To make the analysis easier, rather than looking into individual header or source files, use one of free tools to automatically generate documentation. The class index in chapter Class Description above has been prepared in no time using great Doxygen [https://www.doxygen.nl/], that is the de facto standard tool for generating documentation from annotated C++ sources.


[image: Example of documentation prepared by Doxygen]


The tool crawls through all header and source files collecting information from formatted comment blocks. If developer of particular class annotated the code, you will see it like in examples below.


[image: Example of documentation for station begin method by Doxygen]



[image: Example of documentation for station hostname property by Doxygen]


If code is not annotated, you will still see the function prototype including types of arguments, and can use provided links to jump straight to the source code to check it out on your own. Doxygen provides really excellent navigation between members of library.


[image: Example of documentation for UDP begin method (not annotated in code)by Doxygen]


Several classes of ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] are not annotated. When preparing this document, Doxygen [https://www.doxygen.nl/] has been tremendous help to quickly navigate through almost 30 files that make this library.







            

          

      

      

    

  

    
      
          
            
  
OTA Updates


Introduction

OTA (Over the Air) update is the process of uploading firmware to an ESP module using a Wi-Fi connection rather than a serial port. Such functionality becomes extremely useful in case of limited or no physical access to the module.

OTA may be done using:


	Arduino IDE


	Web Browser


	HTTP Server




The Arduino IDE option is intended primarily for the software development phase. The other two options would be more useful after deployment, to provide the module with application updates either manually with a web browser, or automatically using an HTTP server.

In any case, the first firmware upload has to be done over a serial port. If the OTA routines are correctly implemented in the sketch, then all subsequent uploads may be done over the air.

By default, there is no imposed security for the OTA process.  It is up to the developer to ensure that updates are allowed only from legitimate / trusted sources. Once the update is complete, the module restarts, and the new code is executed. The developer should ensure that the application running on the module is shut down and restarted in a safe manner. Chapters below provide additional information regarding security and safety of OTA updates.


Security Disclaimer

No guarantees as to the level of security provided for your application by the following methods is implied.  Please refer to the GNU LGPL license associated for this project for full disclaimers.  If you do find security weaknesses, please don’t hesitate to contact the maintainers or supply pull requests with fixes.  The MD5 verification and password protection schemes are already known to supply a very weak level of security.




Basic Security

The module has to be exposed wirelessly to get it updated with a new sketch. That poses a risk of the module being violently hacked and programmed with some other code. To reduce the likelihood of being hacked, consider protecting your uploads with a password, selecting certain OTA port, etc.

Check functionality provided with the ArduinoOTA [https://github.com/esp8266/Arduino/tree/master/libraries/ArduinoOTA] library that may improve security:

void setPort(uint16_t port);
void setHostname(const char* hostname);
void setPassword(const char* password);





Certain basic protection is already built in and does not require any additional coding by the developer. ArduinoOTA [https://github.com/esp8266/Arduino/tree/master/libraries/ArduinoOTA] and espota.py use Digest-MD5 [https://en.wikipedia.org/wiki/Digest_access_authentication] to authenticate uploads. Integrity of transferred data is verified on the ESP side using MD5 [https://en.wikipedia.org/wiki/MD5] checksum.

Make your own risk analysis and, depending on the application, decide what library functions to implement. If required, consider implementation of other means of protection from being hacked, like exposing modules for uploads only according to a specific schedule, triggering OTA only when the user presses a dedicated “Update” button wired to the ESP, etc.




Advanced Security - Signed Updates

While the above password-based security will dissuade casual hacking attempts, it is not highly secure.  For applications where a higher level of security is needed, cryptographically signed OTA updates can be required.  This uses SHA256 hashing in place of MD5 (which is known to be cryptographically broken) and RSA-2048 bit level public-key encryption to guarantee that only the holder of a cryptographic private key can produce signed updates accepted by the OTA update mechanisms.

Signed updates are updates whose compiled binaries are signed with a private key (held by the developer) and verified with a public key (stored in the application and available for all to see).  The signing process computes a hash of the binary code, encrypts the hash with the developer’s private key, and appends this encrypted hash (also called a signature) to the binary that is uploaded (via OTA, web, or HTTP server).  If the code is modified or replaced in any way by anyone except the holder of the developer’s private key, the signature will not match and the ESP8266 will reject the upload.

Cryptographic signing only protects against tampering with binaries delivered via OTA.  If someone has physical access, they will always be able to flash the device over the serial port.  Signing also does not encrypt anything but the hash (so that it can’t be modified), so this does not protect code inside the device: if a user has physical access they can read out your program.

Securing your private key is paramount.  The same private/public key pair that was used with the original upload must also be used to sign later binaries.  Loss of the private key associated with a binary means that you will not be able to OTA-update any of your devices in the field.  Alternatively, if someone else copies the private key, then they will be able to use it to sign binaries which will be accepted by the ESP.


Signed Binary Format

The format of a signed binary is compatible with the standard binary format, and can be uploaded to a non-signed ESP8266 via serial or OTA without any conditions.  Note, however, that once an unsigned OTA app is overwritten by this signed version, further updates will require signing.

As shown below, the signed hash is appended to the unsigned binary, followed by the total length of the signed hash (i.e., if the signed hash was 64 bytes, then this uint32 data segment will contain 64).  This format allows for extensibility (such as adding a CA-based validation scheme allowing multiple signing keys all based on a trust anchor). Pull requests are always welcome. (currently it uses SHA256 with RSASSA-PKCS1-V1_5-SIGN signature scheme from RSA PKCS #1 v1.5)

NORMAL-BINARY <SIGNATURE> <uint32 LENGTH-OF-SIGNATURE>








Signed Binary Prerequisites

OpenSSL is required to run the standard signing steps, and should be available on any UNIX-like or Windows system.  As usual, the latest stable version of OpenSSL is recommended.

Signing requires the generation of an RSA-2048 key (other bit lengths are supported as well, but 2048 is a good selection today) using any appropriate tool.  The following shell commands will generate a new public/private key pair.  Run them in the sketch directory:

openssl genrsa -out private.key 2048
openssl rsa -in private.key -outform PEM -pubout -out public.key








Automatic Signing – Only available on Linux and Mac

The simplest way of implementing signing is to use the automatic mode, which presently is only possible on Linux and Mac due to some of the tools not being available for Windows.  This mode uses the IDE to configure the source code to enable sigining verification with a given public key, and signs binaries as part of the standard build process using a given public key.

To enable this mode, just include private.key and public.key in the sketch .ino directory.  The IDE will call a helper script (tools/signing.py) before the build begins to create a header to enable key validation using the given public key, and to actually do the signing after the build process, generating a sketch.bin.signed file.  When OTA is enabled (ArduinoOTA, Web, or HTTP), the binary will automatically only accept signed updates.

When the signing process starts, the message:

Enabling binary signing





will appear in the IDE window before a compile is launched. At the completion of the build, the signed binary file well be displayed in the IDE build window as:

Signed binary: /full/path/to/sketch.bin.signed





If you receive either of the following messages in the IDE window, the signing was not completed and you will need to verify the public.key and private.key:

Not enabling binary signing
... or ...
Not signing the generated binary








Manual Signing of Binaries

Users may also manually sign executables and require the OTA process to verify their signature.  In the main code, before enabling any update methods, add the following declarations and function call:

<in globals>
BearSSL::PublicKey signPubKey( ... key contents ... );
BearSSL::HashSHA256 hash;
BearSSL::SigningVerifier sign( &signPubKey );
...
<in setup()>
Update.installSignature( &hash, &sign );





The above snippet creates a BearSSL public key and a SHA256 hash verifier, and tells the Update object to use them to validate any updates it receives from any method.

Compile the sketch normally and, once a .bin file is available, sign it using the signer script:

<ESP8266ArduinoPath>/tools/signing.py --mode sign --privatekey <path-to-private.key> --bin <path-to-unsigned-bin> --out <path-to-signed-binary>








Old And New Signature Formats

Up to version 2.5.2 of the core, the format of signatures was a little different. An additional signed binary with the extension legacy_sig is created. This file contains a signature in the old format and can be uploaded OTA to a device that checks for the old signature format.

To create a legacy signature, call the signing script with –legacy:

<ESP8266ArduinoPath>/tools/signing.py --mode sign --privatekey <path-to-private.key> --bin <path-to-unsigned-bin> --out <path-to-signed-binary> --legacy <path-to-legacy-file>












Compression

The eboot bootloader incorporates a GZIP decompressor, built for very low code requirements.  For applications, this optional decompression is completely transparent.  For uploading compressed filesystems, the application must be built with ATOMIC_FS_UPDATE defined because, otherwise, eboot will not be involved in writing the filesystem.

No changes to the application are required.  The Updater class and eboot bootloader (which performs actual application overwriting on update) automatically search for the gzip header in the uploaded binary, and if found, handle it.

Compress an application .bin file or filesystem package using any gzip available, at any desired compression level (gzip -9 is recommended because it provides the maximum compression and uncompresses as fast as any other compressino level).  For example:

gzip -9 sketch.bin  # Maximum compression, output sketch.bin.gz
<Upload the resultant sketch.bin.gz>





If signing is desired, sign the gzip compressed file after compression.

gzip -9 sketch.bin
<ESP8266ArduinoPath>/tools/signing.py --mode sign --privatekey <path-to-private.key> --bin sketch.bin.gz --out sketch.bin.gz.signed






Updating apps in the field to support compression

If you have applications deployed in the field and wish to update them to support compressed OTA uploads, you will need to first recompile the application, then _upload the uncompressed .bin file once.  Attempting to upload a gzip compressed binary to a legacy app will result in the Updater rejecting the upload as it does not understand the gzip format.  After this initial upload, which will include the new bootloader and Updater class with compression support, compressed updates can then be used.




Safety

The OTA process consumes some of the ESP’s resources and bandwidth during upload. Then, the module is restarted and a new sketch executed. Analyse and test how this affects the functionality of the existing and new sketches.

If the ESP is in a remote location and controlling some equipment, you should devote additional attention to what happens if operation of this equipment is suddenly interrupted by the update process. Therefore, decide how to put this equipment into a safe state before starting the update. For instance, your module may be controlling a garden watering system in a sequence. If this sequence is not properly shut down and a water valve is left open, the garden may be flooded.

The following functions are provided with the ArduinoOTA [https://github.com/esp8266/Arduino/tree/master/libraries/ArduinoOTA] library and intended to handle functionality of your application during specific stages of OTA, or on an OTA error:

void onStart(OTA_CALLBACK(fn));
void onEnd(OTA_CALLBACK(fn));
void onProgress(OTA_CALLBACK_PROGRESS(fn));
void onError(OTA_CALLBACK_ERROR (fn));








OTA Basic Requirements

The flash chip size should be large enough to hold the old sketch (currently running) and the new sketch (OTA) at the same time.

Keep in mind that the file system and EEPROM, for example, need space too; see Flash layout.

ESP.getFreeSketchSpace();





can be used for checking the free space available for the new sketch.

For an overview of memory layout, where the new sketch is stored and how it is copied during the OTA process, see Update process - memory view.

The following chapters provide more details and specific methods for OTA updates.






Arduino IDE

Uploading modules wirelessly from Arduino IDE is intended for the following typical scenarios:


	during firmware development as a quicker alternative to loading over a serial port,


	for updating a small number of modules,


	only if modules are accessible on the same network as the computer with the Arduino IDE.





Requirements


	The ESP and the computer must be connected to the same network.







Application Example

Instructions below show configuration of OTA on a NodeMCU 1.0 (ESP-12E Module) board. You can use any other board that meets the requirements described above. This instruction is valid for all operating systems supported by the Arduino IDE. Screen captures have been made on Windows 7 and you may see small differences (like name of the serial port), if you are using Linux or MacOS.


	Before you begin, please make sure that you have the following software
installed:


	Arduino IDE 1.6.7 or newer -
https://www.arduino.cc/en/Main/Software


	esp8266/Arduino platform package 2.0.0 or newer - for instructions
follow
https://github.com/esp8266/Arduino#installing-with-boards-manager






	Now prepare the sketch and configuration for upload via a serial port.


	Start Arduino IDE and upload the sketch BasicOTA.ino, available under
File > Examples > ArduinoOTA [image: ota sketch selection]


	Update the SSID and password in the sketch, so that the module can join
your Wi-Fi network [image: ota ssid pass entry]


	Configure upload parameters as below (you may need to adjust
configuration if you are using a different module): [image: ota serial upload config]

Note: Depending on version of platform package and board you
have, you may see Upload Using: in the menu above. This option
is inactive and it does not matter what you select. It has been
left for compatibility with older implementation of OTA and
finally removed in platform package version 2.2.0.







	Upload the sketch (Ctrl+U). Once done, open Serial Monitor
(Ctrl+Shift+M) and check if module has joined your Wi-Fi network:


[image: Check if module joined network]






Note: The ESP module should be reset after serial upload. Otherwise, subsequent steps will not work. Reset may be done for you automatically after opening serial monitor, as visible on the screenshot above. It depends on how you have DTR and RTS wired from the USB-Serial converter to the ESP. If reset is not done automatically, then trigger it by pressing reset button or manually cycling the power. For more details why this should be done please refer to FAQ regarding ESP.restart().


	Only if the module is connected to network, after a couple of seconds,
the esp8266-ota port will show up in Arduino IDE. Select port with IP
address shown in the Serial Monitor window in previous step:


[image: Selection of OTA port]


Note: If the OTA port does not show up, exit Arduino IDE, open it
again and check if the port is there. If it is not, check your
firewall and router settings. The OTA port is advertised using mDNS
service. To check if the port is visible by your PC, you can use
an application like Bonjour Browser.



	Now get ready for your first OTA upload by selecting the OTA port:


[image: Configuration of OTA upload]


Note: The menu entry Upload Speed: does not matter at this
point as it concerns the serial port. Just left it unchanged.



	If you have successfully completed all the above steps, you can
upload (Ctrl+U) the same (or any other) sketch over OTA:


[image: OTA upload complete]






Note: To be able to upload your sketch over and over again using OTA, you need to embed OTA routines inside. Please use BasicOTA.ino as an example.


Password Protection

Protecting your OTA uploads with password is really straightforward. All you need to do, is to include the following statement in your code:

ArduinoOTA.setPassword((const char *)"123");





Where 123 is a sample password that you should replace with your own.

Before implementing it in your sketch, it is a good idea to check how it works using BasicOTA.ino sketch available under File > Examples > ArduinoOTA. Go ahead, open BasicOTA.ino, uncomment the above statement that is already there, and upload the sketch. To make troubleshooting easier, do not modify example sketch besides what is absolutely required. This is including original simple 123 OTA password. Then attempt to upload sketch again (using OTA). After compilation is complete, once upload is about to begin, you should see prompt for password as follows:


[image: Password prompt for OTA upload]


Enter the password and upload should be initiated as usual with the only difference being Authenticating...OK message visible in upload log.


[image: Authenticating...OK during OTA upload]


You will not be prompted for a reentering the same password next time. Arduino IDE will remember it for you. You will see prompt for password only after reopening IDE, or if you change it in your sketch, upload the sketch and then try to upload it again.

Please note, it is possible to reveal password entered previously in Arduino IDE, if IDE has not been closed since last upload. This can be done by enabling Show verbose output during: upload in File > Preferences and attempting to upload the module.


[image: Verbose upload output with password passing in plain text]


The picture above shows that the password is visible in log, as it is passed to espota.py upload script.

Another example below shows situation when password is changed between uploads.


[image: Verbose output when OTA password has been changed between uploads]


When uploading, Arduino IDE used previously entered password, so the upload failed and that has been clearly reported by IDE. Only then IDE prompted for a new password. That was entered correctly and second attempt to upload has been successful.




Troubleshooting

If OTA update fails, first step is to check for error messages that may be shown in upload window of Arduino IDE. If this is not providing any useful hints, try to upload again while checking what is shown by ESP on serial port. Serial Monitor from IDE will not be useful in that case. When attempting to open it, you will likely see the following:


[image: Arduino IDE network terminal window]


This window is for Arduino Yún and not yet implemented for esp8266/Arduino. It shows up because IDE is attempting to open Serial Monitor using network port you have selected for OTA upload.

Instead you need an external serial monitor. If you are a Windows user check out Termite [https://www.compuphase.com/software_termite.htm]. This is handy, slick and simple RS232 terminal that does not impose RTS or DTR flow control. Such flow control may cause issues if you are using respective lines to toggle GPIO0 and RESET pins on ESP for upload.

Select COM port and baud rate on external terminal program as if you were using Arduino Serial Monitor. Please see typical settings for Termite [https://www.compuphase.com/software_termite.htm] below:


[image: Termite settings]


Then run OTA from IDE and look what is displayed on terminal. Successful ArduinoOTA process using BasicOTA.ino sketch looks like below (IP address depends on your network configuration):


[image: OTA upload successful - output on an external serial terminal]


If upload fails you will likely see errors caught by the uploader, exception and the stack trace, or both.

Instead of the log as on the above screen you may see the following:


[image: OTA upload failed - output on an external serial terminal]


If this is the case, then most likely ESP module has not been reset after initial upload using serial port.

The most common causes of OTA failure are as follows:


	not enough physical memory on the chip (e.g. ESP01 with 512K flash memory is not enough for OTA).


	too much memory declared for the filesystem so new sketch will not fit between existing sketch and the filesystem – see Update process - memory view.


	too little memory declared in Arduino IDE for your selected board (i.e. less than physical size).


	not resetting the ESP module after initial upload using serial port.




For more details regarding flash memory layout please check File system. For overview where new sketch is stored, how it is copied and how memory is organized for the purpose of OTA see Update process - memory view.








Web Browser

Updates described in this chapter are done with a web browser that can be useful in the following typical scenarios:


	after application deployment if loading directly from Arduino IDE is
inconvenient or not possible,


	after deployment if user is unable to expose module for OTA from
external update server,


	to provide updates after deployment to small quantity of modules when
setting an update server is not practicable.





Requirements


	The ESP and the computer must be connected to the same network.







Implementation Overview

Updates with a web browser are implemented using ESP8266HTTPUpdateServer class together with ESP8266WebServer and ESP8266mDNS classes. The following code is required to get it work:

setup()

MDNS.begin(host);

httpUpdater.setup(&httpServer);
httpServer.begin();

MDNS.addService("http", "tcp", 80);





loop()

httpServer.handleClient();








Application Example

The sample implementation provided below has been done using:


	example sketch WebUpdater.ino available in
ESP8266HTTPUpdateServer library,


	NodeMCU 1.0 (ESP-12E Module).




You can use another module if it meets previously described requirements.


	Before you begin, please make sure that you have the following
software installed:


	Arduino IDE and 2.0.0-rc1 (of Nov 17, 2015) version of platform
package as described under
https://github.com/esp8266/Arduino#installing-with-boards-manager


	Host software depending on O/S you use:


	Avahi https://avahi.org/ for Linux


	Bonjour https://www.apple.com/support/bonjour/ for Windows


	Mac OSX and iOS - support is already built in / no any extra
s/w is required










	Prepare the sketch and configuration for initial upload with a serial
port.


	Start Arduino IDE and load sketch WebUpdater.ino available under
File > Examples > ESP8266HTTPUpdateServer.


	Update SSID and password in the sketch, so the module can join
your Wi-Fi network.


	Open File > Preferences, look for “Show verbose output during:”
and check out “compilation” option.


[image: Preferences - enabling verbose output during compilation]


Note: This setting will be required in step 5 below. You can
uncheck this setting afterwards.







	Upload sketch (Ctrl+U). Once done, open Serial Monitor (Ctrl+Shift+M)
and check if you see the following message displayed, that contains
url for OTA update.


[image: Serial Monitor - after first load using serial]


Note: Such message will be shown only after module successfully
joins network and is ready for an OTA upload. Please remember about
resetting the module once after serial upload as discussed in chapter
Arduino IDE, step 3.



	Now open web browser and enter the url provided on Serial Monitor,
i.e. http://esp8266-webupdate.local/update. Once entered, browser
should display a form like below that has been served by your module.
The form invites you to choose a file for update.


[image: OTA update form in web browser]


Note: If entering http://esp8266-webupdate.local/update does
not work, try replacing esp8266-webupdate with module’s IP
address. For example, if your module IP is 192.168.1.100 then url
should be http://192.168.1.100/update. This workaround is useful
in case the host software installed in step 1 does not work. If still
nothing works and there are no clues on the Serial Monitor, try to
diagnose issue by opening provided url in Google Chrome, pressing F12
and checking contents of “Console” and “Network” tabs. Chrome
provides some advanced logging on these tabs.



	To obtain the file, navigate to directory used by Arduino IDE to
store results of compilation. You can check the path to this file in
compilation log shown in IDE debug window as marked below.


[image: Compilation complete - path to binary file]




	Now press “Choose File” in web browser, go to directory identified in
step 5 above, find the file “WebUpdater.cpp.bin” and upload it. If
upload is successful, you will see “OK” on web browser like below.


[image: OTA update complete]


Module will reboot that should be visible on Serial Monitor:


[image: Serial Monitor - after OTA update]


Just after reboot you should see exactly the same message
HTTPUpdateServer ready! Open http://esp8266-webupdate.local/update in your browser
like in step 3. This is because module has been loaded again with the
same code – first using serial port, and then using OTA.





Once you are comfortable with this procedure, go ahead and modify WebUpdater.ino sketch to print some additional messages, compile it, locate new binary file and upload it using web browser to see entered changes on a Serial Monitor.

You can also add OTA routines to your own sketch following guidelines in Implementation Overview above. If this is done correctly, you should be always able to upload new sketch over the previous one using a web browser.

In case OTA update fails dead after entering modifications in your sketch, you can always recover module by loading it over a serial port. Then diagnose the issue with sketch using Serial Monitor. Once the issue is fixed try OTA again.






HTTP Server

ESP8266HTTPUpdate class can check for updates and download a binary file from HTTP web server. It is possible to download updates from every IP or domain address on the network or Internet.

Note that by default this class closes all other connections except the one used by the update, this is because the update method blocks. This means that if there’s another application receiving data then TCP packets will build up in the buffer leading to out of memory errors causing the OTA update to fail. There’s also a limited number of receive buffers available and all may be used up by other applications.

There are some cases where you know that you won’t be receiving any data but would still like to send progress updates.
It’s possible to disable the default behaviour (and keep connections open) by calling closeConnectionsOnUpdate(false).


Requirements


	web server







Arduino code


Simple updater

Simple updater downloads the file every time the function is called.

#include <ESP8266httpUpdate.h>

WiFiClient client;
ESPhttpUpdate.update(client, "192.168.0.2", 80, "/arduino.bin");








Advanced updater

Its possible to point the update function to a script on the server. If a version string argument is given, it will be sent to the server. The server side script can use this string to check whether an update should be performed.

The server-side script can respond as follows: - response code 200, and send the firmware image, - or response code 304 to notify ESP that no update is required.

#include <ESP8266httpUpdate.h>

WiFiClient client;
t_httpUpdate_return ret = ESPhttpUpdate.update(client, "192.168.0.2", 80, "/esp/update/arduino.php", "optional current version string here");
switch(ret) {
    case HTTP_UPDATE_FAILED:
        Serial.println("[update] Update failed.");
        break;
    case HTTP_UPDATE_NO_UPDATES:
        Serial.println("[update] Update no Update.");
        break;
    case HTTP_UPDATE_OK:
        Serial.println("[update] Update ok."); // may not be called since we reboot the ESP
        break;
}








TLS updater

Please read and try the examples provided with the library.






Server request handling


Simple updater

For the simple updater the server only needs to deliver the binary file for update.




Advanced updater

For advanced update management a script (such as a PHP script) needs to run on the server side. On every update request, the ESP sends some information in HTTP headers to the server.

Example header data:

[User-Agent] => ESP8266-http-Update
[x-ESP8266-STA-MAC] => 18:FE:AA:AA:AA:AA
[x-ESP8266-AP-MAC] => 1A:FE:AA:AA:AA:AA
[x-ESP8266-free-space] => 671744
[x-ESP8266-sketch-size] => 373940
[x-ESP8266-sketch-md5] => a56f8ef78a0bebd812f62067daf1408a
[x-ESP8266-chip-size] => 4194304
[x-ESP8266-sdk-version] => 1.3.0
[x-ESP8266-version] => DOOR-7-g14f53a19
[x-ESP8266-mode] => sketch





With this information the script now can check if an update is needed. It is also possible to deliver different binaries based on the MAC address, as in the following example:

<?PHP

header('Content-type: text/plain; charset=utf8', true);

function check_header($name, $value = false) {
    if(!isset($_SERVER[$name])) {
        return false;
    }
    if($value && $_SERVER[$name] != $value) {
        return false;
    }
    return true;
}

function sendFile($path) {
    header($_SERVER["SERVER_PROTOCOL"].' 200 OK', true, 200);
    header('Content-Type: application/octet-stream', true);
    header('Content-Disposition: attachment; filename='.basename($path));
    header('Content-Length: '.filesize($path), true);
    header('x-MD5: '.md5_file($path), true);
    readfile($path);
}

if(!check_header('User-Agent', 'ESP8266-http-Update')) {
    header($_SERVER["SERVER_PROTOCOL"].' 403 Forbidden', true, 403);
    echo "only for ESP8266 updater!\n";
    exit();
}

if(
    !check_header('x-ESP8266-STA-MAC') ||
    !check_header('x-ESP8266-AP-MAC') ||
    !check_header('x-ESP8266-free-space') ||
    !check_header('x-ESP8266-sketch-size') ||
    !check_header('x-ESP8266-sketch-md5') ||
    !check_header('x-ESP8266-chip-size') ||
    !check_header('x-ESP8266-sdk-version')
) {
    header($_SERVER["SERVER_PROTOCOL"].' 403 Forbidden', true, 403);
    echo "only for ESP8266 updater! (header)\n";
    exit();
}

$db = array(
    "18:FE:AA:AA:AA:AA" => "DOOR-7-g14f53a19",
    "18:FE:AA:AA:AA:BB" => "TEMP-1.0.0"
);

if(!isset($db[$_SERVER['x-ESP8266-STA-MAC']])) {
    header($_SERVER["SERVER_PROTOCOL"].' 500 ESP MAC not configured for updates', true, 500);
}

$localBinary = "./bin/".$db[$_SERVER['x-ESP8266-STA-MAC']].".bin";

// Check if version has been set and does not match, if not, check if
// MD5 hash between local binary and ESP8266 binary do not match if not.
// then no update has been found.
if((!check_header('x-ESP8266-sdk-version') && $db[$_SERVER['x-ESP8266-STA-MAC']] != $_SERVER['x-ESP8266-version'])
    || $_SERVER["x-ESP8266-sketch-md5"] != md5_file($localBinary)) {
    sendFile($localBinary);
} else {
    header($_SERVER["SERVER_PROTOCOL"].' 304 Not Modified', true, 304);
}

header($_SERVER["SERVER_PROTOCOL"].' 500 no version for ESP MAC', true, 500);












Stream Interface

The Stream Interface is the base for all other update modes like OTA, HTTP Server / client. Given a Stream-class variable streamVar providing byteCount bytes of firmware, it can store the firmware as follows:

Update.begin(firmwareLengthInBytes);
Update.writeStream(streamVar);
Update.end();








Updater class

Updater is in the Core and deals with writing the firmware to the flash, checking its integrity and telling the bootloader (eboot) to load the new firmware on the next boot.

The following Updater <https://github.com/esp8266/Arduino/tree/master/cores/esp8266/Updater.h methods could be used to be notified about OTA progress:

using THandlerFunction_Progress = std::function<void(size_t, size_t)>;
void onProgress(THandlerFunction_Progress); // current and total number of bytes

using THandlerFunction_Error = std::function<void(uint8_t)>;
void onStart(THandlerFunction_Error); // error code

using THandlerFunction = std::function<void()>;
void onEnd(THandlerFunction);
void onError(THandlerFunction);






Using RTC memory

The bootloader command will be stored into the first 128 bytes of user RTC memory, then it will be retrieved by eboot on boot. That means that user data present there will be lost (per discussion in #5330) [https://github.com/esp8266/Arduino/pull/5330#issuecomment-437803456].




Flash mode and size

For uncompressed firmware images, the Updater will change the flash mode bits if they differ from the flash mode the device is currently running at. This ensures that the flash mode is not changed to an incompatible mode when the device is in a remote or hard to access area. Compressed images are not modified, thus changing the flash mode in this instance could result in damage to the ESP8266 and/or flash memory chip or your device no longer be accessible via OTA, and requiring re-flashing via a serial connection (per discussion in #7307) [https://github.com/esp8266/Arduino/issues/7307#issuecomment-631523053].




Update process - memory view


	The new sketch will be stored in the space between the old sketch and
the spiff.


	on the next reboot, the “eboot” bootloader checks for commands.


	the new sketch is now copied “over” the old one.


	the new sketch is started.




By default, OTA filesystem updates overwrite the target flash directly. This can lead to the file system being corrupted if there is a power outage during the update process. In order to use the same two step process that is used for OTA application firmware updates, set the ATOMIC_FS_UPDATE flag. Note that you will need to have enough unused space for the new filesystem image to be stored, hence is why this is not the default behaviour.


[image: Memory layout for OTA updates]










            

          

      

      

    

  

    
      
          
            
  
Guide to PROGMEM on ESP8266 and Arduino IDE


Intro

PROGMEM is a Arduino AVR feature that has been ported to ESP8266 to
ensure compatibility with existing Arduino libraries, as well as, saving
RAM. On the esp8266 declaring a string such as const char * xyz =
"this is a string" will place this string in RAM, not flash.  It is
possible to place a String into flash, and then load it into RAM when
it is needed.  On an 8bit AVR this process is very simple.  On the 32bit
ESP8266 there are conditions that must be met to read back from flash.

On the ESP8266 PROGMEM is a macro:

#define PROGMEM   ICACHE_RODATA_ATTR





ICACHE_RODATA_ATTR is defined by:

#define ICACHE_RODATA_ATTR  __attribute__((section(".irom.text")))





Which places the variable in the .irom.text section in flash.  Placing strings in
flash requires using any of the methods above.


### Declare a global string to be stored in flash.



static const char xyz[] PROGMEM = "This is a string stored in flash";








Declare a flash string within code block.

For this you can use the PSTR macro. Which are all defined in
pgmspace.h [https://github.com/esp8266/Arduino/blob/master/cores/esp8266/pgmspace.h]

#define PGM_P       const char *
#define PGM_VOID_P  const void *
#define PSTR(s) (__extension__({static const char __c[] PROGMEM = (s); &__c[0];}))





In practice:

void myfunction(void) {
PGM_P xyz = PSTR("Store this string in flash");
const char * abc = PSTR("Also Store this string in flash");
}





The two examples above will store these strings in flash. To retrieve
and manipulate flash strings they must be read from flash in 4byte words.
In the Arduino IDE for esp8266 there are several functions that can help
retrieve strings from flash that have been stored using PROGMEM. Both of
the examples above return const char *.   However use of these pointers,
without correct 32bit alignment you will cause a segmentation fault and
the ESP8266 will crash. You must read from the flash 32 bit aligned.




Functions to read back from PROGMEM

Which are all defined in
pgmspace.h [https://github.com/esp8266/Arduino/blob/master/cores/esp8266/pgmspace.h]

int memcmp_P(const void* buf1, PGM_VOID_P buf2P, size_t size);
void* memccpy_P(void* dest, PGM_VOID_P src, int c, size_t count);
void* memmem_P(const void* buf, size_t bufSize, PGM_VOID_P findP, size_t findPSize);
void* memcpy_P(void* dest, PGM_VOID_P src, size_t count);
char* strncpy_P(char* dest, PGM_P src, size_t size);
char* strcpy_P(dest, src)
char* strncat_P(char* dest, PGM_P src, size_t size);
char* strcat_P(dest, src)
int strncmp_P(const char* str1, PGM_P str2P, size_t size);
int strcmp_P(str1, str2P)
int strncasecmp_P(const char* str1, PGM_P str2P, size_t size);
int strcasecmp_P(str1, str2P)
size_t strnlen_P(PGM_P s, size_t size);
size_t strlen_P(strP)
char* strstr_P(const char* haystack, PGM_P needle);
int printf_P(PGM_P formatP, ...);
int sprintf_P(char *str, PGM_P formatP, ...);
int snprintf_P(char *str, size_t strSize, PGM_P formatP, ...);
int vsnprintf_P(char *str, size_t strSize, PGM_P formatP, va_list ap);





There are a lot of functions there but in reality they are _P
versions of standard c functions that are adapted to read from the
esp8266 32bit aligned flash. All of them take a PGM_P which is
essentially a const char *. Under the hood these functions all use, a
process to ensure that 4 bytes are read, and the request byte is returned.

This works well when you have designed a function as above that is
specialised for dealing with PROGMEM pointers but there is no type
checking except against const char *. This means that it is totally
legitimate, as far as the compiler is concerned, for you to pass it any
const char * string, which is obviously not true and will lead to
undefined behaviour. This makes it impossible to create any overloaded
functions that can use flash strings when they are defined as PGM_P.
If you try you will get an ambiguous overload error as PGM_P ==
const char *.

Enter the __FlashStringHelper… This is a wrapper class that allows flash
strings to be used as a class, this means that type checking and function
overloading can be used with flash strings. Most people will be familiar with
the F() macro and possibly the FPSTR() macro. These are defined in WString.h [https://github.com/esp8266/Arduino/blob/master/cores/esp8266/WString.h#L37]:

#define FPSTR(pstr_pointer) (reinterpret_cast<const __FlashStringHelper *>(pstr_pointer))
#define F(string_literal) (FPSTR(PSTR(string_literal)))





So FPSTR() takes a PROGMEM pointer to a string and casts it to this
__FlashStringHelper class. Thus if you have defined a string as
above xyz you can use FPSTR() to convert it to
__FlashStringHelper for passing into functions that take it.

static const char xyz[] PROGMEM = "This is a string stored in flash";
Serial.println(FPSTR(xyz));





The F() combines both of these methods to create an easy and quick
way to store an inline string in flash, and return the type
__FlashStringHelper. For example:

Serial.println(F("This is a string stored in flash"));





Although these two functions provide a similar function, they serve
different roles. FPSTR() allows you to define a global flash string
and then use it in any function that takes __FlashStringHelper.
F() allows you to define these flash strings in place, but you can’t
use them anywhere else. The consequence of this is sharing common
strings is possible using FPSTR() but not F().
__FlashStringHelper is what the String class uses to overload its
constructor:

String(const char *cstr = nullptr); // constructor from const char *
String(const String &str); // copy constructor
String(const __FlashStringHelper *str); // constructor for flash strings





This allows you to write:

String mystring(F("This string is stored in flash"));





How do I write a function to use __FlashStringHelper? Simples: cast the pointer back to a PGM_P and use the _P functions shown above. This an example implementation for String for the concat function.

unsigned char String::concat(const __FlashStringHelper * str) {
    if (!str) return 0; // return if the pointer is void
    int length = strlen_P((PGM_P)str); // cast it to PGM_P, which is basically const char *, and measure it using the _P version of strlen.
    if (length == 0) return 1;
    unsigned int newlen = len + length;
    if (!reserve(newlen)) return 0; // create a buffer of the correct length
    strcpy_P(buffer + len, (PGM_P)str); //copy the string in using strcpy_P
    len = newlen;
    return 1;
}








How do I declare a global flash string and use it?

static const char xyz[] PROGMEM = "This is a string stored in flash. Len = %u";

void setup() {
    Serial.begin(115200); Serial.println();
    Serial.println( FPSTR(xyz) ); // just prints the string, must convert it to FlashStringHelper first using FPSTR().
    Serial.printf_P( xyz, strlen_P(xyz)); // use printf with PROGMEM string
}








How do I use inline flash strings?

void setup() {
    Serial.begin(115200); Serial.println();
    Serial.println( F("This is an inline string")); //
    Serial.printf_P( PSTR("This is an inline string using printf %s"), "hello");
}








How do I declare and use data in PROGMEM?

const size_t len_xyz = 30;
const uint8_t xyz[] PROGMEM = {
  0x53, 0x61, 0x79, 0x20, 0x48, 0x65, 0x6c, 0x6c, 0x6f, 0x20,
  0x74, 0x6f, 0x20, 0x4d, 0x79, 0x20, 0x4c, 0x69, 0x74, 0x74,
  0x6c, 0x65, 0x20, 0x46, 0x72, 0x69, 0x65, 0x6e, 0x64, 0x00};

 void setup() {
     Serial.begin(115200); Serial.println();
     uint8_t * buf = new uint8_t[len_xyz];
     if (buf) {
      memcpy_P(buf, xyz, len_xyz);
      Serial.write(buf, len_xyz); // output the buffer.
     }
 }








How do I declare some data in PROGMEM, and retrieve one byte from it.

Declare the data as done previously, then use pgm_read_byte to get
the value back.

const size_t len_xyz = 30;
const uint8_t xyz[] PROGMEM = {
  0x53, 0x61, 0x79, 0x20, 0x48, 0x65, 0x6c, 0x6c, 0x6f, 0x20,
  0x74, 0x6f, 0x20, 0x4d, 0x79, 0x20, 0x4c, 0x69, 0x74, 0x74,
  0x6c, 0x65, 0x20, 0x46, 0x72, 0x69, 0x65, 0x6e, 0x64, 0x00
};

void setup() {
  Serial.begin(115200); Serial.println();
  for (int i = 0; i < len_xyz; i++) {
    uint8_t byteval = pgm_read_byte(xyz + i);
    Serial.write(byteval); // output the buffer.
  }
}








How do I declare Arrays of strings in PROGMEM and retrieve an element from it.

It is often convenient when working with large amounts of text, such as a project with an LCD display, to setup an array of strings. Because strings themselves are arrays, this is actually an example of a two-dimensional array.

These tend to be large structures so putting them into program memory is often desirable. The code below illustrates the idea.

// Define Strings
const char string_0[] PROGMEM = "String 0";
const char string_1[] PROGMEM = "String 1";
const char string_2[] PROGMEM = "String 2";
const char string_3[] PROGMEM = "String 3";
const char string_4[] PROGMEM = "String 4";
const char string_5[] PROGMEM = "String 5";

// Initialize Table of Strings
const char* const string_table[] PROGMEM = { string_0, string_1, string_2, string_3, string_4, string_5 };

char buffer[30]; // buffer for reading the string to (needs to be large enough to take the longest string

void setup() {
  Serial.begin(9600);
  Serial.println("OK");
}

void loop() {
  for (int i = 0; i < 6; i++) {
    strcpy_P(buffer, (char*)pgm_read_dword(&(string_table[i])));
    Serial.println(buffer);
    delay(500);
  }
}








In summary

It is easy to store strings in flash using PROGMEM and PSTR but
you have to create functions that specifically use the pointers they
generate as they are basically const char *. On the other hand
FPSTR and F() give you a class that you can do implicit
conversions from, very useful when overloading functions, and doing
implicit type conversions. It is worth adding that if you wish to store
an int, float or pointer these can be stored and read back
directly as they are 4 bytes in size and therefore will be always
aligned!

Hope this helps.







            

          

      

      

    

  

    
      
          
            
  
Using GDB to Debug Applications

ESP applications can be debugged using GDB, the GNU debugger, which is
included with the standard IDE installation.  This note will only discuss
the ESP specific steps, so please refer to the
main GNU GDB documentation.

Note that as of 2.5.0, the toolchain moved from the ESPRESSIF patched,
closed-source version of GDB to the main GNU version.  The debugging
formats are different, so please be sure to use only the latest Arduino
toolchain GDB executable.


CLI and IDE Note

Because the Arduino IDE doesn’t support interactive debugging, the following
sections describe debugging using the command line.  Other IDEs which use
GDB in their debug backends should work identically, but you may need to
edit their configuration files or options to enable the remote serial
debugging required and to set the standard options.  PRs are happily
accepted for updates to this document with additional IDEs!




Preparing your application for GDB

Applications need to be changed to enable GDB debugging support.  This
change will add 2-3KB of flash and around 700 bytes of IRAM usage, but
should not affect operation of the application.

In your main sketch.ino file, add the following line to the top of
the application:

#include <GDBStub.h>





And in the void setup() function ensure the serial port is initialized
and call gdbstub_init():

Serial.begin(115200);
gdbstub_init();





Rebuild and reupload your application and it should run exactly as before.




Starting a Debug Session

Once your application is running, the process to attach a debugger is
quite simple:
. Close the Arduino Serial Monitor
. Locate Application.ino.elf File
. Open a Command Prompt and Start GDB
. Apply the GDB configurations
. Attach the Debugger
. Debug Away!


Close the Arduino Serial Monitor

Because GDB needs full control of the serial port, you will need to close
any Arduino Serial Monitor windows you may have open.  Otherwise GDB will
report an error while attempting to debug.




Locate Application.ino.elf File

In order for GDB to debug your application, you need to locate the compiled
ELF format version of it (which includes needed debug symbols).

Under Linux these files are stored in /tmp/arduino_build_* and the following command will help locate the right file for your app:

find /tmp -name "*.elf" -print





Under Windows these files are stored in %userprofile%\AppData\Local\Temp\arduino_build_* and the following command will help locate the right file for your app:

dir %userprofile%\appdata\*.elf /s/b





Note the full path of ELF file that corresponds to your sketch name, it will
be needed later once GDB is started.




Open a Command Prompt and Start GDB

Open a terminal or CMD prompt and navigate to the proper ESP8266 toolchain
directory.

Linux

~/.arduino15/packages/esp8266/tools/xtensa-lx106-elf-gcc/2.5.0-4-b40a506/bin/xtensa-lx106-elf-gdb





Windows (Using Board Manager version)

%userprofile%\AppData\Local\Arduino15\packages\esp8266\tools\xtensa-lx106-elf-gcc\2.5.0-3-20ed2b9\bin\xtensa-lx106-elf-gdb.exe





Windows (Using Git version)

%userprofile%\Documents\Arduino\hardware\esp8266com\esp8266\tools\xtensa-lx106-elf\bin\xtensa-lx106-elf-gdb.exe





Please note the proper GDB name is “xtensa-lx106-elf-gdb”.  If you accidentally
run “gdb” you may start your own operating system’s GDB, which will not know how
to talk to the ESP8266.




Apply the GDB Configurations

At the (gdb) prompt, enter the following options to configure GDB for the
ESP8266 memory map and configuration:

set remote hardware-breakpoint-limit 1
set remote hardware-watchpoint-limit 1
set remote interrupt-on-connect on
set remote kill-packet off
set remote symbol-lookup-packet off
set remote verbose-resume-packet off
mem 0x20000000 0x3fefffff ro cache
mem 0x3ff00000 0x3fffffff rw
mem 0x40000000 0x400fffff ro cache
mem 0x40100000 0x4013ffff rw cache
mem 0x40140000 0x5fffffff ro cache
mem 0x60000000 0x60001fff rw
set serial baud 115200





Now tell GDB where your compiled ELF file is located:

file /tmp/arduino_build_257110/sketch_dec26a.ino.elf








Attach the Debugger

Once GDB has been configured properly and loaded your debugging symbols, connect
it to the ESP with the command (replace the ttyUSB0 or COM9 with your ESP’s serial
port):

target remote /dev/ttyUSB0





or

target remote \\.\COM9





At this point GDB will send a stop the application on the ESP8266 and you can
begin setting a breakpoint (break loop) or any other debugging operation.






Example Debugging Session

Create a new sketch and paste the following code into it:

#include <GDBStub.h>

void setup() {
  Serial.begin(115200);
  gdbstub_init();
  Serial.printf("Starting...\n");
}

void loop() {
  static uint32_t cnt = 0;
  Serial.printf("%d\n", cnt++);
  delay(100);
}





Save it and then build and upload to your ESP8266.  On the Serial monitor you
should see something like

1
2
3
....





Now close the Serial Monitor.

Open a command prompt and find the ELF file:

earle@server:~$ find /tmp -name "*.elf" -print
/tmp/arduino_build_257110/testgdb.ino.elf
/tmp/arduino_build_531411/listfiles.ino.elf
/tmp/arduino_build_156712/SDWebServer.ino.elf





In this example there are multiple elf files found, but we only care about
the one we just built, testgdb.ino.elf.

Open up the proper ESP8266-specific GDB

earle@server:~$ ~/.arduino15/packages/esp8266/hardware/xtensa-lx106-elf/bin/xtensa-lx106-elf-gdb
GNU gdb (GDB) 8.2.50.20180723-git
Copyright (C) 2018 Free Software Foundation, Inc.
License GPLv3+: GNU GPL version 3 or later <https://gnu.org/licenses/gpl.html>
This is free software: you are free to change and redistribute it.
There is NO WARRANTY, to the extent permitted by law.
Type "show copying" and "show warranty" for details.
This GDB was configured as "--host=x86_64-linux-gnu --target=xtensa-lx106-elf".
Type "show configuration" for configuration details.
For bug reporting instructions, please see:
    <https://www.gnu.org/software/gdb/bugs/>.
Find the GDB manual and other documentation resources online at:
    <https://www.gnu.org/software/gdb/documentation/>.

For help, type "help".
Type "apropos word" to search for commands related to "word".
(gdb)





We’re now at the GDB prompt, but nothing has been set up for the ESP8266
and no debug information has been loaded.  Cut-and-paste the setup options:

(gdb) set remote hardware-breakpoint-limit 1
(gdb) set remote hardware-watchpoint-limit 1
(gdb) set remote interrupt-on-connect on
(gdb) set remote kill-packet off
(gdb) set remote symbol-lookup-packet off
(gdb) set remote verbose-resume-packet off
(gdb) mem 0x20000000 0x3fefffff ro cache
(gdb) mem 0x3ff00000 0x3fffffff rw
(gdb) mem 0x40000000 0x400fffff ro cache
(gdb) mem 0x40100000 0x4013ffff rw cache
(gdb) mem 0x40140000 0x5fffffff ro cache
(gdb) mem 0x60000000 0x60001fff rw
(gdb) set serial baud 115200
(gdb)





And tell GDB where the debugging info ELF file is located:

(gdb) file /tmp/arduino_build_257110/testgdb.ino.elf
Reading symbols from /tmp/arduino_build_257110/testgdb.ino.elf...done.





Now, connect to the running ESP8266:

(gdb)     target remote /dev/ttyUSB0
Remote debugging using /dev/ttyUSB0
0x40000f68 in ?? ()
(gdb)





Don’t worry that GDB doesn’t know what is at our present address, we broke
into the code at a random spot and we could be in an interrupt, in the
ROM, or elsewhere.  The important bit is that we’re now connected and
two things will now happen: we can debug, and the app’s regular serial
output will be displayed on the GDB console..

Continue the running app to see the serial output:

(gdb) cont
Continuing.
74
75
76
77
...





The app is back running and we can stop it at any time using Ctrl-C:

113
^C
Program received signal SIGINT, Interrupt.
0x40000f68 in ?? ()
(gdb)





At this point we can set a breakpoint on the main loop() and restart
to get into our own code:

(gdb) break loop
Breakpoint 1 at 0x40202e33: file /home/earle/Arduino/sketch_dec26a/sketch_dec26a.ino, line 10.
(gdb) cont
Continuing.
Note: automatically using hardware breakpoints for read-only addresses.
bcn_timout,ap_probe_send_start

Breakpoint 1, loop () at /home/earle/Arduino/sketch_dec26a/sketch_dec26a.ino:10
10  void loop()
(gdb)





Let’s examine the local variable:

(gdb) next
loop () at /home/earle/Arduino/sketch_dec26a/sketch_dec26a.ino:13
13      Serial.printf("%d\n", cnt++);
(gdb) print cnt
$1 = 114
(gdb)





And change it:

$2 = 114
(gdb) set cnt = 2000
(gdb) print cnt
$3 = 2000
(gdb)





And restart the app and see our changes take effect:

(gdb) cont
Continuing.
2000
Breakpoint 1, loop () at /home/earle/Arduino/sketch_dec26a/sketch_dec26a.ino:10
10  void loop() {
(gdb) cont
Continuing.
2001
Breakpoint 1, loop () at /home/earle/Arduino/sketch_dec26a/sketch_dec26a.ino:10
10  void loop() {
(gdb)





Looks like we left the breakpoint on loop(), let’s get rid of it and try again:

(gdb) delete
Delete all breakpoints? (y or n) y
(gdb) cont
Continuing.
2002
2003
2004
2005
2006
....





At this point we can exit GDB with quit or do further debugging.




ESP8266 Hardware Debugging Limitations

The ESP8266 only supports a single hardware breakpoint and a single
hardware data watchpoint.  This means only one breakpoint in user code
is allowed at any time.  Consider using the thb (temporary hardware
breakpoint) command in GDB while debugging instead of the more common
break command, since thb will remove the breakpoint once it is
reached automatically and save you some trouble.

Because of the single hardware breakpoint limitation, you must pay careful
attention to the output from gdb when you set a breakpoint. If your
breakpoint expression matches multiple locations, as in this example:

(gdb) break loop
Breakpoint 1 at 0x40202c84: loop. (2 locations)





Then you will be unable to continue:

(gdb) cont
Continuing.
Note: automatically using hardware breakpoints for read-only addresses.
Warning:
Cannot insert hardware breakpoint 1.
Could not insert hardware breakpoints:
You may have requested too many hardware breakpoints/watchpoints.





You can resolve this situation by deleting the previous breakpoint and
using a more specific breakpoint expression:

(gdb) delete
Delete all breakpoints? (y or n) y
(gdb) break mysketch.ino:loop
Breakpoint 2 at 0x40202c84: file .../mysketch.ino, line 113.











            

          

      

      

    

  

    
      
          
            
  
MMU - Adjust the Ratio of ICACHE to IRAM


Overview

The ESP8266 has a total of 64K of instruction memory, IRAM. This 64K of
IRAM is composed of one dedicated 32K block of IRAM and two 16K blocks
of IRAM. The last two 16K blocks of IRAM are flexible in the sense that
it can be used as a transparent cache for external flash memory. These
blocks can either be used for IRAM or an instruction cache for executing
code out of flash, ICACHE.

The code generated for a sketch is divided up into two groups, ICACHE
and IRAM. IRAM offers faster execution. It is used for interrupt service
routines, exception handling, and time-critical code. The ICACHE allows
for the execution of up to 1MB of code stored in flash. On a cache miss,
a delay occurs as the instructions are read from flash via the SPI bus.

There is 98KB of DRAM space. This memory can be accessed as byte, short,
or a 32-bit word. Access must be aligned according to the data type
size. A 16bit short must be on a multiple of 2-byte address boundary.
Likewise, a 32-bit word must be on a multiple of 4-byte address
boundary. In contrast, data access in IRAM or ICACHE must always be a
full 32-bit word and aligned. We will discuss a non32-bit exception
handler for this later.




Option Summary


The Arduino IDE Tools menu option, MMU has the following selections:


	32KB cache + 32KB IRAM (balanced)


	This is the legacy ratio.


	Try this option 1st.






	16KB cache + 48KB IRAM (IRAM)


	With just 16KB cache, execution of code out of flash may be slowed
by more cache misses when compared to 32KB. The slowness will vary
with the sketch.


	Use this if you need a little more IRAM space, and you have enough
DRAM space.






	16KB cache + 48KB IRAM and 2nd Heap (shared)


	This option builds on the previous option and creates a 2nd Heap
made with IRAM.


	The 2nd Heap size will vary with free IRAM.


	This option is flexible. IRAM usage for code can overflow into the
additional 16KB IRAM region, shrinking the 2nd Heap below 16KB. Or
IRAM can be under 32KB, allowing the 2nd Heap to be larger than
16KB.


	Installs a Non-32-Bit Access handler for IRAM. This allows for
byte and 16-bit aligned short access.


	This 2nd Heap is supported by the standard malloc APIs.


	Heap selection is handled through a HeapSelect class. This
allows a specific heap selection for the duration of a scope.


	Use this option, if you are still running out of DRAM space after
you have moved as many of your constant strings/data elements that
you can to PROGMEM.






	16KB cache + 32KB IRAM + 16KB 2nd Heap (not shared)


	Not managed by the umm_malloc heap library


	If required, non-32-Bit Access for IRAM must be enabled
separately.


	Enables a 16KB block of unmanaged IRAM memory


	Data persist across reboots, but not deep sleep.


	Works well for when you need a simple large chunk of memory. This
option will reduce the resources required to support a shared 2nd
Heap.








MMU related build defines and possible values. These values change as
indicated with the menu options above:










	#define

	balanced

	IRAM

	shared
(IRAM and
Heap)

	not shared
(IRAM and
Heap)





	MMU_
IRAM_SIZE

	0x8000

	0xC000

	0xC000

	0x8000



	MMU_IC
ACHE_SIZE

	0x8000

	0x4000

	0x4000

	0x4000



	MMU_
IRAM_HEAP

	–

	–

	defined,
e
nablesu
mm_malloc

	–



	MMU
_SEC_HEAP

	–

	**

	**

	0
x40108000



	MMU_SEC_
HEAP_SIZE

	–

	**

	**

	0x4000






** This define is to an inline function that calculates the value,
based on unused code space, requires #include <mmu_iram.h>.




The Arduino IDE Tools menu option, Non-32-Bit Access has the following selections:


	Use pgm_read macros for IRAM/PROGMEM


	Byte/Word access to IRAM/PROGMEM (very slow)


	This option adds a non32-bit exception handler to your build.


	Handles read/writes to IRAM and reads to ICACHE.


	Supports short and byte access to IRAM


	Not recommended for high-frequency access data, use DRAM if you
can.


	Expect it to be slower than DRAM, each character access, will
require a complete save and restore of all 16+ registers.


	Processing an exception uses 256 bytes of stack space just to get
started. The actual handler will add a little more.


	This option is implicitly enabled and required when you select MMU
option 16KB cache + 48KB IRAM and 2nd Heap (shared).








IRAM, unlike DRAM, must be accessed as aligned full 32-bit words, no
byte or short access. The pgm_read macros are an option; however, the
store operation remains an issue. For a block copy, ets_memcpy appears
to work well as long as the byte count is rounded up to be evenly
divided by 4, and source and destination addresses are 4 bytes aligned.

A word of caution, I have seen one case with the new toolchain 10.1
where code that reads a 32-bit word to extract a byte was optimized away
to be a byte read. Using volatile on the pointer stopped the
over-optimization.

To get a sense of how memory access time is effected, see examples
MMU48K and irammem in ESP8266.

NON-OS SDK v3.0.0 and above have builtin support for Non-32-Bit Access.
Selecting Byte/Word access to IRAM/PROGMEM will override the builtin
version with ours. However, there is no known reason to do this other
than debugging.






Miscellaneous


For calls to umm_malloc with interrupts disabled.


	malloc will always allocate from the DRAM heap when called
with interrupts disabled.


	realloc with a NULL pointer will use malloc and return a
DRAM heap allocation. Note, calling realloc with
interrupts disabled is not officially supported. You are on
your own if you do this.






	If you must use IRAM memory in your ISR, allocate the memory in your
init code. To reduce the time spent in the ISR, avoid non32-bit
access that would trigger the exception handler. For short or byte
access, consider using the inline functions described in section
“Performance Functions” below.







How to Select Heap

The MMU selection 16KB cache + 48KB IRAM and 2nd Heap (shared)
allows you to use the standard heap API function calls (malloc,
calloc, free, … ). to allocate memory from DRAM or IRAM. This
selection can be made by instantiating the class HeapSelectIram or
HeapSelectDram. The usage is similar to that of the
InterruptLock class. The default/initial heap source is DRAM. The
class is in umm_malloc/umm_heap_select.h.

...
  char *bufferDram;
  bufferDram = (char *)malloc(33);
  char *bufferIram;
  {
      HeapSelectIram ephemeral;
      bufferIram = (char *)malloc(33);
  }
...
  free(bufferIram);
  free(bufferDram);
...





free will always return memory to the correct heap. There is no need
for tracking and selecting before freeing.

realloc with a non-NULL pointer will always resize the allocation
from the original heap it was allocated from. When the supplied pointer
is NULL, then the current heap selection is used.

Low-level primitives for selecting a heap. These are used by the above
Classes:


	umm_get_current_heap_id()


	umm_set_heap_by_id( ID value )


	Possible ID values


	UMM_HEAP_DRAM


	UMM_HEAP_IRAM








Also, an alternate stack select method API is available. This is not as
easy as the class method; however, for some small set of cases, it may
provide some additional control:


	ESP.setIramHeap() Pushes current heap ID onto a stack and sets
Heap API for an IRAM selection.


	ESP.setDramHeap() Pushes current heap ID onto a stack and sets
Heap API for a DRAM selection.


	ESP.resetHeap() Restores previously pushed heap. ### Identify
Memory




These always inlined functions can be used to determine the resource of
a pointer:

bool mmu_is_iram(const void *addr);
bool mmu_is_dram(const void *addr);
bool mmu_is_icache(const void *addr);








Performance Functions

While these always inlined functions, will bypass the need for the
exception handler reducing execution time and stack use, it comes at the
cost of increased code size.

These are an alternative to the pgm_read macros for reading from
IRAM. When compiled with ‘Debug Level: core’ range checks are performed
on the pointer value to make sure you are reading from the address range
of IRAM, DRAM, or ICACHE.

uint8_t mmu_get_uint8(const void *p8);
uint16_t mmu_get_uint16(const uint16_t *p16);
int16_t mmu_get_int16(const int16_t *p16);





While these functions are intended for writing to IRAM, they will work
with DRAM. When compiled with ‘Debug Level: core’, range checks are
performed on the pointer value to make sure you are writing to the
address range of IRAM or DRAM.

uint8_t mmu_set_uint8(void *p8, const uint8_t val);
uint16_t mmu_set_uint16(uint16_t *p16, const uint16_t val);
int16_t mmu_set_int16(int16_t *p16, const int16_t val);













            

          

      

      

    

  

    
      
          
            
  
Boards


Generic ESP8266 Module

These modules come in different form factors and pinouts. See the page at ESP8266 community wiki for more info: ESP8266 Module Family [http://www.esp8266.com/wiki/doku.php?id=esp8266-module-family].

Usually these modules have no bootstrapping resistors on board, insufficient decoupling capacitors, no voltage regulator, no reset circuit, and no USB-serial adapter. This makes using them somewhat tricky, compared to development boards which add these features.

In order to use these modules, make sure to observe the following:


	Provide sufficient power to the module. For stable use of the ESP8266 a power supply with 3.3V and >= 250mA is required. Using the power available from USB to Serial adapter is not recommended, these adapters typically do not supply enough current to run ESP8266 reliably in every situation. An external supply or regulator alongwith filtering capacitors is preferred.


	Connect bootstrapping resistors to GPIO0, GPIO2, GPIO15 according to the schematics below.


	Put ESP8266 into bootloader mode before uploading code.







Serial Adapter

There are many different USB to Serial adapters / boards. To be able to put ESP8266 into bootloader mode using serial handshaking lines, you need the adapter which breaks out RTS and DTR outputs. CTS and DSR are not useful for upload (they are inputs). Make sure the adapter can work with 3.3V IO voltage: it should have a jumper or a switch to select between 5V and 3.3V, or be marked as 3.3V only.

Adapters based around the following ICs should work:


	FT232RL


	CP2102


	CH340G




PL2303-based adapters are known not to work on Mac OS X. See https://github.com/igrr/esptool-ck/issues/9 for more info.




Minimal Hardware Setup for Bootloading and Usage








	PIN

	Resistor

	Serial Adapter





	VCC

	
	VCC (3.3V)



	GND

	
	GND



	TX or GPIO2*

	
	RX



	RX

	
	TX



	GPIO0

	PullUp

	DTR



	Reset*

	PullUp

	RTS



	GPIO15*

	PullDown

	


	CH_PD

	PullUp

	






	Note


	GPIO15 is also named MTDO


	Reset is also named RSBT or REST (adding PullUp improves the
stability of the module)


	GPIO2 is alternative TX for the boot loader mode


	Directly connecting a pin to VCC or GND is not a substitute for a
PullUp or PullDown resistor, doing this can break upload management
and the serial console, instability has also been noted in some
cases.







ESP to Serial


[image: ESP to Serial]
ESP to Serial




Minimal Hardware Setup for Bootloading only

ESPxx Hardware








	PIN

	Resistor

	Serial Adapter





	VCC

	
	VCC (3.3V)



	GND

	
	GND



	TX or GPIO2

	
	RX



	RX

	
	TX



	GPIO0

	
	GND



	Reset

	
	RTS*



	GPIO15

	PullDown

	


	CH_PD

	PullUp

	






	Note


	if no RTS is used a manual power toggle is needed







Minimal Hardware Setup for Running only

ESPxx Hardware








	PIN

	Resistor

	Power supply





	VCC

	
	VCC (3.3V)



	GND

	
	GND



	GPIO0

	PullUp

	


	GPIO15

	PullDown

	


	CH_PD

	PullUp

	










Minimal
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Improved Stability


[image: ESP improved stability]
ESP improved stability






Boot Messages and Modes

The ESP module checks at every boot the Pins 0, 2 and 15. based on them its boots in different modes:









	GPIO15

	GPIO0

	GPIO2

	Mode





	0V

	0V

	3.3V

	Uart Bootloader



	0V

	3.3V

	3.3V

	Boot sketch (SPI flash)



	3.3V

	x

	x

	SDIO mode (not used for Arduino)






at startup the ESP prints out the current boot mode example:

rst cause:2, boot mode:(3,6)





note: - GPIO2 is used as TX output and the internal Pullup is enabled on boot.


rst cause







	Number

	Description





	0

	unknown



	1

	normal boot



	2

	reset pin



	3

	software reset



	4

	watchdog reset









boot mode

the first value respects the pin setup of the Pins 0, 2 and 15.










	Number

	GPIO15

	GPIO0

	GPIO2

	Mode





	0

	0V

	0V

	0V

	Not valid



	1

	0V

	0V

	3.3V

	Uart



	2

	0V

	3.3V

	0V

	Not valid



	3

	0V

	3.3V

	3.3V

	Flash



	4

	3.3V

	0V

	0V

	SDIO



	5

	3.3V

	0V

	3.3V

	SDIO



	6

	3.3V

	3.3V

	0V

	SDIO



	7

	3.3V

	3.3V

	3.3V

	SDIO






note: - number = ((GPIO15 << 2) | (GPIO0 << 1) | GPIO2);






Generic ESP8285 Module

ESP8285 (datasheet [http://www.espressif.com/sites/default/files/0a-esp8285_datasheet_en_v1.0_20160422.pdf]) is a multi-chip package which contains ESP8266 and 1MB flash. All points related to bootstrapping resistors and recommended circuits listed above apply to ESP8285 as well.

Note that since ESP8285 has SPI flash memory internally connected in DOUT mode, pins 9 and 10 may be used as GPIO / I2C / PWM pins.




Lifely Agrumino Lemon v4

Procuct page https://www.lifely.cc

This Board “Lifely Agrumino Lemon” is based with WT8266-S1 core with WiFi 2,4Ghz and 2MB of Flash.
Power
Micro usb power cable, Lir2450 rechargeable battery (or not rechargeable)or with JST connector in the back board Max 6 Vin
Libraries and examples
Download libraries from: Official Arduino Ide, our website https://www.lifely.cc or https://github.com/lifely-cc/
Full pinout and PDF for setup here https://www.lifely.cc our libraries is OpenSource




ESPDuino (ESP-13 Module)

TODO




Adafruit Feather HUZZAH ESP8266

The Adafruit Feather HUZZAH ESP8266 is an Arduino-compatible Wi-Fi development board powered by Ai-Thinker’s ESP-12S, clocked at 80 MHz at 3.3V logic. A high-quality SiLabs CP2104 USB-Serial chip is included so that you can upload code at a blistering 921600 baud for fast development time. It also has auto-reset so no noodling with pins and reset button pressings. A 3.7V Lithium polymer battery connector is included, making it ideal for portable projects. The Adafruit Feather HUZZAH ESP8266 will automatically recharge a connected battery when USB power is available.

Product page: https://www.adafruit.com/product/2821




WiFi Kit 8

The Heltec WiFi Kit 8 is an Arduino-compatible Wi-Fi development board powered by Ai-Thinker’s ESP-12S, clocked at 80 MHz at 3.3V logic. A high-quality SiLabs CP2104 USB-Serial chip is included so that you can upload code at a blistering 921600 baud for fast development time. It also has auto-reset so no noodling with pins and reset button pressings. A 3.7V Lithium polymer battery connector is included, making it ideal for portable projects. The Heltec WiFi Kit 8 will automatically recharge a connected battery when USB power is available.

Product page: https://github.com/Heltec-Aaron-Lee/WiFi_Kit_series




Invent One

The Invent One is an Arduino-compatible Wi-Fi development board powered by Ai-Thinker’s ESP-12F, clocked at 80 MHz at 3.3V logic. It has an onboard ADC (PCF8591) so that you can have multiple analog inputs to work with. More information can be found here: https://blog.inventone.ng

Product page: https://inventone.ng




XinaBox CW01

The XinaBox CW01(ESP8266) is an Arduino-compatible Wi-Fi development board powered by an ESP-12F, clocked at 80 MHz at 3.3V logic. The CW01 has an onboard RGB LED and 3 xBUS connection ports.

Product page: https://xinabox.cc/products/CW01




ESPresso Lite 1.0

ESPresso Lite 1.0 (beta version) is an Arduino-compatible Wi-Fi development board powered by Espressif System’s own ESP8266 WROOM-02 module. It has breadboard-friendly breakout pins with in-built LED, two reset/flash buttons and a user programmable button . The operating voltage is 3.3VDC, regulated with 800mA maximum current. Special distinctive features include on-board I2C pads that allow direct connection to OLED LCD and sensor boards.




ESPresso Lite 2.0

ESPresso Lite 2.0 is an Arduino-compatible Wi-Fi development board based on an earlier V1 (beta version). Re-designed together with Cytron Technologies, the newly-revised ESPresso Lite V2.0 features the auto-load/auto-program function, eliminating the previous need to reset the board manually before flashing a new program. It also feature two user programmable side buttons and a reset button. The special distinctive features of on-board pads for I2C sensor and actuator is retained.




Phoenix 1.0

Product page: http://www.espert.co




Phoenix 2.0

Product page: http://www.espert.co




NodeMCU 0.9 (ESP-12 Module)


Pin mapping

Pin numbers written on the board itself do not correspond to ESP8266 GPIO pin numbers. Constants are defined to make using this board easier:

static const uint8_t D0   = 16;
static const uint8_t D1   = 5;
static const uint8_t D2   = 4;
static const uint8_t D3   = 0;
static const uint8_t D4   = 2;
static const uint8_t D5   = 14;
static const uint8_t D6   = 12;
static const uint8_t D7   = 13;
static const uint8_t D8   = 15;
static const uint8_t D9   = 3;
static const uint8_t D10  = 1;





If you want to use NodeMCU pin 5, use D5 for pin number, and it will be translated to ‘real’ GPIO pin 14.






NodeMCU 1.0 (ESP-12E Module)

This module is sold under many names for around $6.50 on AliExpress and it’s one of the cheapest, fully integrated ESP8266 solutions.

It’s an open hardware design with an ESP-12E core and 4 MB of SPI flash.

According to the manufacturer, “with a micro USB cable, you can connect NodeMCU devkit to your laptop and flash it without any trouble”. This is more or less true: the board comes with a CP2102 onboard USB to serial adapter which just works, well, the majority of the time. Sometimes flashing fails and you have to reset the board by holding down FLASH +
RST, then releasing FLASH, then releasing RST. This forces the CP2102 device to power cycle and to be re-numbered by Linux.

The board also features a NCP1117 voltage regulator, a blue LED on GPIO16 and a 220k/100k Ohm voltage divider on the ADC input pin.
The ESP-12E usually has a led connected on GPIO2.

Full pinout and PDF schematics can be found here [https://github.com/nodemcu/nodemcu-devkit-v1.0]




Olimex MOD-WIFI-ESP8266(-DEV)

This board comes with 2 MB of SPI flash and optional accessories (e.g. evaluation board ESP8266-EVB or BAT-BOX for batteries).

The basic module has three solder jumpers that allow you to switch the operating mode between SDIO, UART and FLASH.

The board is shipped for FLASH operation mode, with jumpers TD0JP=0, IO0JP=1, IO2JP=1.

Since jumper IO0JP is tied to GPIO0, which is PIN 21, you’ll have to ground it before programming with a USB to serial adapter and reset the board by power cycling it.

UART pins for programming and serial I/O are GPIO1 (TXD, pin 3) and GPIO3 (RXD, pin 4).

You can find the board schematics here [https://github.com/OLIMEX/ESP8266/blob/master/HARDWARE/MOD-WIFI-ESP8266-DEV/MOD-WIFI-ESP8266-DEV_schematic.pdf]




SparkFun ESP8266 Thing

Product page: https://www.sparkfun.com/products/13231




SparkFun ESP8266 Thing Dev

Product page: https://www.sparkfun.com/products/13711




SparkFun Blynk Board

Product page: https://www.sparkfun.com/products/13794




SweetPea ESP-210

TODO




LOLIN(WEMOS) D1 R2 & mini

Product page: https://www.wemos.cc/




LOLIN(WEMOS) D1 ESP-WROOM-02

No real product pages. See: https://www.instructables.com/How-to-Use-Wemos-ESP-Wroom-02-D1-Mini-WiFi-Module-/ or https://www.arduino-tech.com/wemos-esp-wroom-02-mainboard-d1-mini-wifi-module-esp826618650-battery/




LOLIN(WEMOS) D1 mini (clone)

Clone variant of the LOLIN(WEMOS) D1 mini board,
with enabled flash-mode menu, DOUT selected by default.

Product page of the preferred official board: https://www.wemos.cc/




LOLIN(WEMOS) D1 mini Pro

Product page: https://www.wemos.cc/




LOLIN(WEMOS) D1 mini Lite


Parameters in Arduino IDE:


	Card: “WEMOS D1 Mini Lite”


	Flash Size: “1M (512K FS)”


	CPU Frequency: “80 Mhz”







Power:


	5V pin : 4.7V 500mA output when the board is powered by USB ; 3.5V-6V input


	3V3 pin : 3.3V 500mA regulated output


	Digital pins : 3.3V 30mA.







links:


	Product page: https://www.wemos.cc/


	Board schematic: https://wiki.wemos.cc/_media/products:d1:sch_d1_mini_lite_v1.0.0.pdf


	ESP8285 datasheet: https://www.espressif.com/sites/default/files/0a-esp8285_datasheet_en_v1.0_20160422.pdf


	Voltage regulator datasheet: http://pdf-datasheet.datasheet.netdna-cdn.com/pdf-down/M/E/6/ME6211-Microne.pdf









LOLIN(WeMos) D1 R1

Product page: https://www.wemos.cc/




ESPino (ESP-12 Module)

ESPino integrates the ESP-12 module with a 3.3v regulator, CP2104 USB-Serial bridge and a micro USB connector for easy programming. It is designed for fitting in a breadboard and has an RGB Led and two buttons for easy prototyping.

For more information about the hardware, pinout diagram and programming procedures, please see the datasheet [https://github.com/makerlabmx/ESPino-tools/raw/master/Docs/ESPino-Datasheet-EN.pdf].

Product page: http://www.espino.io/en




ThaiEasyElec’s ESPino

ESPino by ThaiEasyElec using WROOM-02 module from Espressif Systems with 4 MB Flash.

We will update an English description soon. - Product page:
http://thaieasyelec.com/products/wireless-modules/wifi-modules/espino-wifi-development-board-detail.html
- Schematics:
www.thaieasyelec.com/downloads/ETEE052/ETEE052_ESPino_Schematic.pdf -
Dimensions:
http://thaieasyelec.com/downloads/ETEE052/ETEE052_ESPino_Dimension.pdf
- Pinouts:
http://thaieasyelec.com/downloads/ETEE052/ETEE052_ESPino_User_Manual_TH_v1_0_20160204.pdf (Please see pg. 8)




WifInfo

WifInfo integrates the ESP-12 or ESP-07+Ext antenna module with a 3.3v regulator and the hardware to be able to measure French telemetry issue from ERDF powering meter serial output. It has a USB connector for powering, an RGB WS2812 Led, 4 pins I2C connector to fit OLED or sensor, and two buttons + FTDI connector and auto reset feature.

For more information, please see WifInfo related blog [http://hallard.me/category/wifinfo/] entries, github [https://github.com/hallard/WifInfo] and community [https://community.hallard.me/category/16/wifinfo] forum.




Arduino

TODO




4D Systems gen4 IoD Range

gen4-IoD Range of ESP8266 powered Display Modules by 4D Systems.

2.4”, 2.8” and 3.2” TFT LCD with uSD card socket and Resistive Touch. Chip Antenna + uFL Connector.

Datasheet and associated downloads can be found on the 4D Systems product page.

The gen4-IoD range can be programmed using the Arduino IDE and also the 4D Systems Workshop4 IDE, which incorporates many additional graphics benefits. GFX4d library is available, along with a number of demo applications.


	Product page: https://4dsystems.com.au/products/iot-display-modules







Digistump Oak

The Oak requires an Serial Adapter for a serial connection or flashing; its micro USB port is only for power.

To make a serial connection, wire the adapter’s TX to P3, RX to P4, and GND to GND.  Supply 3.3v from the serial adapter if not already powered via USB.

To put the board into bootloader mode, configure a serial connection as above, connect P2 to GND, then re-apply power.  Once flashing is complete, remove the connection from P2 to GND, then re-apply power to boot into normal mode.




WiFiduino

Product page: https://wifiduino.com/esp8266




Amperka WiFi Slot

Product page: http://wiki.amperka.ru/wifi-slot




Seeed Wio Link

Wio Link is designed to simplify your IoT development. It is an ESP8266 based open-source Wi-Fi development board to create IoT applications by virtualizing plug-n-play modules to RESTful APIs with mobile APPs. Wio Link is also compatible with the Arduino IDE.

Please DO NOTICE that you MUST pull up pin 15 to enable the power for Grove ports, the board is designed like this for the purpose of peripherals power management.

Product page: https://www.seeedstudio.com/Wio-Link-p-2604.html




ESPectro Core

ESPectro Core is ESP8266 development board as the culmination of our 3+ year experience in exploring and developing products with ESP8266 MCU.

Initially designed for kids in mind, everybody should be able to use it. Yet it’s still hacker-friendly as we break out all ESP8266 ESP-12F pins.

More details at https://shop.makestro.com/product/espectrocore/




Schirmilabs Eduino WiFi

Eduino WiFi is an Arduino-compatible DIY WiFi development board using an ESP-12 module

Product page: https://schirmilabs.de/?page_id=165




ITEAD Sonoff

ESP8266 based devices from ITEAD: Sonoff SV, Sonoff TH, Sonoff Basic, and Sonoff S20

These are not development boards. The development process is inconvenient with these devices. When flashing firmware you will need a Serial Adapter to connect it to your computer.



Most of these devices, during normal operation, are connected to wall power (AKA Mains Electricity). NEVER try to flash these devices when connected to wall power. ALWAYS have them disconnected from wall power when connecting them to your computer. Your life may depend on it!






When flashing you will need to hold down the push button connected to the GPIO0 pin, while powering up with a safe 3.3 Volt source. Some USB Serial Adapters may supply enough power to handle flashing; however, it many may not supply enough power to handle the activities when the device reboots.

More product details at the bottom of https://www.itead.cc/wiki/Product/




DOIT ESP-Mx DevKit (ESP8285)

DOIT ESP-Mx DevKit - This is a development board by DOIT, with a DOIT ESP-Mx module (datasheet [https://github.com/SmartArduino/SZDOITWiKi/wiki/ESP8285---ESP-M2]) using a ESP8285 Chip. With the DOIT ESP-Mx module, GPIO pins 9 and 10 are not available. The DOIT ESP-Mx DevKit board has a red power LED and a blue LED connected to GPIO16 and is active low to turn on. It uses a CH340C, USB to Serial converter chip.

ESP8285 (datasheet [http://www.espressif.com/sites/default/files/0a-esp8285_datasheet_en_v1.0_20160422.pdf]) is a multi-chip package which contains ESP8266 and 1MB flash.







            

          

      

      

    

  

    
      
          
            
  
FAQ

The purpose of this FAQ / Troubleshooting is to respond to questions
commonly asked in Issues [https://github.com/esp8266/Arduino/issues]
section and on ESP8266 Community forum [https://www.esp8266.com/].

Where possible we are going right to the answer and provide it within
one or two paragraphs. If it takes more than that, you will see a link
to “Read more” details.

Please feel free to contribute if you believe that some frequent issues
are not covered below.


I am getting “espcomm_sync failed” error when trying to upload my ESP. How to resolve this issue?

This message indicates issue with uploading ESP module over a serial
connection. There are couple of possible causes, that depend on the type
of your module, if you use separate USB to serial converter.

Read more.




Why esptool is not listed in “Programmer” menu? How do I upload ESP without it?

Do not worry about “Programmer” menu of Arduino IDE. It doesn’t matter
what is selected in it — upload now always defaults to using esptool.

Ref. #138 [https://github.com/esp8266/Arduino/issues/138],
#653 [https://github.com/esp8266/Arduino/issues/653] and
#739 [https://github.com/esp8266/Arduino/issues/739].




My ESP crashes running some code. How to troubleshoot it?

The code may crash because of s/w bug or issue with your h/w. Before
entering an issue report, please perform initial troubleshooting.

Read more.




How can I get some extra KBs in flash ?


	Using *printf() with floats is enabled by default.  Some KBs of flash can
be saved by using the option --nofloat with the boards generator:

./tools/boards.txt.py --nofloat --boardsgen



	Use the debug level option NoAssert-NDEBUG (in the Tools menu)




Read more.




About WPS

From release 2.4.2 and ahead, not using WPS will give an extra ~4.5KB in
heap.

In release 2.4.2 only, WPS is disabled by default and the board generator is
required to enable it:

./tools/boards.txt.py --allowWPS --boardsgen

Read more.

For platformIO (and maybe other build environments), you will also need to add the build flag: -D NO_EXTRA_4K_HEAP

This manual selection is not needed starting from 2.5.0 (and in git
version).  WPS is always available, and not using it will give an extra
~4.5KB compared to releases until 2.4.1 included.




This Arduino library doesn’t work on ESP. How do I make it work?

You would like to use this Arduino library with ESP8266 and it does not
perform. It is not listed among libraries verified to work with ESP8266.

Read more.




In the IDE, for ESP-12E that has 4M flash, I can choose 4M (1M FS) or 4M (3M FS). No matter what I select, the IDE tells me the maximum code space is about 1M. Where does my flash go?

The reason we cannot have more than 1MB of code in flash has to do with
a hardware limitation. Flash cache hardware on the ESP8266 only allows
mapping 1MB of code into the CPU address space at any given time. You
can switch mapping offset, so technically you can have more than 1MB
total, but switching such “banks” on the fly is not easy and efficient,
so we don’t bother doing that. Besides, no one has so far complained
about 1MB of code space being insufficient for practical purposes.

The option to choose 3M or 1M filesystem is to optimize the upload time.
Uploading 3MB takes a long time so sometimes you can just use 1MB. Other
2MB of flash can still be used with ESP.flashRead and
ESP.flashWrite APIs if necessary.




I have observed a case when ESP.restart() doesn’t work. What is the reason for that?

You will see this issue only if serial upload was not followed by a
physical reset (e.g. power-on reset). For a device being in that state
ESP.restart will not work. Apparently the issue is caused by one of
internal registers not being properly updated until physical
reset [https://github.com/esp8266/Arduino/issues/1017#issuecomment-200605576].
This issue concerns only serial uploads. OTA uploads are not affected.
If you are using ESP.restart, the work around is to reset ESP once
after each serial upload.

Ref. #1017 [https://github.com/esp8266/Arduino/issues/1017],
#1107 [https://github.com/esp8266/Arduino/issues/1107],
#1782 [https://github.com/esp8266/Arduino/issues/1782]




How to resolve “Board generic (platform esp8266, package esp8266) is unknown” error?

This error may pop up after switching between
staging [https://github.com/esp8266/Arduino#staging-version-] and
stable [https://github.com/esp8266/Arduino#stable-version-] esp8266
/ Arduino package installations, or after upgrading the package version
Read more.




How to clear TCP PCBs in time-wait state ?

This is not needed anymore:

PCBs in time-wait state are limited to 5 and removed when that number is
exceeded.

Ref.  https://github.com/d-a-v/esp82xx-nonos-linklayer/commit/420960dfc0dbe07114f7364845836ac333bc84f7

For reference:

Time-wait PCB state helps TCP not confusing two consecutive connections with the
same (s-ip,s-port,d-ip,d-port) when the first is already closed but still
having duplicate packets lost in internet arriving later during the second.
Artificially clearing them is a workaround to help saving precious heap.

// no need for #include
struct tcp_pcb;
extern struct tcp_pcb* tcp_tw_pcbs;
extern "C" void tcp_abort (struct tcp_pcb* pcb);

void tcpCleanup (void) {
  while (tcp_tw_pcbs)
    tcp_abort(tcp_tw_pcbs);
}





Ref.  #1923 [https://github.com/esp8266/Arduino/issues/1923]




Why is there a board generator and what about it ?

The board generator is a python script originally intended to ease the
Arduino IDE’s boards.txt configuration file about the multitude of
available boards, especially when common parameters have to be updated for
all of them.

This script is also used to manage uncommon options that are currently not
available in the IDE menu.

Read more.




My WiFi won’t reconnect after deep sleep using WAKE_RF_DISABLED

When you implement deep sleep using WAKE_RF_DISABLED, this forces what
appears to be a bare metal disabling of WiFi functionality, which is not
restored using WiFi.forceSleepWake() or WiFi.mode(WIFI_STA). If you need
to implement deep sleep with WAKE_RF_DISABLED and later connect to WiFi, you
will need to implement an additional (short) deep sleep using
WAKE_RF_DEFAULT.

Ref.  #3072 [https://github.com/esp8266/Arduino/issues/3072]




My WiFi was previously automatically connected right after booting, but isn’t anymore

This was WiFi persistence.  Starting from version 3 of this core, WiFi is
indeed off at boot and is powered on only when starting to be used with the
regular API.

Read more at former WiFi persistent mode.




How to resolve “undefined reference to flashinit” error ?

Please read flash layout documentation entry.




How to specify global build defines and options?

By using a uniquely named .h file, macro definitions can be created and
globally used. Additionally, compiler command-line options can be embedded in
this file as a unique block comment.

Read more.







            

          

      

      

    

  

    
      
          
            
  
Exception Causes (EXCCAUSE)










	EXCCAUSE
Code

	Cause Name

	Cause Description

	Required
Option

	EXCVADDR
Loaded





	0

	IllegalInstructionCause

	Illegal instruction

	Exception

	No



	1

	SyscallCause

	SYSCALL instruction

	Exception

	No



	2

	InstructionFetchErrorCause

	Processor internal physical address or
data error during instruction fetch

	Exception

	Yes



	3

	LoadStoreErrorCause

	Processor internal physical address or
data error during load or store

	Exception

	Yes



	4

	Level1InterruptCause

	Level-1 interrupt as indicated by set
level-1 bits in the INTERRUPT register

	Interrupt

	No



	5

	AllocaCause

	MOVSP instruction, if caller’s
registers are not in the register file

	Windowed
Register

	No



	6

	IntegerDivideByZeroCause

	QUOS, QUOU, REMS, or REMU divisor
operand is zero

	32-bit
Integer
Divide

	No



	7

	Reserved for Tensilica

	
	
	


	8

	PrivilegedCause

	Attempt to execute a privileged
operation when CRING != 0

	MMU

	No



	9

	LoadStoreAlignmentCause

	Load or store to an unaligned address

	Unaligned
Exception

	Yes



	10..11

	Reserved for Tensilica

	
	
	


	12

	InstrPIFDateErrorCause

	PIF data error during instruction fetch

	Processor
Interface

	Yes



	13

	LoadStorePIFDataErrorCause

	Synchronous PIF data error during
LoadStore access

	Processor
Interface

	Yes



	14

	InstrPIFAddrErrorCause

	PIF address error during instruction
fetch

	Processor
Interface

	Yes



	15

	LoadStorePIFAddrErrorCause

	Synchronous PIF address error during
LoadStore access

	Processor
Interface

	Yes



	16

	InstTLBMissCause

	Error during Instruction TLB refill

	MMU

	Yes



	17

	InstTLBMultiHitCause

	Multiple instruction TLB entries
matched

	MMU

	Yes



	18

	InstFetchPrivilegeCause

	An instruction fetch referenced a
virtual address at a ring level less
than CRING

	MMU

	Yes



	19

	Reserved for Tensilica

	
	
	


	20

	InstFetchProhibitedCause

	An instruction fetch referenced a page
mapped with an attribute that does not
permit instruction fetch

	Region
Protection
or MMU

	Yes



	21..23

	Reserved for Tensilica

	
	
	


	24

	LoadStoreTLBMissCause

	Error during TLB refill for a load or
store

	MMU

	Yes



	25

	LoadStoreTLBMultiHitCause

	Multiple TLB entries matched for a load
or store

	MMU

	Yes



	26

	LoadStorePrivilegeCause

	A load or store referenced a virtual
address at a ring level less than CRING

	MMU

	Yes



	27

	Reserved for Tensilica

	
	
	


	28

	LoadProhibitedCause

	A load referenced a page mapped with an
attribute that does not permit loads

	Region
Protection
or MMU

	Yes



	29

	StoreProhibitedCause

	A store referenced a page mapped with
an attribute that does not permit

	Region
Protection
or MMU

	Yes



	30..31

	Reserved for Tensilica

	
	
	


	32..39

	CoprocessornDisabled

	Coprocessor n instruction when cpn
disabled. n varies 0..7 as the cause
varies 32..39

	Coprocessor

	No



	40..63

	Reserved

	
	
	





Infos from Xtensa Instruction Set Architecture (ISA) Reference Manual





            

          

      

      

    

  

    
      
          
            
  
Debugging


Introduction

Since 2.1.0-rc1 the core includes a Debugging feature that is
controllable over the IDE menu.

The new menu points manage the real-time Debug messages.


Requirements

For usage of the debugging a Serial connection is required (Serial or
Serial1).

The Serial Interface need to be initialized in the setup().

Set the Serial baud rate as high as possible for your Hardware setup.

Minimum sketch to use debugging:

void setup() {
    Serial.begin(115200);
}

void loop() {
}








Usage


	Select the Serial interface for the Debugging messages: [image: Debug-Port]


	Select which type / level you want debug messages for: [image: Debug-Level]


	Check if the Serial interface is initialized in setup() (see
Requirements)


	Flash sketch


	Check the Serial Output









Information

It work with every sketch that enables the Serial interface that is
selected as debug port.

The Serial interface can still be used normal in the Sketch.

The debug output is additional and will not disable any interface from
usage in the sketch.


For Developers

For the debug handling uses defines.

The defined are set by command line.


Debug Port

The port has the define DEBUG_ESP_PORT possible value: - Disabled:
define not existing - Serial: Serial - Serial1: Serial1




Debug Level

All defines for the different levels starts with DEBUG_ESP_

a full list can be found here in the
boards.txt [https://github.com/esp8266/Arduino/blob/04c2322721f6865efe0c518be57e795e8643c183/tools/boards.txt.py#L1308-L1309]




Example for own debug messages

The debug messages will be only shown when the Debug Port in the IDE
menu is set.

#ifdef DEBUG_ESP_PORT
#define DEBUG_MSG(...) DEBUG_ESP_PORT.printf( __VA_ARGS__ )
#else
#define DEBUG_MSG(...)
#endif

void setup() {
    Serial.begin(115200);

    delay(3000);
    DEBUG_MSG("bootup...\n");
}

void loop() {
    DEBUG_MSG("loop %d\n", millis());
    delay(1000);
}















            

          

      

      

    

  

    
      
          
            
  
Stack Dumps


Introduction

If the ESP crashes the Exception Cause will be shown and the current stack will be dumped.

Example:

Exception (0): epc1=0x402103f4 epc2=0x00000000 epc3=0x00000000 excvaddr=0x00000000 depc=0x00000000

ctx: sys
sp: 3ffffc10 end: 3fffffb0 offset: 01a0

>>>stack>>>
3ffffdb0:  40223e00 3fff6f50 00000010 60000600
3ffffdc0:  00000001 4021f774 3fffc250 4000050c
3ffffdd0:  400043d5 00000030 00000016 ffffffff
3ffffde0:  400044ab 3fffc718 3ffffed0 08000000
3ffffdf0:  60000200 08000000 00000003 00000000
3ffffe00:  0000ffff 00000001 04000002 003fd000
3ffffe10:  3fff7188 000003fd 3fff2564 00000030
3ffffe20:  40101709 00000008 00000008 00000020
3ffffe30:  c1948db3 394c5e70 7f2060f2 c6ba0c87
3ffffe40:  3fff7058 00000001 40238d41 3fff6ff0
3ffffe50:  3fff6f50 00000010 60000600 00000020
3ffffe60:  402301a8 3fff7098 3fff7014 40238c77
3ffffe70:  4022fb6c 40230ebe 3fff1a5b 3fff6f00
3ffffe80:  3ffffec8 00000010 40231061 3fff0f90
3ffffe90:  3fff6848 3ffed0c0 60000600 3fff6ae0
3ffffea0:  3fff0f90 3fff0f90 3fff6848 3fff6d40
3ffffeb0:  3fff28e8 40101233 d634fe1a fffeffff
3ffffec0:  00000001 00000000 4022d5d6 3fff6848
3ffffed0:  00000002 4000410f 3fff2394 3fff6848
3ffffee0:  3fffc718 40004a3c 000003fd 3fff7188
3ffffef0:  3fffc718 40101510 00000378 3fff1a5b
3fffff00:  000003fd 4021d2e7 00000378 000003ff
3fffff10:  00001000 4021d37d 3fff2564 000003ff
3fffff20:  000003fd 60000600 003fd000 3fff2564
3fffff30:  ffffff00 55aa55aa 00000312 0000001c
3fffff40:  0000001c 0000008a 0000006d 000003ff
3fffff50:  4021d224 3ffecf90 00000000 3ffed0c0
3fffff60:  00000001 4021c2e9 00000003 3fff1238
3fffff70:  4021c071 3ffecf84 3ffecf30 0026a2b0
3fffff80:  4021c0b6 3fffdab0 00000000 3fffdcb0
3fffff90:  3ffecf40 3fffdab0 00000000 3fffdcc0
3fffffa0:  40000f49 40000f49 3fffdab0 40000f49
<<<stack<<<





The first number after Exception gives the cause of the reset. a
full list of all causes can be found here
the hex after are the stack dump.


Decode

It’s possible to decode the Stack to readable information.
You can get a copy and read about the Esp Exception Decoder [https://github.com/me-no-dev/EspExceptionDecoder] tool.

For a troubleshooting example using the Exception Decoder Tool, read FAQ: My ESP Crashes.


[image: ESP Exception Decoder]
ESP Exception Decoder











            

          

      

      

    

  

    
      
          
            
  
Using Eclipse with Arduino ESP8266


What to Download


	arduino IDE [https://www.arduino.cc/en/Main/Software]


	Eclipse IDE for C/C++
Developers [https://www.eclipse.org/downloads/packages/eclipse-ide-cc-developers/oxygen3a]


	Java [https://www.java.com/]







Setup Arduino

See the
Readme [https://github.com/esp8266/Arduino#installing-with-boards-manager]




Setup Eclipse


	step 1 [https://www.baeyens.it/eclipse/how_to.shtml#/c]


	step 2 [https://www.baeyens.it/eclipse/how_to.shtml#/e]


	go to Window –> preferences –> Arduino


	add as private hardware path the Part to the ESP8266




example private hardware path

Windows: C:\Users\[username]\AppData\Roaming\Arduino15\packages\esp8266\hardware
Linux: /home/[username]/.arduino15/packages/esp8266/hardware








Eclipse won’t build

if eclipse dont find the path to the Compiler add to the platform.txt
after:

version=1.6.4





this:

runtime.tools.xtensa-lx106-elf-gcc.path={runtime.platform.path}/../../../tools/xtensa-lx106-elf-gcc/1.20.0-26-gb404fb9
runtime.tools.esptool.path={runtime.platform.path}/../../../tools/esptool/0.4.4





Note: - the path may changed, check the current version. - each update
over the Arduino IDE will remove the fix - may not needed in future if
Eclipse Plugin get an Update
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BearSSL WiFi Classes

Methods and properties described in this section are specific to ESP8266. They are not covered in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] documentation. Before they are fully documented please refer to information below.

The BearSSL [https://bearssl.org] library (with modifications for ESP8266 compatibility and to use ROM tables whenever possible) is used to perform all cryptography and TLS operations.  The main ported repo is available on GitHub [https://github.com/earlephilhower/bearssl-esp8266].


CPU Requirements

SSL operations take significant CPU cycles to run, so it is recommended that all TLS/SSL sketches to run at 160 Mhz and not the default 80 Mhz.  Even at 160 MHz, certain key exchanges can take multiple seconds of runtime to complete.  There is no special cryptographic hardware in the ESP8266, nor is there a 32x32=>64 multiplier, nor is the program stored in onboard RAM, so there is little that can be done to speed this up.

See the section on sessions and limiting cryptographic negotiation for ways of ensuring faster modes are used.




Memory Requirements

BearSSL doesn’t perform memory allocations at runtime, but it does require allocation of memory at the beginning of a connection.  There are two memory chunks required:
. A per-application secondary stack
. A per-connection TLS receive/transmit buffer plus overhead

The per-application secondary stack is approximately 6KB in size and is used for temporary variables during BearSSL processing.  Only one stack is required, and it will be allocated whenever any BearSSL::WiFiClientSecure or BearSSL::WiFiServerSecure are instantiated.  So, in the case of a global client or server, the memory will be allocated before setup() is called.

The per-connection buffers are approximately 22KB in size, but in certain circumstances it can be reduced dramatically by using MFLN or limiting message sizes.  See the MLFN section below for more information.




Object Lifetimes

There are many configuration options that require passing in a pointer to an object (i.e. a pointer to a private key, or a certificate list).  In order to preserve memory, BearSSL does NOT copy the objects passed in via these pointers and as such any pointer passed in to BearSSL needs to be preserved for the life of the client object.  For example, the following code is in error:

BearSSL::WiFiClientSecure client;
const char x509CA PROGMEM = ".......";
void setup() {
    BearSSL::X509List x509(x509CA);
    client.setTrustAnchor(&x509);
}
void loop() {
    client.connect("192.168.1.1", 443);
}





Because the pointer to the local object x509 no longer is valid after setup(), expect to crash in the main loop() where it is accessed by the client object.

As a rule, either keep your objects global, use new to create them, or ensure that all objects needed live inside the same scope as the client.




TLS and HTTPS Basics

The following discussion is only intended to give a rough idea of TLS/HTTPS(which is just HTTP over a TLS connection) and the components an application needs to manage to make a TLS connection.  For more detailed information, please check the relevant RFC 5246 [https://tools.ietf.org/search/rfc5246] and others.

TLS can be broken into two stages: verifying the identities of server (and potentially client), and then encrypting blocks of data bidirectionally.  Verifying the identity of the other partner is handled via keys encoded in X509 certificates, optionally signed by a series of other entities.




Public and Private Keys

Cryptographic keys are required for many of the BearSSL functions.  Both public and private keys are supported, with either Elliptic Curve or RSA key support.

To generate a public or private key from an existing PEM (ASCII format) or DER (binary format), the simplest method is to use the constructor:

BearSSL::PublicKey(const char *pemString)
... or ...
BearSSL::PublicKey(const uint8_t *derArray, size_t derLen)





Note that PROGMEM strings and arrays are natively supported by these constructors and no special *_P modes are required.  There are additional functions to identify the key type and access the underlying BearSSL proprietary types, but they are not needed by user applications.




TLS Sessions

TLS supports the notion of a session (completely independent and different from HTTP sessions) which allow clients to reconnect to a server without having to renegotiate encryption settings or validate X509 certificates.  This can save significant time (3-4 seconds in the case of EC keys) and can help save power by allowing the ESP8266 to sleep for a long time, reconnect and transmit some samples using the SSL session, and then jump back to sleep quicker.

BearSSL::Session is an opaque class.  Use the BearSSL::WiFiClientSecure.setSession(&BearSSLSession) method to apply it before the first BearSSL::WiFiClientSecure.connect() and it will be updated with session parameters during the operation of the connection.  After the connection has had .close() called on it, serialize the BearSSL::Session object to stable storage (EEPROM, RTC RAM, etc.) and restore it before trying to reconnect.  See the BearSSL_Sessions example for a detailed example.

Sessions contains additional information on the sessions API.




X.509 Certificate(s)

X509 certificates are used to identify peers in TLS connections.  Normally only the server identifies itself, but the client can also supply an X509 certificate if desired (this is often done in MQTT applications).  The certificate contains many fields, but the most interesting in our applications are the name, the public key, and potentially a chain of signing that leads back to a trusted authority (like a global internet CA or a company-wide private certificate authority).

Any call that takes an X509 certificate can also take a list of X509 certificates, so there is no special X509 class, simply BearSSL::X509List (which may only contain a single certificate).

Generating a certificate to be used to validate using the constructor

BearSSL::X509List(const char *pemX509);
...or...
BearSSL::X509List(const uint8_t *derCert, size_t derLen);





If you need to add additional certificates (unlikely in normal operation), the ::append() operation can be used.




Certificate Stores

The web browser you’re using to read this document keeps a list of 100s of certification authorities (CAs) worldwide that it trusts to attest to the identity of websites.

In many cases your application will know the specific CA it needs to validate web or MQTT servers against (often just a single, self-signing CA private to your institution).  Simply load your private CA in a BearSSL::X509List and use that as your trust anchor.

However, there are cases where you will not know beforehand which CA you will need (i.e. a user enters a website through a keypad), and you need to keep the list of CAs just like your web browser.  In those cases, you need to generate a certificate bundle on the PC while compiling your application, upload the certs.ar bundle to LittleFS or SD when uploading your application binary, and pass it to a BearSSL::CertStore() in order to validate TLS peers.

See the BearSSL_CertStore example for full details.




Supported Crypto

Please see the BearSSL website [https://bearssl.org] for detailed cryptographic information.  In general, TLS 1.2, TLS 1.1, and TLS 1.0 are supported with RSA and Elliptic Curve keys and a very rich set of hashing and symmetric encryption codes.  Please note that Elliptic Curve (EC) key operations take a significant amount of time.






BearSSL::WiFiClientSecure Class

BearSSL::WiFiClientSecure is the object which actually handles TLS encrypted WiFi connections to a remote server or client.  It extends WiFiClient and so can be used with minimal changes to code that does unsecured communications.


Validating X509 Certificates (Am I talking to the server I think I’m talking to?)

Prior to connecting to a server, the BearSSL::WiFiClientSecure needs to be told how to verify the identity of the other machine.  By default BearSSL will not validate any connections and will refuse to connect to any server.

There are multiple modes to tell BearSSL how to verify the identity of the remote server.  See the BearSSL_Validation example for real uses of the following methods:


setInsecure()

Don’t verify any X509 certificates.  There is no guarantee that the server connected to is the one you think it is in this case.




setKnownKey(const BearSSL::PublicKey *pk)

Assume the server is using the specific public key.  This does not verify the identity of the server or the X509 certificate it sends, it simply assumes that its public key is the one given.  If the server updates its public key at a later point then connections will fail.




setFingerprint(const uint8_t fp[20]) / setFingerprint(const char *fpStr)

Verify the SHA1 fingerprint of the certificate returned matches this one.  If the server certificate changes, it will fail.  If an array of 20 bytes are sent in, it is assumed they are the binary SHA1 values.  If a char* string is passed in, it is parsed as a series of human-readable hex values separated by spaces or colons (e.g. setFingerprint(“00:01:02:03:…:1f”);)

This fingerprint is calculated on the raw X509 certificate served by the server.  In very rare cases, these certificates have certain encodings which should be normalized before taking a fingerprint (but in order to preserve memory BearSSL does not do this normalization since it would need RAM for an entire copy of the cert), and the fingerprint BearSSL calculates will not match the fingerprint OpenSSL calculates.  In this case, you can enable SSL debugging and get a dump of BearSSL’s calculated fingerprint and use that one in your code, or use full certificate validation.  See the original issue and debug here [https://github.com/esp8266/Arduino/issues/6209].




setTrustAnchors(BearSSL::X509List *ta)

Use the passed-in certificate(s) as a trust anchor, accepting remote certificates signed by any of these.  If you have many trust anchors it may make sense to use a BearSSL::CertStore because it will only require RAM for a single trust anchor (while the setTrustAnchors call requires memory for all certificates in the list).




setX509Time(time_t now)

For setTrustAnchors and CertStore , the current time (set via SNTP) is used to verify the certificate against the list, so SNTP must be enabled and functioning before the connection is attempted.  If you cannot use SNTP for some reason, you can manually set the “present time” that BearSSL will use to validate a certificate with this call where now is standard UNIX time.






Client Certificates (Proving I’m who I say I am to the server)

TLS servers can request that a client identify themselves with an X509 certificate signed by a trust anchor it honors (i.e. a global TA or a private CA).  This is commonly done for applications like MQTT.  By default the client doesn’t send a certificate, and in cases where a certificate is required the server will disconnect and no connection will be possible.


setClientRSACert / setClientECCert

Sets a client certificate to send to a TLS server that requests one.  It should be called before connect() to add a certificate to the client in case the server requests it.  Note that certificates include both a certificate and a private key.  Both should be provided to you by your certificate generator.  Elliptic Curve (EC) keys require additional information, as shown in the prototype.






MFLN or Maximum Fragment Length Negotiation (Saving RAM)

Because TLS was developed on systems with many megabytes of memory, they require by default a 16KB buffer for receive and transmit.  That’s enormous for the ESP8266, which has only around 40KB total heap available.

We can (and do) minimize the transmission buffer down to slightly more than 512 bytes to save memory, since BearSSL can internally ensure transmissions larger than that are broken up into smaller chunks that do fit.  But that still leaves the 16KB receive buffer requirement since we cannot in general guarantee the TLS peer will send in smaller chunks.

TLS 1.2 added MFLN, which lets a client negotiate smaller buffers with a server and reduce the memory requirements on the ESP8266.  Unfortunately, BearSSL needs to know the buffer sizes before it begins connection, so applications that want to use smaller buffers need to check the remote server’s support before connect() .


probeMaxFragmentLength(host, port, len)

Use one of these calls before connection to determine if a specific fragment length is supported (len must be a power of two from 512 to 4096, per the specification).  This does not initiate a SSL connection, it simply opens a TCP port and performs a trial handshake to check support.




setBufferSizes(int recv, int xmit)

Once you have verified (or know beforehand) that MFLN is supported you can use this call to set the size of memory buffers allocated by the connection object.  This must be called before connect() or it will be ignored.

In certain applications where the TLS server does not support MFLN (not many do as of this writing as it is relatively new to OpenSSL), but you control both the ESP8266 and the server to which it is communicating, you may still be able to setBufferSizes() smaller if you guarantee no chunk of data will overflow those buffers.




bool getMFLNStatus()

After a successful connection, this method returns whether or not MFLN negotiation succeeded or not.  If it did not succeed, and you reduced the receive buffer with setBufferSizes then you may experience reception errors if the server attempts to send messages larger than your receive buffer.






Sessions (Resuming connections fast)


setSession(BearSSL::Session &sess)

If you are connecting to a server repeatedly in a fixed time period (usually 30 or 60 minutes, but normally configurable at the server), a TLS session can be used to cache crypto settings and speed up connections significantly.






Errors

BearSSL can fail in many more unique and interesting ways.  Use these calls to get more information when something fails.


getLastSSLError(char *dest = NULL, size_t len = 0)

Returns the last BearSSL error code encountered and optionally set a user-allocated buffer to a human-readable form of the error.  To only get the last error integer code, just call without any parameters (int errCode = getLastSSLError();).






Limiting Ciphers (New connections faster)

There is very rarely reason to use these calls, but they are available.


setCiphers()

Takes an array (in PROGMEM is valid) or a std::vector of 16-bit BearSSL cipher identifiers and restricts BearSSL to only use them.  If the server requires a different cipher, then connection will fail.  Generally this is not useful except in cases where you want to connect to servers using a specific cipher.  See the BearSSL headers for more information on the supported ciphers.




setCiphersLessSecure()

Helper function which essentially limits BearSSL to less secure ciphers than it would natively choose, but they may be helpful and faster if your server depended on specific crypto options.






Limiting TLS(SSL) Versions

By default, BearSSL will connect with TLS 1.0, TLS 1.1, or TLS 1.2 protocols (depending on the request of the remote side).  If you want to limit to a subset, use the following call:


setSSLVersion(uint32_t min, uint32_t max)

Valid values for min and max are BR_TLS10, BR_TLS11, BR_TLS12.  Min and max may be set to the same value if only a single TLS version is desired.









            

          

      

      

    

  

    
      
          
            
  
BearSSL Secure Server Class

Implements a TLS encrypted server with optional client certificate validation.  See Server Class for general information and BearSSL Secure Client Class for basic server and BearSSL concepts.


setBufferSizes(int recv, int xmit)

Similar to the BearSSL::WiFiClientSecure method, sets the receive and transmit buffer sizes.  Note that servers cannot request a buffer size from the client, so if these are shrunk and the client tries to send a chunk larger than the receive buffer, it will always fail.  Needs to be called before begin()




Setting Server Certificates

TLS servers require a certificate identifying itself and containing its public key, and a private key they will use to encrypt information with.  The application author is responsible for generating this certificate and key, either using a self-signed generator or using a commercial certification authority.  Do not re-use the certificates included in the examples provided.

This example command will generate a RSA 2048-bit key and certificate:

openssl req -x509 -nodes -newkey rsa:2048 -keyout key.pem -out cert.pem -days 4096





Again, it is up to the application author to generate this certificate and key and keep the private key safe and private.


setRSACert(const BearSSL::X509List *chain, const BearSSL::PrivateKey *sk)

Sets a RSA certificate and key to be used by the server when connections are received.  Needs to be called before begin()




setECCert(const BearSSL::X509List *chain, unsigned cert_issuer_key_type, const BearSSL::PrivateKey *sk)

Sets an elliptic curve certificate and key for the server.  Needs to be called before begin().






Client sessions (Resuming connections fast)

The TLS handshake process takes a long time because of all the back and forth between the client and the server.  You can shorten it by caching the clients’ sessions which will skip a few steps in the TLS handshake.  In order for this to work, your client also needs to cache the session. BearSSL::WiFiClientSecure can do that as well as modern web browsers.

Here are the kind of performance improvements that you’ll be able to see for TLS handshakes with an ESP8266 with it’s clock set at 160MHz on a network with fairly low latency:


	With an EC key of 256 bits, a request taking ~360ms without caching takes ~60ms with caching.


	With an RSA key of 2048 bits, a request taking ~1850ms without caching takes ~70ms with caching.





setCache(BearSSL::ServerSessions *cache)

Sets the cache for the server’s sessions.  When choosing the size of the cache, remember that each client session takes 100 bytes.  If you setup a cache for 10 sessions, it will take 1000 bytes.  Needs to be called before begin()

When creating the cache, you can use any of the 2 available constructors:


	BearSSL::ServerSessions(ServerSession *sessions, uint32_t size): Creates a cache with the given buffer and number of sessions.


	BearSSL::ServerSessions(uint32_t size): Dynamically allocates a cache for the given number of sessions.









Requiring Client Certificates

TLS servers can request the client to identify itself by transmitting a certificate during handshake.  If the client cannot transmit the certificate, the connection will be dropped by the server.


setClientTrustAnchor(const BearSSL::X509List *client_CA_ta)

Sets the trust anchor (normally a self-signing CA) that all received certificates will be verified against.  Needs to be called before begin().









            

          

      

      

    

  

    
      
          
            
  
Client Class

Methods documented for Client [https://www.arduino.cc/en/Reference/WiFiClientConstructor] in Arduino [https://github.com/arduino/Arduino]


	WiFiClient() [https://www.arduino.cc/en/Reference/WiFiClient]


	connected() [https://www.arduino.cc/en/Reference/WiFiClientConnected]


	connect() [https://www.arduino.cc/en/Reference/WiFiClientConnect]


	write() [https://www.arduino.cc/en/Reference/WiFiClientWrite]


	print() [https://www.arduino.cc/en/Reference/WiFiClientPrint]


	println() [https://www.arduino.cc/en/Reference/WiFiClientPrintln]


	available() [https://www.arduino.cc/en/Reference/WiFiClientAvailable]


	read() [https://www.arduino.cc/en/Reference/WiFiClientRead]


	flush() [https://www.arduino.cc/en/Reference/WiFiClientFlush]


	stop() [https://www.arduino.cc/en/Reference/WiFIClientStop]




Methods and properties described further down are specific to ESP8266. They are not covered in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] documentation. Before they are fully documented please refer to information below.


flush and stop

flush(timeoutMs) and stop(timeoutMs) both have now an optional argument: timeout in millisecond, and both return a boolean.

Default input value 0 means that effective value is left at the discretion of the implementer.

flush() returning true indicates that output data have effectively been sent, and false that a timeout has occurred.

stop() returns false in case of an issue when closing the client (for instance a timed-out flush). Depending on implementation, its parameter can be passed to flush().




abort

void abort();





Originally proposed in #8738 [https://github.com/esp8266/Arduino/pull/8738]
Unlike stop(), immediately shuts down internal connection object.

Under usual circumstances, we either enter CLOSE_WAIT or TIME_WAIT state. But, the connection object is not freed right away, and requires us to either
* wait until malloc() returns NULL when our TCP stack tries to allocate memory for a new connection
* manually call tcp_kill_timewait() to forcibly stop the ‘oldest’ connection

This API frees up resources used by the connection. Consider using it instead of stop() if your application handles a lot of clients and frequently runs out of available heap memory.

Example:

# define MIN_HEAP_FREE 20000 // or whatever min available heap memory convienent for your application
auto client = server.accept();
// ... do something with the client object ...
if (ESP.getFreeHeap() >= MIN_HEAP_FREE) {
  client.stop();
} else {
  client.abort();
}








setNoDelay

setNoDelay(nodelay)





With nodelay set to true, this function will to disable Nagle algorithm [https://en.wikipedia.org/wiki/Nagle%27s_algorithm].

This algorithm is intended to reduce TCP/IP traffic of small packets sent over the network by combining a number of small outgoing messages, and sending them all at once. The downside of such approach is effectively delaying individual messages until a big enough packet is assembled.

Example:

client.setNoDelay(true);








getNoDelay

Returns whether NoDelay is enabled or not for the current connection.




setSync

This is an experimental API that will set the client in synchronized mode.
In this mode, every write() is flushed.  It means that after a call to
write(), data are ensured to be received where they went sent to (that is
flush semantic).

When set to true in WiFiClient implementation,


	It slows down transfers, and implicitly disable the Nagle algorithm.


	It also allows to avoid a temporary copy of data that otherwise consumes
at most TCP_SND_BUF = (2 * MSS) bytes per connection,







getSync

Returns whether Sync is enabled or not for the current connection.




setDefaultNoDelay and setDefaultSync

These set the default value for both setSync and setNoDelay for
every future instance of WiFiClient (including those coming from
WiFiServer.available() by default).

Default values are false for both NoDelay and Sync.

This means that Nagle is enabled by default for all new connections.




getDefaultNoDelay and getDefaultSync

Return the values to be used as default for NoDelay and Sync for all future connections.




Other Function Calls

uint8_t  status ()
virtual size_t  write (const uint8_t *buf, size_t size)
size_t  write_P (PGM_P buf, size_t size)
size_t  write (Stream &stream)
size_t  write (Stream &stream, size_t unitSize) __attribute__((deprecated))
virtual int  read (uint8_t *buf, size_t size)
virtual int  peek ()
virtual size_t  peekBytes (uint8_t *buffer, size_t length)
size_t  peekBytes (char *buffer, size_t length)
virtual  operator bool ()
IPAddress  remoteIP ()
uint16_t  remotePort ()
IPAddress  localIP ()
uint16_t  localPort ()





Documentation for the above functions is not yet available.







            

          

      

      

    

  

    
      
          
            
  
Generic Class

Methods and properties described in this section are specific to ESP8266. They are not covered in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] documentation. Before they are fully documented please refer to information below.


onEvent

void  onEvent (WiFiEventCb cb, WiFiEvent_t event=WIFI_EVENT_ANY) __attribute__((deprecated))








WiFiEventHandler

WiFiEventHandler  onStationModeConnected (std::function< void(const WiFiEventStationModeConnected &)>)
WiFiEventHandler  onStationModeDisconnected (std::function< void(const WiFiEventStationModeDisconnected &)>)
WiFiEventHandler  onStationModeAuthModeChanged (std::function< void(const WiFiEventStationModeAuthModeChanged &)>)
WiFiEventHandler  onStationModeGotIP (std::function< void(const WiFiEventStationModeGotIP &)>)
WiFiEventHandler  onStationModeDHCPTimeout (std::function< void(void)>)
WiFiEventHandler  onSoftAPModeStationConnected (std::function< void(const WiFiEventSoftAPModeStationConnected &)>)
WiFiEventHandler  onSoftAPModeStationDisconnected (std::function< void(const WiFiEventSoftAPModeStationDisconnected &)>)





It should be noted that when an WiFi interface goes down, all WiFiClients are stopped, and all WiFiServers stop serving. When the interface comes up, it is up to the user to reconnect the relevant WiFiClients and bring the WiFiServers back up.
For the WiFi station interface, it is suggested to set a callback for onStationModeDisconnected() that shuts down the user app’s WiFiClients and WiFiServers (resource cleanup), and another callback for onStationModeGotIP() that brings them back up.
For the SoftAP interface, when the interface is brought up, any servers should be brought up as well.

A detailed explanation of WiFiEventHandler can be found in the section with examples :arrow_right: dedicated specifically to the Generic Class..

Alternatively, check the example sketch WiFiEvents.ino [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/examples/WiFiEvents/WiFiEvents.ino] available in the examples folder of the ESP8266WiFi library.




persistent

WiFi.persistent(persistent)





Starting from version 3 of this core, persistence is disabled by default
and WiFi does not start automatically at boot (see PR #7902 [https://github.com/esp8266/Arduino/pull/7902]).

Previously, SDK was automatically starting WiFi at boot.  This was probably
intended for the Espressif AT FW which is interactive and preserves WiFi
state across reboots.  This behavior is generally irrelevant with the
Arduino API because sketches start with WiFi.begin() or
WiFi.softAP().

This change is harmless with standard sketches: Calls to WiFi.mode() do
enable radio as usual.  It also smooths current spikes at boot and decreases
DHCP stress.

Known side-effects:


	WiFi.mode() must be called before changing mac addresses with wifi_set_macaddr({SOFTAP,STATION}_IF, ...).




Legacy behavior can be restored by calling enableWiFiAtBootTime() from
anywhere in the code (it is a weak void function intended to play with the
linker).

#include <ESP8266WiFi.h>

void setup () {
#ifdef WIFI_IS_OFF_AT_BOOT
    enableWiFiAtBootTime(); // can be called from anywhere with the same effect
#endif
    ....
}





When legacy behavior is restored thanks to this call,
ESP8266 is able to reconnect to the last used WiFi network or establishes the same Access Point upon power up or reset.
By default, these settings are written to specific sectors of flash memory every time they are changed in WiFi.begin(ssid, passphrase) or WiFi.softAP(ssid, passphrase, channel), and when WiFi.disconnect or WiFi.softAPdisconnect is invoked.
Frequently calling these functions could cause wear on the flash memory (see issue #1054 [https://github.com/esp8266/Arduino/issues/1054]).

Once WiFi.persistent(false) is called, WiFi.begin, WiFi.disconnect, WiFi.softAP, or WiFi.softAPdisconnect only changes the current in-memory WiFi settings, and does not affect the WiFi settings stored in flash memory.




mode

bool mode(WiFiMode_t m)





Switches to one of the regular WiFi modes, where m is one of:


	WIFI_OFF: turn WiFi off.


	WIFI_STA: switch to Station (STA) mode.


	WIFI_AP: switch to Access Point (AP) mode.


	WIFI_AP_STA: enable both Station (STA) and Access Point (AP) mode.







getMode

WiFiMode_t getMode()





Gets the current WiFi mode (one out of four regular modes above).




WiFi power management, DTIM

bool setSleepMode (WiFiSleepType_t type, int listenInterval=0)





Sleep mode type is WIFI_NONE_SLEEP, WIFI_LIGHT_SLEEP or WIFI_MODEM_SLEEP.

(listenInterval appeared in esp8266-arduino core v2.5.0 using the last
V2 revision of nonos-sdk before V3)

Quoting nonos-sdk datasheet:


	NONE: disable power saving


	LIGHT or MODEM: TCP timer rate raised from 250ms to 3s




When listenInterval is set to 1..10, in LIGHT or MODEM mode,
station wakes up every (DTIM-interval * listenInterval).  This saves
power but station interface may miss broadcast data.

Otherwise (default value 0), station wakes up at every DTIM-interval
(configured in the access-point).

Quoting wikipedia:

A Delivery Traffic Indication Map (DTIM) is a kind of Traffic Indication Map
(TIM) which informs the clients about the presence of buffered
multicast/broadcast data on the access point.  It is generated within the
periodic beacon at a frequency specified by the DTIM Interval.  Beacons are
packets sent by an access point to synchronize a wireless network.




setOutputPower

void WiFi.setOutputPower(float dBm)





Sets the max transmit power, in dBm. Values range from 0 to 20.5 [dBm] inclusive, and should be multiples of 0.25.
This is essentially a thin wrapper around the SDK’s system_phy_set_max_tpw() api call.

If wifi connection issues are encountered due to signal noise, one thing to try is to reduce the Tx power.
This has been found effective in cases where STA mode is in use with 802.11n phy (default). Reducing to
e.g.: 17.5dBm or slightly lower can reduce noise and improve connectivity, although max range will also be reduced.




setPhyMode

bool  setPhyMode (WiFiPhyMode_t mode)





Sets the WiFi radio phy mode. Argument is an enum of type WiFiPhyMode_t, valid values are:
-  WIFI_PHY_MODE_11B: 802.11b mode
-  WIFI_PHY_MODE_11G: 802.11g mode
-  WIFI_PHY_MODE_11N: 802.11n mode

Per the NONOS SDK API Reference document, the AP mode only supports b/g, see notes in section on wifi_set_phy_mode() api.
Returns true success, false otherwise.

Some experiments have shown that 802.11b mode has longest LOS range, while 802.11n mode has longest indoor range.

It has been observed that some wifi routers may degrade from 802.11n to g/b if an ESP8266 in g/b phy mode connects to them. That
means that the entire wifi connectivity of all devices are impacted.




getPhyMode

WiFiPhyMode_t  getPhyMode (WiFiPhyMode_t mode)





Gets the WiFi radio phy mode that is currently set.




forceSleepBegin

bool  forceSleepBegin (uint32 sleepUs=0)





Saves the currently set WiFi mode and starts forced modem sleep for the specified time (us)




forceSleepWake

bool  forceSleepWake ()





Called after forceSleepBegin(). Restores the previous WiFi mode and attempts reconnection when STA was active.




shutdown and resumeFromShutdown

bool  shutdown (WiFiState& state)
bool  shutdown (WiFiState& state, uint32 sleepUs)
bool  resumeFromShutdown (WiFiState& state)
bool  shutdownValidCRC (const WiFiState& state)





Stores the STA interface IP configuration in the specified state struct and calls forceSleepBegin(sleepUs).
Restores STA interface configuration from the state and calls forceSleepWake().

These methods are intended to be used in low-power scenarios, e.g. where ESP.deepSleep is used between actions to preserve battery power. It is the user’s responsibility to preserve the WiFiState between shutdown() and resumeFromShutdown() by storing it in the RTC user data and/or flash memory.

See WiFiShutdown.ino [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/examples/WiFiShutdown/WiFiShutdown.ino] for an example of usage.




Other Function Calls

int32_t  channel (void)
WiFiSleepType_t  getSleepMode ()
bool  enableSTA (bool enable)
bool  enableAP (bool enable)
int  hostByName (const char *aHostname, IPAddress &aResult)





Also, when using NONOS SDK v3:

uint8_t getListenInterval ();
bool isSleepLevelMax ();





Documentation for the above functions is not yet prepared.

For code samples please refer to separate section with examples dedicated specifically to the Generic Class.







            

          

      

      

    

  

    
      
          
            
  
Generic

In the first example of the ESP8266WiFi library documentation we have discussed how to check when module connects to the Wi-Fi network. We were waiting until connection is established. If network is not available, the module could wait like that for ever doing nothing else. Another example on the Wi-Fi asynchronous scan mode demonstrated how to wait for scan result and do in parallel something else - blink a LED not disturbing the blink pattern. Let’s apply similar functionality when connecting the module to an access point.
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Introduction

In example below we will show another cool example of getting ESP perform couple of tasks at the same time and with very little programming.




What are the Tasks?

We would like to write a code that will inform us that connection to Wi-Fi network has been established or lost. At the same time we want to perform some time critical task. We will simulate it with a blinking LED. Generic class provides specific, event driven methods, that will be executed asynchronously, depending on e.g. connection status, while we are already doing other tasks.




Event Driven Methods

The list of all such methods is provided in Generic Class documentation.

We would like to use two of them: * onStationModeGotIP called when station is assigned IP address. This assignment may be done by DHCP client or by executing WiFi.config(...). * onStationModeDisconnected called when station is disconnected from Wi-Fi network. The reason of disconnection does not matter. Event will be triggered both if disconnection is done from the code by executing WiFi.disconnect(), because the Wi-Fi signal is weak, or because the access point is switched off.




Register the Events

To get events to work we need to complete just two steps:


	Declare the event handler:




cpp   WiFiEventHandler disconnectedEventHandler;


	Select particular event (in this case onStationModeDisconnected)
and add the code to be executed when event is fired.




cpp   disconnectedEventHandler = WiFi.onStationModeDisconnected([](const WiFiEventStationModeDisconnected& event)   {     Serial.println("Station disconnected");   }); If this event is fired the code will print out information that station has been disconnected.

That’s it. It is all we need to do.




The Code

The complete code, including both methods discussed at the beginning, is provided below.

#include <ESP8266WiFi.h>

const char* ssid = "********";
const char* password = "********";

WiFiEventHandler gotIpEventHandler, disconnectedEventHandler;

bool ledState;


void setup()
{
  Serial.begin(115200);
  Serial.println();

  pinMode(LED_BUILTIN, OUTPUT);

  gotIpEventHandler = WiFi.onStationModeGotIP([](const WiFiEventStationModeGotIP& event)
  {
    Serial.print("Station connected, IP: ");
    Serial.println(WiFi.localIP());
  });

  disconnectedEventHandler = WiFi.onStationModeDisconnected([](const WiFiEventStationModeDisconnected& event)
  {
    Serial.println("Station disconnected");
  });

  Serial.printf("Connecting to %s ...\n", ssid);
  WiFi.begin(ssid, password);
}


void loop()
{
  digitalWrite(LED_BUILTIN, ledState);
  ledState = !ledState;
  delay(250);
}








Check the Code

After uploading above sketch and opening a serial monitor we should see a similar log:

Connecting to sensor-net ...
Station connected, IP: 192.168.1.10





If you switch off the access point, and put it back on, you will see the following:

Station disconnected
Station disconnected
Station disconnected
Station connected, IP: 192.168.1.10





The process of connection, disconnection and printing messages is done in background of the loop() that is responsible for blinking the LED. Therefore the blink pattern all the time remains undisturbed.




Conclusion

Check out events from generic class. They will help you to write more compact code. Use them to practice splitting your code into separate tasks that are executed asynchronously.

For review of functions included in generic class, please refer to the Generic Class documentation.







            

          

      

      

    

  

    
      
          
            
  
Scan Class

This class is represented in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] by scanNetworks() [https://www.arduino.cc/en/Reference/WiFiScanNetworks] function. Developers of esp8266 / Arduino core extend this functionality by additional methods and properties.

Documentation of this class is divided into two parts. First covers functions to scan for available networks. Second describes what information is collected during scanning process and how to access it.




Scan for Networks

Scanning for networks takes hundreds of milliseconds to complete. This may be done in a single run when we are triggering scan process, waiting for completion, and providing result - all by a single function. Another option is to split this into steps, each done by a separate function. This way we can execute other tasks while scanning is in progress. This is called asynchronous scanning. Both methods of scanning are documented below.


scanNetworks

Scan for available Wi-Fi networks in one run and return the number of networks that has been discovered.

WiFi.scanNetworks()





There is on overload [https://en.wikipedia.org/wiki/Function_overloading] of this function that accepts two optional parameters to provide extended functionality of asynchronous scanning as well as looking for hidden networks.

WiFi.scanNetworks(async, show_hidden)





Both function parameters are of boolean type. They provide the flowing functionality: * asysnc - if set to true then scanning will start in background and function will exit without waiting for result. To check for result use separate function scanComplete that is described below. * show_hidden - set it to true to include in scan result networks with hidden SSID.




scanComplete

Check for result of asynchronous scanning.

WiFi.scanComplete()





On scan completion function returns the number of discovered networks.

If scan is not done, then returned value is < 0 as follows: * Scanning still in progress: -1 * Scanning has not been triggered: -2




scanDelete

Delete the last scan result from memory.

WiFi.scanDelete()








scanNetworksAsync

Start scanning for available Wi-Fi networks. On completion execute another function.

WiFi.scanNetworksAsync(onComplete, show_hidden)






Function parameters: * onComplete - the event handler executed
when the scan is done

* show_hidden - optional boolean parameter, set it to
true to scan for hidden networks



Example code:

#include "ESP8266WiFi.h"

void prinScanResult(int networksFound)
{
  Serial.printf("%d network(s) found\n", networksFound);
  for (int i = 0; i < networksFound; i++)
  {
    Serial.printf("%d: %s, Ch:%d (%ddBm) %s\n", i + 1, WiFi.SSID(i).c_str(), WiFi.channel(i), WiFi.RSSI(i), WiFi.encryptionType(i) == ENC_TYPE_NONE ? "open" : "");
  }
}


void setup()
{
  Serial.begin(115200);
  Serial.println();

  WiFi.mode(WIFI_STA);
  WiFi.disconnect();
  delay(100);

  WiFi.scanNetworksAsync(prinScanResult);
}


void loop() {}





Example output:

5 network(s) found
1: Tech_D005107, Ch:6 (-72dBm)
2: HP-Print-A2-Photosmart 7520, Ch:6 (-79dBm)
3: ESP_0B09E3, Ch:9 (-89dBm) open
4: Hack-4-fun-net, Ch:9 (-91dBm)
5: UPC Wi-Free, Ch:11 (-79dBm)










Show Results

Functions below provide access to result of scanning. It does not matter if scanning has been done in synchronous or asynchronous mode, scan results are available using the same API.

Individual results are accessible by providing a `networkItem’ that identifies the index (zero based) of discovered network.


SSID

Return the SSID of a network discovered during the scan.

WiFi.SSID(networkItem)





Returned SSID is of the String type. The networkItem is a zero based index of network discovered during scan.




encryptionType

Return the encryption type of a network discovered during the scan.

WiFi.encryptionType(networkItem)





Function returns a number that encodes encryption type as follows: * 5
: ENC_TYPE_WEP - WEP * 2 : ENC_TYPE_TKIP - WPA / PSK * 4 :
ENC_TYPE_CCMP - WPA2 / PSK * 7 : ENC_TYPE_NONE - open network
* 8 : ENC_TYPE_AUTO - WPA / WPA2 / PSK

The networkItem is a zero based index of network discovered during scan.




RSSI

Return the RSSI [https://en.wikipedia.org/wiki/Received_signal_strength_indication] (Received Signal Strength Indication) of a network discovered during the scan.

WiFi.RSSI(networkItem)





Returned RSSI is of the int32_t type. The networkItem is a zero based index of network discovered during scan.




BSSID

Return the BSSID [https://en.wikipedia.org/wiki/Service_set_(802.11_network)#Basic_service_set_identification_.28BSSID.29] (Basic Service Set Identification) that is another name of MAC address of a network discovered during the scan.

WiFi.BSSID(networkItem)





Function returns a pointer to the memory location (an uint8_t array with the size of 6 elements) where the BSSID is saved.

If you do not like to pointers, then there is another version of this function that returns a String.

WiFi.BSSIDstr(networkItem)





The networkItem is a zero based index of network discovered during scan.




channel

Return the channel of a network discovered during the scan.

WiFi.channel(networkItem)





Returned channel is of the int32_t type. The networkItem is a zero based index of network discovered during scan.




isHidden

Return information if a network discovered during the scan is hidden or not.

WiFi.isHidden(networkItem)





Returned value if the boolean type, and true means that network is hidden. The networkItem is a zero based index of network discovered during scan.




getNetworkInfo

Return all the network information discussed in this chapter above in a single function call.

WiFi.getNetworkInfo(networkItem, &ssid, &encryptionType, &RSSI, *&BSSID, &channel, &isHidden)





The networkItem is a zero based index of network discovered during scan. All other input parameters are passed to function by reference. Therefore they will be updated with actual values retrieved for particular networkItem. The function itself returns boolean true or false to confirm if information retrieval was successful or not.

Example code:

int n = WiFi.scanNetworks(false, true);

String ssid;
uint8_t encryptionType;
int32_t RSSI;
uint8_t* BSSID;
int32_t channel;
bool isHidden;

for (int i = 0; i < n; i++)
{
  WiFi.getNetworkInfo(i, ssid, encryptionType, RSSI, BSSID, channel, isHidden);
  Serial.printf("%d: %s, Ch:%d (%ddBm) %s %s\n", i + 1, ssid.c_str(), channel, RSSI, encryptionType == ENC_TYPE_NONE ? "open" : "", isHidden ? "hidden" : "");
}





Example output:

6 network(s) found
1: Tech_D005107, Ch:6 (-72dBm)
2: HP-Print-A2-Photosmart 7520, Ch:6 (-79dBm)
3: ESP_0B09E3, Ch:9 (-89dBm) open
4: Hack-4-fun-net, Ch:9 (-91dBm)
5: , Ch:11 (-77dBm)  hidden
6: UPC Wi-Free, Ch:11 (-79dBm)





For code samples please refer to separate section with examples dedicated specifically to the Scan Class.




getScanInfoByIndex

Similar to the getNetworkInfo, but instead returns a pointer to the Nth bss_info structure which is internally used by the NONOS SDK.

WiFi.getScanInfoByIndex(networkItem)





The networkItem is a zero based index of network discovered during scan. Function will return nullptr when networkItem is greater than the number of networks in the scan result or when there are no scan results available.

auto n = WiFi.scanNetworks(false, true);
if (n <= 0) {
    // scan failed or there are no results
    return;
}

for (int i = 0; i < n; i++)
    const auto* info = WiFi.getScanInfoByIndex(i)
    // ... use the raw data from the bss_info structure ...
}





See tools/sdk/include/user_interface.h for all available fields and examples.







            

          

      

      

    

  

    
      
          
            
  
IDE example


	For the currently installed Core, see Arduino IDE > Examples > ESP8266WiFi > WiFiScan.


	For the latest development version, see WiFiScan.ino [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/examples/WiFiScan/WiFiScan.ino].





Scan

To connect a mobile phone to a hot spot, you typically open Wi-Fi settings app, list available networks and then pick the hot spot you need. You can also list the networks with ESP8266 and here is how.




Simple Scan

This example shows the bare minimum code we need to check for the list of available networks.






Disconnect

To start with, enable module in station mode and then disconnect.

WiFi.mode(WIFI_STA);
WiFi.disconnect();





Running WiFi.disconnect() is to shut down a connection to an access point that module may have automatically made using previously saved credentials.




Scan for Networks

After some delay to let the module disconnect, go to scanning for available networks:

int n = WiFi.scanNetworks();





Now just check if returned n if greater than 0 and list found networks:

for (int i = 0; i < n; i++)
{
  Serial.println(WiFi.SSID(i));
}





This is that simple.




Complete Example

The sketch should have obligatory #include <ESP8266WiFi.h> and looks as follows:

#include "ESP8266WiFi.h"

void setup()
{
  Serial.begin(115200);
  Serial.println();

  WiFi.mode(WIFI_STA);
  WiFi.disconnect();
  delay(100);
}

void loop()
{
  Serial.print("Scan start ... ");
  int n = WiFi.scanNetworks();
  Serial.print(n);
  Serial.println(" network(s) found");
  for (int i = 0; i < n; i++)
  {
    Serial.println(WiFi.SSID(i));
  }
  Serial.println();

  delay(5000);
}








Example in Action

Upload this sketch to ESP module and open a serial monitor. If there are access points around (sure there are) you will see a similar list repeatedly printed out:

Scan start ... 5 network(s) found
Tech_D005107
HP-Print-A2-Photosmart 7520
ESP_0B09E3
Hack-4-fun-net
UPC Wi-Free





When looking for the text scan start ... displayed, you will notice that it takes noticeable time for the following text n network(s) found to show up. This is because execution of WiFi.scanNetworks() takes time and our program is waiting for it to complete before moving to the next line of code. What if at the same time we would like ESP to run time critical process (e.g. animation)
that should not be disturbed?

It turns out that this is fairly easy to do by scanning networks in async mode.

Check it out in next example below that will also demonstrate printing out other parameters of available networks besides SSID.


Async Scan

What we like to do, is to trigger process of scanning for networks and then return to executing code inside the loop(). Once scanning is complete, at a convenient time, we will check the list of networks. The “time critical process” will be simulated by a blinking LED at 250ms period.

We would like the blinking pattern not be disturbed at any time.






No delay()

To implement such functionality we should refrain from using any delay() inside the loop(). Instead we will define period when to trigger particular action. Then inside loop() we will check millis() (internal clock that counts milliseconds) and fire the action if the period expires.

Please check how this is done in BlinkWithoutDelay.ino example sketch. Identical technique can be used to periodically trigger scanning for Wi-Fi networks.




Setup

First we should define scanning period and internal variable lastScanMillis that will hold time when the last scan has been made.

#define SCAN_PERIOD 5000
long lastScanMillis;








When to Start

Then inside the loop() we will check if SCAN_PERIOD expired, so it is time to fire next scan:

if (currentMillis - lastScanMillis > SCAN_PERIOD)
{
  WiFi.scanNetworks(true);
  Serial.print("\nScan start ... ");
  lastScanMillis = currentMillis;
}





Please note that WiFi.scanNetworks(true) has an extra parameter true that was not present in previous example above. This is an instruction to scan in asynchronous mode, i.e. trigger scanning process, do not wait for result (processing will be done in background) and move to the next line of code. We need to use asynchronous mode otherwise 250ms LED blinking pattern would be disturbed as scanning takes longer than 250ms.




Check When Done

Finally we should periodically check for scan completion to print out the result once ready. To do so, we will use function WiFi.scanComplete(), that upon completion returns the number of found networks. If scanning is still in progress it returns -1. If scanning has not been triggered yet, it would return -2.

int n = WiFi.scanComplete();
if(n >= 0)
{
  Serial.printf("%d network(s) found\n", n);
  for (int i = 0; i < n; i++)
  {
    Serial.printf("%d: %s, Ch:%d (%ddBm) %s\n", i+1, WiFi.SSID(i).c_str(), WiFi.channel(i), WiFi.RSSI(i), WiFi.encryptionType(i) == ENC_TYPE_NONE ? "open" : "");
  }
  WiFi.scanDelete();
}





Please note function WiFi.scanDelete() that is deleting scanning result from memory, so it is not printed out over and over again on each loop() run.




Complete Example

Complete sketch is below. The code inside setup() is the same as described in previous example except for an additional pinMode() to configure the output pin for LED.

#include "ESP8266WiFi.h"

#define BLINK_PERIOD 250
long lastBlinkMillis;
boolean ledState;

#define SCAN_PERIOD 5000
long lastScanMillis;


void setup()
 {
  Serial.begin(115200);
  Serial.println();

  pinMode(LED_BUILTIN, OUTPUT);

  WiFi.mode(WIFI_STA);
  WiFi.disconnect();
  delay(100);
}

void loop()
{
  long currentMillis = millis();

  // blink LED
  if (currentMillis - lastBlinkMillis > BLINK_PERIOD)
  {
    digitalWrite(LED_BUILTIN, ledState);
    ledState = !ledState;
    lastBlinkMillis = currentMillis;
  }

  // trigger Wi-Fi network scan
  if (currentMillis - lastScanMillis > SCAN_PERIOD)
  {
    WiFi.scanNetworks(true);
    Serial.print("\nScan start ... ");
    lastScanMillis = currentMillis;
  }

  // print out Wi-Fi network scan result upon completion
  int n = WiFi.scanComplete();
  if(n >= 0)
  {
    Serial.printf("%d network(s) found\n", n);
    for (int i = 0; i < n; i++)
    {
      Serial.printf("%d: %s, Ch:%d (%ddBm) %s\n", i+1, WiFi.SSID(i).c_str(), WiFi.channel(i), WiFi.RSSI(i), WiFi.encryptionType(i) == ENC_TYPE_NONE ? "open" : "");
    }
    WiFi.scanDelete();
  }
}








Example in Action

Upload above sketch to ESP module and open a serial monitor. You should see similar list printed out every 5 seconds:

Scan start ... 5 network(s) found
1: Tech_D005107, Ch:6 (-72dBm)
2: HP-Print-A2-Photosmart 7520, Ch:6 (-79dBm)
3: ESP_0B09E3, Ch:9 (-89dBm) open
4: Hack-4-fun-net, Ch:9 (-91dBm)
5: UPC Wi-Free, Ch:11 (-79dBm)





Check the LED. It should be blinking undisturbed four times per second.


Conclusion

The scan class API provides comprehensive set of methods to do scanning in both synchronous as well as in asynchronous mode. Therefore we can easy implement code that is doing scanning in background without disturbing other processes running on ESP8266 module.

For the list of functions provided to manage scan mode please refer to the Scan Class documentation.







            

          

      

      

    

  

    
      
          
            
  
Server Class

Methods documented for the Server Class [https://www.arduino.cc/en/Reference/WiFiServerConstructor] in Arduino [https://github.com/arduino/Arduino]


	WiFiServer() [https://www.arduino.cc/en/Reference/WiFiServer]


	begin() [https://www.arduino.cc/en/Reference/WiFiServerBegin]


	available() [https://www.arduino.cc/en/Reference/WiFiServerAvailable]


	write() [https://www.arduino.cc/en/Reference/WiFiServerWrite]


	print() [https://www.arduino.cc/en/Reference/WiFiServerPrint]


	println() [https://www.arduino.cc/en/Reference/WiFiServerPrintln]




In ESP8266WiFi library the ArduinoWiFiServer class implements available and the write-to-all-clients functionality as described in the Arduino WiFi library reference. The PageServer example shows how available and the write-to-all-clients works.

For most use cases the basic WiFiServer class of the ESP8266WiFi library is suitable.

Methods and properties described further down are specific to ESP8266. They are not covered in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] documentation. Before they are fully documented please refer to information below.


accept

Method accept() returns a waiting client connection. accept() is documented [https://www.arduino.cc/en/Reference/EthernetServerAccept] for the Arduino Ethernet library.




available


Deprecated since version 3.1.0: see accept



available in the ESP8266WiFi library’s WiFiServer class doesn’t work as documented for the Arduino WiFi library. It works the same way as accept.




write (write to all clients) not supported

Please note that the write method on the WiFiServer object is not implemented and returns failure always.  Use the returned
WiFiClient object from the WiFiServer::accept() method to communicate with individual clients.  If you need to send
the exact same packets to a series of clients, your application must maintain a list of connected clients and iterate over them manually.




setNoDelay

setNoDelay(nodelay)





With nodelay set to true, this function will to disable Nagle algorithm [https://en.wikipedia.org/wiki/Nagle%27s_algorithm].

This algorithm is intended to reduce TCP/IP traffic of small packets sent over the network by combining a number of small outgoing messages, and sending them all at once. The downside of such approach is effectively delaying individual messages until a big enough packet is assembled.

Example:

server.begin();
server.setNoDelay(true);





By default, nodelay value will depends on global WiFiClient::getDefaultNoDelay() (currently false by default).

However, a call to wiFiServer.setNoDelay() will override NoDelay for all new WiFiClient provided by the calling instance (wiFiServer).




Other Function Calls

bool  hasClient ()
size_t  hasClientData ()
bool  hasMaxPendingClients ()
bool  getNoDelay ()
virtual size_t  write (const uint8_t *buf, size_t size)
uint8_t  status ()
void  close ()
void  stop ()





Documentation for the above functions is not yet prepared.

For code samples please refer to separate section with examples dedicated specifically to the Server Class.







            

          

      

      

    

  

    
      
          
            
  
Server

Setting up web a server on ESP8266 requires very little code and is surprisingly straightforward. This is thanks to functionality provided by the versatile ESP8266WiFi library.

The purpose of this example will be to prepare a web page that can be opened in a web browser. This page should show the current raw reading of ESP’s analog input pin.




Table of Contents


	The Object


	The Page


	Header First


	The Page is Served


	Get it Together


	Get it Run


	What Else?


	Conclusion





The Object

We will start off by creating a server object.

WiFiServer server(80);





The server responds to clients (in this case - web browsers) on port 80, which is a standard port web browsers talk to web servers.




The Page

Then let’s write a short function prepareHtmlPage(), that will return a String class variable containing the contents of the web page. We will then pass this variable to server to pass it over to a client.

String prepareHtmlPage()
{
  String htmlPage;
  htmlPage.reserve(1024);               // prevent ram fragmentation
  htmlPage = F("HTTP/1.1 200 OK\r\n"
               "Content-Type: text/html\r\n"
               "Connection: close\r\n"  // the connection will be closed after completion of the response
               "Refresh: 5\r\n"         // refresh the page automatically every 5 sec
               "\r\n"
               "<!DOCTYPE HTML>"
               "<html>"
               "Analog input:  ");
  htmlPage += analogRead(A0);
  htmlPage += F("</html>"
                "\r\n");
  return htmlPage;
}





The function does nothing fancy but just puts together a text header and HTML [https://www.w3schools.com/html/] contents of the page.




Header First

The header is to inform client what type of contents is to follow and how it will be served:

Content-Type: text/html
Connection: close
Refresh: 5





In our example the content type is text/html, the connection will be closed after serving and the content should be requested by the client again every 5 seconds. The header is concluded with an empty line \r\n. This is to distinguish header from the content to follow.

<!DOCTYPE HTML>
<html>
Analog input:  [Value]
</html>





The content contains two basic HTML [https://www.w3schools.com/html/] tags, one to denote HTML document type <!DOCTYPE HTML> and another to mark beginning <html> and end </html> of the document. Inside there is a raw value read from ESP’s analog input analogRead(A0) converted to the String type.

analogRead(A0)








The Page is Served

Serving of this web page will be done in the loop() where server is waiting for a new client to connect and send some data containing a request:

void loop()
{
  WiFiClient client = server.accept();
  if (client)
  {
    // we have a new client sending some request
  }
}





Once a new client is connected, server will read the client’s request and print it out on a serial monitor.

while (client.connected())
{
  if (client.available())
  {
    String line = client.readStringUntil('\r');
    Serial.print(line);
  }
}





Request from the client is marked with an empty new line. If we find this mark, we can send back the web page and exit while() loop using break.

if (line.length() == 1 && line[0] == '\n')
{
    client.println(prepareHtmlPage());
    break;
}





The whole process is concluded by stopping the connection with client:

client.stop();





But before that, we must not interrupt client’s request:

while (client.available()) {
  // but first, let client finish its request
  // that's diplomatic compliance to protocols
  // (and otherwise some clients may complain, like curl)
  // (that is an example, prefer using a proper webserver library)
  client.read();
}








Put it Together

Complete sketch is presented below.

#include <ESP8266WiFi.h>

const char* ssid = "********";
const char* password = "********";

WiFiServer server(80);


void setup()
{
  Serial.begin(115200);
  Serial.println();

  Serial.printf("Connecting to %s ", ssid);
  WiFi.begin(ssid, password);
  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
  Serial.println(" connected");

  server.begin();
  Serial.printf("Web server started, open %s in a web browser\n", WiFi.localIP().toString().c_str());
}


// prepare a web page to be send to a client (web browser)
String prepareHtmlPage()
{
  String htmlPage;
  htmlPage.reserve(1024);               // prevent ram fragmentation
  htmlPage = F("HTTP/1.1 200 OK\r\n"
               "Content-Type: text/html\r\n"
               "Connection: close\r\n"  // the connection will be closed after completion of the response
               "Refresh: 5\r\n"         // refresh the page automatically every 5 sec
               "\r\n"
               "<!DOCTYPE HTML>"
               "<html>"
               "Analog input:  ");
  htmlPage += analogRead(A0);
  htmlPage += F("</html>"
                "\r\n");
  return htmlPage;
}


void loop()
{
  WiFiClient client = server.accept();
  // wait for a client (web browser) to connect
  if (client)
  {
    Serial.println("\n[Client connected]");
    while (client.connected())
    {
      // read line by line what the client (web browser) is requesting
      if (client.available())
      {
        String line = client.readStringUntil('\r');
        Serial.print(line);
        // wait for end of client's request, that is marked with an empty line
        if (line.length() == 1 && line[0] == '\n')
        {
          client.println(prepareHtmlPage());
          break;
        }
      }
    }

    while (client.available()) {
      // but first, let client finish its request
      // that's diplomatic compliance to protocols
      // (and otherwise some clients may complain, like curl)
      // (that is an example, prefer using a proper webserver library)
      client.read();
    }

    // close the connection:
    client.stop();
    Serial.println("[Client disconnected]");
  }
}








Get it Run

Update ssid and password in sketch to match credentials of your access point. Load sketch to ESP module and open a serial monitor. First you should see confirmation that module connected to the access point and the web server started.

Connecting to sensor-net ........ connected
Web server started, open 192.168.1.104 in a web browser





Enter provided IP address in a web browser. You should see the page served by ESP8266:


[image: Output from server in a web browser]


The page would be refreshed every 5 seconds. Each time this happens, you should see a request from the client (your web browser) printed out on the serial monitor:

[Client connected]
GET / HTTP/1.1
Accept: text/html, application/xhtml+xml, */*
Accept-Language: en-US
User-Agent: Mozilla/5.0 (Windows NT 6.1; WOW64; Trident/7.0; rv:11.0) like Gecko
Accept-Encoding: gzip, deflate
Host: 192.168.1.104
DNT: 1
Connection: Keep-Alive
[client disconnected]








Conclusion

The above example shows that a web server on ESP8266 can be set up in almost no time. Such server can easily stand up requests from much more powerful hardware and software like a PC with a web browser. Check out other classes like ESP8266WebServer [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WebServer] that let you program more advanced applications.

If you like to try another server example, check out WiFiManualWebServer.ino [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/examples/WiFiManualWebServer/WiFiManualWebServer.ino], that provides functionality of toggling the GPIO pin on and off out of a web browser.

For the list of functions provided to implement and manage servers, please refer to the Server Class documentation.







            

          

      

      

    

  

    
      
          
            
  
Soft Access Point Class

Section below is ESP8266 specific as Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] documentation does not cover soft access point. The API description is broken down into three short chapters. They cover how to setup soft-AP, manage connection, and obtain information on soft-AP interface configuration.
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Set up Network

This section describes functions to set up and configure ESP8266 in the soft access point (soft-AP) mode.


softAP

Set up a soft access point to establish a Wi-Fi network.

The simplest version (an overload in C++
terms [https://en.wikipedia.org/wiki/Function_overloading]) of this function requires only one parameter and is used to set up an open Wi-Fi network.

WiFi.softAP(ssid)





To set up pre-shared key protected network, or to configure additional network parameters, use the following overload:

WiFi.softAP(ssid, psk, channel, hidden, max_connection)





The first parameter of this function is required, remaining four are optional.

Meaning of all parameters is as follows:


	ssid - character string containing network SSID (max. 32 characters)


	psk - optional character string with a pre-shared key. For WPA2-PSK network it should be minimum 8 characters long and not longer than 64 characters. If not specified, the access point will be open for anybody to connect.


	channel - optional parameter to set Wi-Fi channel, from 1 to 13. Default channel = 1.


	hidden - optional parameter, if set to true will hide SSID.


	max_connection - optional parameter to set max simultaneous connected stations, from 0 to 8 [https://bbs.espressif.com/viewtopic.php?f=46&t=481&p=1832&hilit=max_connection#p1832]. Defaults to 4. Once the max number has been reached, any other station that wants to connect will be forced to wait until an already connected station disconnects.




Function will return true or false depending on result of setting the soft-AP.

Notes:


	The network established by softAP will have default IP address of 192.168.4.1. This address may be changed using softAPConfig (see below).


	Even though ESP8266 can operate in soft-AP + station mode, it actually has only one hardware channel. Therefore in soft-AP + station mode, the soft-AP channel will default to the number used by station. For more information how this may affect operation of stations connected to ESP8266’s soft-AP, please check this FAQ entry [https://bbs.espressif.com/viewtopic.php?f=10&t=324] on Espressif forum.







softAPConfig

Configure the soft access point’s network interface.

softAPConfig (local_ip, gateway, subnet)





All parameters are the type of IPAddress and defined as follows:


	local_ip - IP address of the soft access point


	gateway - gateway IP address


	subnet - subnet mask




Function will return true or false depending on result of changing the configuration.

Example code:

#include <ESP8266WiFi.h>

IPAddress local_IP(192,168,4,22);
IPAddress gateway(192,168,4,9);
IPAddress subnet(255,255,255,0);

void setup()
{
  Serial.begin(115200);
  Serial.println();

  Serial.print("Setting soft-AP configuration ... ");
  Serial.println(WiFi.softAPConfig(local_IP, gateway, subnet) ? "Ready" : "Failed!");

  Serial.print("Setting soft-AP ... ");
  Serial.println(WiFi.softAP("ESPsoftAP_01") ? "Ready" : "Failed!");

  Serial.print("Soft-AP IP address = ");
  Serial.println(WiFi.softAPIP());
}

void loop() {}





Example output:

Setting soft-AP configuration ... Ready
Setting soft-AP ... Ready
Soft-AP IP address = 192.168.4.22










Manage Network

Once soft-AP is established you may check the number of stations connected, or shut it down, using the following functions.


softAPgetStationNum

Get the count of the stations that are connected to the soft-AP interface.

WiFi.softAPgetStationNum()





Example code:

Serial.printf("Stations connected to soft-AP = %d\n", WiFi.softAPgetStationNum());





Example output:

Stations connected to soft-AP = 2





Note: the maximum number of stations that may be connected to ESP8266 soft-AP is 4 by default. This can be changed from 0 to 8 via the max_connection argument of the softAP method.




softAPdisconnect

Disconnect stations from the network established by the soft-AP.

WiFi.softAPdisconnect(wifioff)





Function will set currently configured SSID and pre-shared key of the soft-AP to null values. The parameter wifioff is optional. If set to true it will switch the soft-AP mode off.

Function will return true if operation was successful or false if otherwise.






Network Configuration

Functions below provide IP and MAC address of ESP8266’s soft-AP.


softAPIP

Return IP address of the soft access point’s network interface.

WiFi.softAPIP()





Returned value is of IPAddress type.

Example code:

Serial.print("Soft-AP IP address = ");
Serial.println(WiFi.softAPIP());





Example output:

Soft-AP IP address = 192.168.4.1








softAPmacAddress

Return MAC address of soft access point. This function comes in two versions, which differ in type of returned values. First returns a pointer, the second a String.


Pointer to MAC

WiFi.softAPmacAddress(mac)





Function accepts one parameter mac that is a pointer to memory location (an uint8_t array the size of 6 elements) to save the mac address. The same pointer value is returned by the function itself.

Example code:

uint8_t macAddr[6];
WiFi.softAPmacAddress(macAddr);
Serial.printf("MAC address = %02x:%02x:%02x:%02x:%02x:%02x\n", macAddr[0], macAddr[1], macAddr[2], macAddr[3], macAddr[4], macAddr[5]);





Example output:

MAC address = 5e:cf:7f:8b:10:13








MAC as a String

Optionally you can use function without any parameters that returns a String type value.

WiFi.softAPmacAddress()





Example code:

Serial.printf("MAC address = %s\n", WiFi.softAPmacAddress().c_str());





Example output:

MAC address = 5E:CF:7F:8B:10:13





For code samples please refer to separate section with examples dedicated specifically to the Soft Access Point Class.











            

          

      

      

    

  

    
      
          
            
  
Soft Access Point

Example below presents how to configure ESP8266 to run in soft access point mode so Wi-Fi stations can connect to it. The Wi-Fi network established by the soft-AP will be identified with the SSID set during configuration. The network may be protected with a password. The network may be also open, if no password is set during configuration.
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The Sketch

Setting up soft-AP with ESP8266 can be done with just couple lines of code.

#include <ESP8266WiFi.h>

void setup()
{
  Serial.begin(115200);
  Serial.println();

  Serial.print("Setting soft-AP ... ");
  boolean result = WiFi.softAP("ESPsoftAP_01", "pass-to-soft-AP");
  if(result == true)
  {
    Serial.println("Ready");
  }
  else
  {
    Serial.println("Failed!");
  }
}

void loop()
{
  Serial.printf("Stations connected = %d\n", WiFi.softAPgetStationNum());
  delay(3000);
}








How to Use It?

In line boolean result = WiFi.softAP("ESPsoftAP_01", "pass-to-soft-AP") change pass-to-soft-AP to some meaningful password and upload sketch. Open serial monitor and you should see:

Setting soft-AP ... Ready
Stations connected = 0
Stations connected = 0
...





Then take your mobile phone or a PC, open the list of available access points, find ESPsoftAP_01 and connect to it. This should be reflected on serial monitor as a new station connected:

Stations connected = 1
Stations connected = 1
...





If you have another Wi-Fi station available then connect it as well. Check serial monitor again where you should now see two stations reported.




How Does it Work?

Sketch is small so analysis shouldn’t be difficult. In first line we are including ESP8266WiFi library:

#include <ESP8266WiFi.h>





Setting up of the access point ESPsoftAP_01 is done by executing:

cpp  boolean result = WiFi.softAP("ESPsoftAP_01", "pass-to-soft-AP");

If this operation is successful then result will be true or false if otherwise. Basing on that either Ready or Failed! will be printed out by the following if - else conditional statement.




Can we Make it Simpler?

Can we make this sketch even simpler? Yes, we can! We can do it by using alternate if - else statement as below:

WiFi.softAP("ESPsoftAP_01", "pass-to-soft-AP") ? "Ready" : "Failed!"





Such statement will return either Ready or Failed! depending on result of WiFi.softAP(...). This way we can considerably shorten our sketch without any changes to functionality:

#include <ESP8266WiFi.h>

void setup()
{
  Serial.begin(115200);
  Serial.println();

  Serial.print("Setting soft-AP ... ");
  Serial.println(WiFi.softAP("ESPsoftAP_01", "pass-to-soft-AP") ? "Ready" : "Failed!");
}

void loop()
{
  Serial.printf("Stations connected = %d\n", WiFi.softAPgetStationNum());
  delay(3000);
}





I believe this is very neat piece of code. If ? : conditional operator is new to you, I recommend to start using it and make your code shorter and more elegant.




Conclusion

ESP8266WiFi [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WiFi] library makes it easy to turn ESP8266 into soft access point.

Once you try above sketch check out WiFiAccessPoint.ino [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/examples/WiFiAccessPoint/WiFiAccessPoint.ino] as a next step. It demonstrates how to access ESP operating in soft-AP mode from a web browser.

For the list of functions to manage ESP module in soft-AP mode please refer to the Soft Access Point Class documentation.







            

          

      

      

    

  

    
      
          
            
  
Station Class

The number of features provided by ESP8266 in the station mode is far more extensive than covered in original Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi]. Therefore, instead of supplementing original documentation, we have decided to write a new one from scratch.

Description of station class has been broken down into four parts. First discusses methods to establish connection to an access point. Second provides methods to manage connection like e.g. reconnect or isConnected. Third covers properties to obtain information about connection like MAC or IP address. Finally the fourth section provides alternate methods to connect like e.g. Wi-Fi Protected Setup (WPS).
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Points below provide description and code snippets how to use particular methods.

For more code samples please refer to separate section with examples dedicated specifically to the Station Class.


Start Here

Switching the module to Station mode is done with begin function. Typical parameters passed to begin include SSID and password, so module can connect to specific Access Point.

WiFi.begin(ssid, password)





By default, ESP will attempt to reconnect to Wi-Fi network whenever it is disconnected. There is no need to handle this by separate code. A good way to simulate disconnection would be to reset the access point. ESP will report disconnection, and then try to reconnect automatically.


begin

There are several versions (called function overloads [https://en.wikipedia.org/wiki/Function_overloading] in C++) of begin function. One was presented just above:
WiFi.begin(ssid, password). Overloads provide flexibility in number or type of accepted parameters.

The simplest overload of begin is as follows:

WiFi.begin()





Calling it will enable station mode and connect to the last used access point based on configuration saved in flash memory.

Notes:


	It is possible that calling begin will result in the module being in STA + softAP mode if the module was previously placed into AP mode.


	If you notice strange behavior with DNS or other network functionality, check which mode your module is in (see WiFi.mode() in the Generic Class Documentation).




Below is the syntax of another overload of begin with the all possible parameters:

WiFi.begin(ssid, password, channel, bssid, connect)





Meaning of parameters is as follows:


	ssid - a character string containing the SSID of Access Point we would like to connect to, may have up to 32 characters


	password to the access point, a character string that should be minimum 8 characters long and not longer than 64 characters


	channel of AP, if we like to operate using specific channel, otherwise this parameter may be omitted


	bssid - mac address of AP, this parameter is also optional


	connect - a boolean parameter that if set to false, will instruct module just to save the other parameters without actually establishing connection to the access point







config

Disable DHCP [https://en.wikipedia.org/wiki/Dynamic_Host_Configuration_Protocol] client (Dynamic Host Configuration Protocol) and set the IP configuration of station interface to user defined arbitrary values. The interface will be a static IP configuration instead of values provided by DHCP.

WiFi.config(local_ip, gateway, subnet, dns1, dns2)





Function will return true if configuration change is applied successfully. If configuration can not be applied, because e.g. module is not in station or station + soft access point mode, then false will be returned.

The following IP configuration may be provided:


	local_ip - enter here IP address you would like to assign the ESP
station’s interface


	gateway - should contain IP address of gateway (a router) to
access external networks


	subnet - this is a mask that defines the range of IP addresses of
the local network


	dns1, dns2 - optional parameters that define IP addresses of
Domain Name Servers (DNS) that maintain a directory of domain names
(like e.g. www.google.co.uk) and translate them for us to IP
addresses




Example code:

#include <ESP8266WiFi.h>

const char* ssid = "********";
const char* password = "********";

IPAddress staticIP(192,168,1,22);
IPAddress gateway(192,168,1,9);
IPAddress subnet(255,255,255,0);

void setup(void)
{
  Serial.begin(115200);
  Serial.println();

  Serial.printf("Connecting to %s\n", ssid);
  WiFi.config(staticIP, gateway, subnet);
  WiFi.begin(ssid, password);
  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
  Serial.println();
  Serial.print("Connected, IP address: ");
  Serial.println(WiFi.localIP());
}

void loop() {}





Example output:

Connecting to sensor-net
.
Connected, IP address: 192.168.1.22





Please note that station with static IP configuration usually connects to the network faster. In the above example it took about 500ms (one dot . displayed). This is because obtaining of IP configuration by DHCP client takes time and in this case this step is skipped. If you pass all three parameter as 0.0.0.0 (local_ip, gateway and subnet), it will re enable DHCP. You need to re-connect the device to get new IPs.






Manage Connection


reconnect

Reconnect the station. This is done by disconnecting from the access point an then initiating connection back to the same AP.

WiFi.reconnect()





Notes: 1. Station should be already connected to an access point. If this is not the case, then function will return false not performing any action. 2. If true is returned it means that connection sequence has been successfully started. User should still check for connection status, waiting until WL_CONNECTED is reported:

WiFi.reconnect();
while (WiFi.status() != WL_CONNECTED)
{
  delay(500);
  Serial.print(".");
}








disconnect

Sets currently configured SSID and password to null values and disconnects the station from an access point.

WiFi.disconnect(wifioff)





The wifioff is an optional boolean parameter. If set to true, then the station mode will be turned off.




isConnected

Returns true if Station is connected to an access point or false if not.

WiFi.isConnected()








setAutoConnect

Configure module to automatically connect on power on to the last used access point.

WiFi.setAutoConnect(autoConnect)





The autoConnect is an optional parameter. If set to false then auto connection functionality up will be disabled. If omitted or set to true, then auto connection will be enabled.




getAutoConnect

This is “companion” function to setAutoConnect(). It returns true if module is configured to automatically connect to last used access point on power on.

WiFi.getAutoConnect()





If auto connection functionality is disabled, then function returns false.




setAutoReconnect

Set whether module will attempt to reconnect to an access point in case it is disconnected.

WiFi.setAutoReconnect(autoReconnect)





If parameter autoReconnect is set to true, then module will try to reestablish lost connection to the AP. If set to false then module will stay disconnected.

Note: running setAutoReconnect(true) when module is already disconnected will not make it reconnect to the access point. Instead reconnect() should be used.




waitForConnectResult

Wait until module connects to the access point. This function is intended for module configured in station or station + soft access point mode.

WiFi.waitForConnectResult()





Function returns one of the following connection statuses:


	WL_CONNECTED after successful connection is established


	WL_NO_SSID_AVAIL in case configured SSID cannot be reached


	WL_CONNECT_FAILED if connection failed


	WL_CONNECT_WRONG_PASSWORD if password is incorrect


	WL_IDLE_STATUS when Wi-Fi is in process of changing between statuses


	WL_DISCONNECTED if module is not configured in station mode


	-1 on timeout









Configuration


macAddress

Get the MAC address of the ESP station’s interface.

WiFi.macAddress(mac)





Function should be provided with mac that is a pointer to memory location (an uint8_t array the size of 6 elements) to save the mac address. The same pointer value is returned by the function itself.

Example code:

if (WiFi.status() == WL_CONNECTED)
{
  uint8_t macAddr[6];
  WiFi.macAddress(macAddr);
  Serial.printf("Connected, mac address: %02x:%02x:%02x:%02x:%02x:%02x\n", macAddr[0], macAddr[1], macAddr[2], macAddr[3], macAddr[4], macAddr[5]);
}





Example output:

Mac address: 5C:CF:7F:08:11:17





If you do not feel comfortable with pointers, then there is optional version of this function available. Instead of the pointer, it returns a formatted String that contains the same mac address.

WiFi.macAddress()





Example code:

if (WiFi.status() == WL_CONNECTED)
{
  Serial.printf("Connected, mac address: %s\n", WiFi.macAddress().c_str());
}








localIP

Function used to obtain IP address of ESP station’s interface.

WiFi.localIP()





The type of returned value is IPAddress [https://github.com/esp8266/Arduino/blob/master/cores/esp8266/IPAddress.h]. There is a couple of methods available to display this type of data. They are presented in examples below that cover description of subnetMask, gatewayIP and dnsIP that return the IPAdress as well.

Example code:

if (WiFi.status() == WL_CONNECTED)
{
  Serial.print("Connected, IP address: ");
  Serial.println(WiFi.localIP());
}





Example output:

Connected, IP address: 192.168.1.10








subnetMask

Get the subnet mask of the station’s interface.

WiFi.subnetMask()





Module should be connected to the access point to obtain the subnet mask.

Example code:

Serial.print("Subnet mask: ");
Serial.println(WiFi.subnetMask());





Example output:

Subnet mask: 255.255.255.0








gatewayIP

Get the IP address of the gateway.

WiFi.gatewayIP()





Example code:

Serial.printf("Gataway IP: %s\n", WiFi.gatewayIP().toString().c_str());





Example output:

Gataway IP: 192.168.1.9








dnsIP

Get the IP addresses of Domain Name Servers (DNS).

WiFi.dnsIP(dns_no)





With the input parameter dns_no we can specify which Domain Name Server’s IP we need. This parameter is zero based and allowed values are none, 0 or 1. If no parameter is provided, then IP of DNS #1 is returned.

Example code:

Serial.print("DNS #1, #2 IP: ");
WiFi.dnsIP().printTo(Serial);
Serial.print(", ");
WiFi.dnsIP(1).printTo(Serial);
Serial.println();





Example output:

DNS #1, #2 IP: 62.179.1.60, 62.179.1.61








hostname

Get the DHCP hostname assigned to ESP station.

WiFi.hostname()





Function returns String type. Default hostname is in format ESP_24xMAC where 24xMAC are the last 24 bits of module’s MAC address.

The hostname may be changed using the following function:

WiFi.hostname(aHostname)





Input parameter aHostname may be a type of char*, const char* or String. Maximum length of assigned hostname is 32 characters. Function returns either true or false depending on result. For instance, if the limit of 32 characters is exceeded, function will return false without assigning the new hostname.

Example code:

Serial.printf("Default hostname: %s\n", WiFi.hostname().c_str());
WiFi.hostname("Station_Tester_02");
Serial.printf("New hostname: %s\n", WiFi.hostname().c_str());





Example output:

Default hostname: ESP_081117
New hostname: Station_Tester_02








status

Return the status of Wi-Fi connection.

WiFi.status()





Function returns one of the following connection statuses:


	WL_CONNECTED after successful connection is established


	WL_NO_SSID_AVAIL in case configured SSID cannot be reached


	WL_CONNECT_FAILED if password is incorrect


	WL_IDLE_STATUS when Wi-Fi is in process of changing between statuses


	WL_DISCONNECTED if module is not configured in station mode




Returned value is type of wl_status_t defined in wl_definitions.h [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/src/include/wl_definitions.h]

Example code:

#include <ESP8266WiFi.h>

void setup(void)
{
  Serial.begin(115200);
  Serial.printf("Connection status: %d\n", WiFi.status());
  Serial.printf("Connecting to %s\n", ssid);
  WiFi.begin(ssid, password);
  Serial.printf("Connection status: %d\n", WiFi.status());
  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
  Serial.printf("\nConnection status: %d\n", WiFi.status());
  Serial.print("Connected, IP address: ");
  Serial.println(WiFi.localIP());
}

void loop() {}





Example output:

Connection status: 6
Connecting to sensor-net
Connection status: 6
......
Connection status: 3
Connected, IP address: 192.168.1.10





Particular connection statuses 6 and 3 may be looked up in wl_definitions.h [https://github.com/esp8266/Arduino/blob/master/libraries/ESP8266WiFi/src/include/wl_definitions.h] as follows:

3 - WL_CONNECTED
6 - WL_DISCONNECTED





Basing on this example, when running above code, module is initially disconnected from the network and returns connection status 6 - WL_DISCONNECTED. It is also disconnected immediately after running WiFi.begin(ssid, password). Then after about 3 seconds (basing on number of dots displayed every 500ms), it finally gets connected returning status 3 - WL_CONNECTED.




SSID

Return the name of Wi-Fi network, formally called Service Set Identification (SSID) [https://www.juniper.net/techpubs/en_US/network-director1.1/topics/concept/wireless-ssid-bssid-essid.html#jd0e34].

WiFi.SSID()





Returned value is of the String type.

Example code:

Serial.printf("SSID: %s\n", WiFi.SSID().c_str());





Example output:

SSID: sensor-net








psk

Return current pre shared key (password) associated with the Wi-Fi network.

WiFi.psk()





Function returns value of the String type.




BSSID

Return the mac address of the access point to which the ESP module was directed to connect to. This address is formally called Basic Service Set Identification (BSSID) [https://www.juniper.net/techpubs/en_US/network-director1.1/topics/concept/wireless-ssid-bssid-essid.html#jd0e47]. The returned pointer is what the user configured when calling begin() with a bssid argument. It does _not_ necessarily reflect the mac address of the access point to which the ESP module’s station interface is currently connected to.

WiFi.BSSID()





The BSSID() function returns a pointer to the memory location (an uint8_t array with the size of 6 elements) where the BSSID is saved.

Below is similar function, but returning BSSID but as a String type.

WiFi.BSSIDstr()





Example code:

Serial.printf("BSSID: %s\n", WiFi.BSSIDstr().c_str());





Example output:

BSSID: 00:1A:70:DE:C1:68








RSSI

Return the signal strength of Wi-Fi network, that is formally called Received Signal Strength Indication (RSSI) [https://en.wikipedia.org/wiki/Received_signal_strength_indication].

WiFi.RSSI()





Signal strength value is provided in dBm. The type of returned value is int32_t.

Example code:

Serial.printf("RSSI: %d dBm\n", WiFi.RSSI());





Example output:

RSSI: -68 dBm










Connect Different

ESP8266 SDK [https://bbs.espressif.com/viewtopic.php?f=51&t=1023] provides alternate methods to connect ESP station to an access point. Out of them esp8266 / Arduino [https://github.com/esp8266/Arduino] core implements WPS and Smart Config as described in more details below.


WPS

The following beginWPSConfig function allows connecting to a network using Wi-Fi Protected Setup (WPS) [https://en.wikipedia.org/wiki/Wi-Fi_Protected_Setup]. Currently only push-button configuration [https://www.wi-fi.org/knowledge-center/faq/how-does-wi-fi-protected-setup-work] (WPS_TYPE_PBC mode) is supported (SDK 1.5.4).

WiFi.beginWPSConfig()





Depending on connection result function returns either true or false (boolean type).

Example code:

#include <ESP8266WiFi.h>

void setup(void)
{
  Serial.begin(115200);
  Serial.println();

  Serial.printf("Wi-Fi mode set to WIFI_STA %s\n", WiFi.mode(WIFI_STA) ? "" : "Failed!");
  Serial.print("Begin WPS (press WPS button on your router) ... ");
  Serial.println(WiFi.beginWPSConfig() ? "Success" : "Failed");

  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
  Serial.println();
  Serial.print("Connected, IP address: ");
  Serial.println(WiFi.localIP());
}

void loop() {}





Example output:

Wi-Fi mode set to WIFI_STA
Begin WPS (press WPS button on your router) ... Success
.........
Connected, IP address: 192.168.1.102








Smart Config

The Smart Config connection of an ESP module an access point is done by sniffing for special packets that contain SSID and password of desired AP. To do so the mobile device or computer should have functionality of broadcasting of encoded SSID and password.

The following three functions are provided to implement Smart Config.

Start smart configuration mode by sniffing for special packets that contain SSID and password of desired Access Point. Depending on result either true or false is returned.

beginSmartConfig()





Query Smart Config status, to decide when stop configuration. Function returns either true or false of boolean type.

smartConfigDone()





Stop smart config, free the buffer taken by beginSmartConfig(). Depending on result function return either true or false of boolean type.

stopSmartConfig()





For additional details regarding Smart Config please refer to ESP8266 API User Guide [https://bbs.espressif.com/viewtopic.php?f=51&t=1023].









            

          

      

      

    

  

    
      
          
            
  
Station

Example of connecting to an access point has been shown in chapter Quick Start. In case connection is lost, ESP8266 will automatically reconnect to the last used access point, once it is available again.

Can we provide a more robust connection to Wi-Fi than that?
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Introduction

Following the example in Quick Start, we would like to go one step further and make the ESP connect to the next available access point if the current connection is lost. This functionality is provided with the ‘ESP8266WiFiMulti’ class and demonstrated in the sketch below.

#include <ESP8266WiFi.h>
#include <ESP8266WiFiMulti.h>

ESP8266WiFiMulti wifiMulti;
boolean connectioWasAlive = true;

void setup()
{
  Serial.begin(115200);
  Serial.println();

  wifiMulti.addAP("primary-network-name", "pass-to-primary-network");
  wifiMulti.addAP("secondary-network-name", "pass-to-secondary-network");
  wifiMulti.addAP("tertiary-network-name", "pass-to-tertiary-network");
}

void monitorWiFi()
{
  if (wifiMulti.run() != WL_CONNECTED)
  {
    if (connectioWasAlive == true)
    {
      connectioWasAlive = false;
      Serial.print("Looking for WiFi ");
    }
    Serial.print(".");
    delay(500);
  }
  else if (connectioWasAlive == false)
  {
    connectioWasAlive = true;
    Serial.printf(" connected to %s\n", WiFi.SSID().c_str());
  }
}

void loop()
{
  monitorWiFi();
}








Prepare Access Points

To try this sketch in action you need two (or more) access points. In the lines below replace primary-network-name and pass-to-primary-network with the name and password to your primary network. Do the same for the secondary network.

wifiMulti.addAP("primary-network-name", "pass-to-primary-network");
wifiMulti.addAP("secondary-network-name", "pass-to-secondary-network");





You may add more networks if you have more access points.

wifiMulti.addAP("tertiary-network-name", "pass-to-tertiary-network");
...








Try it Out

Now upload the updated sketch to the ESP module and open a serial monitor. The module will first scan for available networks. Then it will select and connect to the network with a stronger signal. In case the connection is lost, the module will connect to the next one available.

This process may look something like:

Looking for WiFi ..... connected to sensor-net-1
Looking for WiFi ....... connected to sensor-net-2
Looking for WiFi .... connected to sensor-net-1





In the above example the ESP connects first to sensor-net-1. Then, after I have switched sensor-net-1 off. The ESP discovers that the connection is lost and starts searching for another configured network. That happened to be sensor-net-2 so the ESP connected to it. Then after I have switched sensor-net-1 back on and shut down sensor-net-2. The ESP reconnected automatically to sensor-net-1.

Function monitorWiFi() is in place to show when connection is lost by displaying Looking for WiFi. Dots .... are displayed during the process of searching for another configured access point. Then a message like connected to sensor-net-2 is shown when a connection is established.




Can we Make it Simpler?

Please note that you may simplify this sketch by removing the function monitorWiFi() and putting inside loop() only wifiMulti.run(). ESP will still reconnect between configured access points if required. Now you won’t be able to see it on serial monitor unless you add Serial.setDebugOutput(true) as described in point Enable Wi-Fi Diagnostic.

Updated sketch for such scenario will look as follows:

#include <ESP8266WiFi.h>
#include <ESP8266WiFiMulti.h>

ESP8266WiFiMulti wifiMulti;

void setup()
{
  Serial.begin(115200);
  Serial.setDebugOutput(true);
  Serial.println();

  wifiMulti.addAP("primary-network-name", "pass-to-primary-network");
  wifiMulti.addAP("secondary-network-name", "pass-to-secondary-network");
  wifiMulti.addAP("tertiary-network-name", "pass-to-tertiary-network");
}

void loop()
{
  wifiMulti.run();
}





That’s it! This is really all the code you need to make ESP automatically reconnect between available networks.

After uploading the sketch and opening the serial monitor, the messages will look as below.

Initial connection to sensor-net-1 on power up:

f r0, scandone
f r0, scandone
state: 0 -> 2 (b0)
state: 2 -> 3 (0)
state: 3 -> 5 (10)

add 0
aid 1
cnt
chg_B1:-40

connected with sensor-net-1, channel 1
dhcp client start...
ip:192.168.1.10,mask:255.255.255.0,gw:192.168.1.9





Lost connection to sensor-net-1 and establishing connection to sensor-net-2:

bcn_timout,ap_probe_send_start
ap_probe_send over, rest wifi status to disassoc
state: 5 -> 0 (1)
rm 0
f r-40, scandone
f r-40, scandone
f r-40, scandone
state: 0 -> 2 (b0)
state: 2 -> 3 (0)
state: 3 -> 5 (10)
add 0

aid 1
cnt

connected with sensor-net-2, channel 11
dhcp client start...
ip:192.168.1.102,mask:255.255.255.0,gw:192.168.1.234





Lost connection to sensor-net-2 and establishing connection back to sensor-net-1:

bcn_timout,ap_probe_send_start
ap_probe_send over, rest wifi status to disassoc
state: 5 -> 0 (1)
rm 0
f r-40, scandone
f r-40, scandone
f r-40, scandone
state: 0 -> 2 (b0)
state: 2 -> 3 (0)
state: 3 -> 5 (10)
add 0
aid 1
cnt

connected with sensor-net-1, channel 6
dhcp client start...
ip:192.168.1.10,mask:255.255.255.0,gw:192.168.1.9








Conclusion

I believe the minimalist sketch with ESP8266WiFiMulti class is a cool example of what the ESP8266 can do for us behind the scenes with just couple lines of code.

As shown in the above example, reconnecting between access points takes time and is not seamless. Therefore, in practical applications, you will likely need to monitor connection status to decide e.g. if you can send the data to an external system or should wait until the connection is back.

For a detailed review of functions provided to manage station mode please refer to the Station Class documentation.







            

          

      

      

    

  

    
      
          
            
  
UDP Class

Methods documented for WiFiUDP Class [https://www.arduino.cc/en/Reference/WiFiUDPConstructor] in Arduino [https://github.com/arduino/Arduino]


	begin() [https://www.arduino.cc/en/Reference/WiFiUDPBegin]


	available() [https://www.arduino.cc/en/Reference/WiFiUDPAvailable]


	beginPacket() [https://www.arduino.cc/en/Reference/WiFiUDPBeginPacket]


	endPacket() [https://www.arduino.cc/en/Reference/WiFiUDPEndPacket]


	write() [https://www.arduino.cc/en/Reference/WiFiUDPWrite]


	parsePacket() [https://www.arduino.cc/en/Reference/WiFiUDPParsePacket]


	peek() [https://www.arduino.cc/en/Reference/WiFiUDPPeek]


	read() [https://www.arduino.cc/en/Reference/WiFiUDPRead]


	flush() [https://www.arduino.cc/en/Reference/WiFiUDPFlush]


	stop() [https://www.arduino.cc/en/Reference/WiFIUDPStop]


	remoteIP() [https://www.arduino.cc/en/Reference/WiFiUDPRemoteIP]


	remotePort() [https://www.arduino.cc/en/Reference/WiFiUDPRemotePort]




Methods and properties described further down are specific to ESP8266.
They are not covered in Arduino WiFi library [https://www.arduino.cc/en/Reference/WiFi] documentation. Before they are fully documented please refer to information below.


Multicast UDP

uint8_t  beginMulticast (IPAddress multicast, uint16_t port)
virtual int  beginPacketMulticast (IPAddress multicastAddress, uint16_t port, IPAddress interfaceAddress, int ttl=1)
IPAddress  destinationIP ()
uint16_t  localPort ()





The WiFiUDP class supports sending and receiving multicast packets on STA interface. When sending a multicast packet, replace udp.beginPacket(addr, port) with udp.beginPacketMulticast(addr, port, WiFi.localIP()). When listening to multicast packets, replace udp.begin(port) with udp.beginMulticast(multicast_ip_addr, port). You can use udp.destinationIP() to tell whether the packet received was sent to the multicast or unicast address.

For code samples please refer to separate section with examples dedicated specifically to the UDP Class.







            

          

      

      

    

  

    
      
          
            
  
UDP

The purpose of example application below is to demonstrate UDP communication between ESP8266 and an external client. The application (performing the role of a server) is checking inside the loop() for an UDP packet to arrive. When a valid packet is received, an acknowledge packet is sent back to the client to the same port it has been sent out.
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Declarations

At the beginning of sketch we need to include two libraries:

#include <ESP8266WiFi.h>
#include <WiFiUdp.h>





The first library ESP8266WiFi.h is required by default if we are using ESP8266’s Wi-Fi. The second one WiFiUdp.h is needed specifically for programming of UDP routines.

Once we have libraries in place we need to create a WiFiUDP object. Then we should specify a port to listen to incoming packets. There are conventions on usage of port numbers, for information please refer to the List of TCP and UDP port numbers [https://en.wikipedia.org/wiki/List_of_TCP_and_UDP_port_numbers]. Finally we need to set up a buffer for incoming packets and define a reply message.

WiFiUDP Udp;
unsigned int localUdpPort = 4210;
char incomingPacket[256];
char replyPacket[] = "Hi there! Got the message :-)";








Wi-Fi Connection

At the beginning of setup() let’s implement typical code to connect to an access point. This has been discussed in Quick Start. Please refer to it if required.




UDP Setup

Once connection is established, you can start listening to incoming packets.

Udp.begin(localUdpPort);





That is all required preparation. We can move to the loop() that will be handling actual UDP communication.




An UDP Packet Arrived!

Waiting for incoming UDP packed is done by the following code:

int packetSize = Udp.parsePacket();
if (packetSize)
{
  Serial.printf("Received %d bytes from %s, port %d\n", packetSize, Udp.remoteIP().toString().c_str(), Udp.remotePort());
  int len = Udp.read(incomingPacket, 255);
  if (len > 0)
  {
    incomingPacket[len] = '\0';
  }
  Serial.printf("UDP packet contents: %s\n", incomingPacket);

  (...)
}





Once a packet is received, the code will printing out the IP address and port of the sender as well as the length of received packet. If the packet is not empty, its contents will be printed out as well.




An Acknowledge Send Out

For each received packet we are sending back an acknowledge packet:

Udp.beginPacket(Udp.remoteIP(), Udp.remotePort());
Udp.write(replyPacket);
Udp.endPacket();





Please note we are sending reply to the IP and port of the sender by using Udp.remoteIP() and Udp.remotePort().




Complete Sketch

The sketch performing all described functionality is presented below:

#include <ESP8266WiFi.h>
#include <WiFiUdp.h>

const char* ssid = "********";
const char* password = "********";

WiFiUDP Udp;
unsigned int localUdpPort = 4210;  // local port to listen on
char incomingPacket[255];  // buffer for incoming packets
char  replyPacket[] = "Hi there! Got the message :-)";  // a reply string to send back


void setup()
{
  Serial.begin(115200);
  Serial.println();

  Serial.printf("Connecting to %s ", ssid);
  WiFi.begin(ssid, password);
  while (WiFi.status() != WL_CONNECTED)
  {
    delay(500);
    Serial.print(".");
  }
  Serial.println(" connected");

  Udp.begin(localUdpPort);
  Serial.printf("Now listening at IP %s, UDP port %d\n", WiFi.localIP().toString().c_str(), localUdpPort);
}


void loop()
{
  int packetSize = Udp.parsePacket();
  if (packetSize)
  {
    // receive incoming UDP packets
    Serial.printf("Received %d bytes from %s, port %d\n", packetSize, Udp.remoteIP().toString().c_str(), Udp.remotePort());
    int len = Udp.read(incomingPacket, 255);
    if (len > 0)
    {
      incomingPacket[len] = 0;
    }
    Serial.printf("UDP packet contents: %s\n", incomingPacket);

    // send back a reply, to the IP address and port we got the packet from
    Udp.beginPacket(Udp.remoteIP(), Udp.remotePort());
    Udp.write(replyPacket);
    Udp.endPacket();
  }
}








How to Check It?

Upload sketch to module and open serial monitor. You should see confirmation that ESP has connected to Wi-Fi and started listening to UDP packets:

Connecting to twc-net-3 ........ connected
Now listening at IP 192.168.1.104, UDP port 4210





Now we need another application to send some packets to IP and port shown by ESP above.

Instead of programming another ESP, let’s make it easier and use a purpose build application. I have selected the Packet Sender [https://packetsender.com/download]. It is available for popular operating systems. Download, install and execute it.

Once Packet Sender’s window show up enter the following information: * Name of the packet * ASCII text of the message to be send inside the packet * IP Address shown by our ESP * Port shown by the ESP
* Select UDP

What I have entered is shown below:


[image: Testing UDP with packet sender]


Now click Send.

Immediately after that you should see the following on ESP’s serial monitor:

Received 12 bytes from 192.168.1.106, port 55056
UDP packet contents: Hello World!





The text 192.168.1.106, port 55056 identifies a PC where the packet is send from. You will likely see different values.

As ESP sends an acknowledge packet back, you should see it in the log in the bottom part of the Packet Sender’s window.




Conclusion

This simple example shows how to send and receive UDP packets between ESP and an external application. Once tested in this minimal set up, you should be able to program ESP to talk to any other UDP device. In case of issues to establish communication with a new device, use the Packet Sender [https://packetsender.com] or other similar program for troubleshooting

For review of functions provided to send and receive UDP packets, please refer to the UDP Class documentation.
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Introduction

This message indicates issue with uploading ESP module over a serial
connection. There are couple of possible causes, that depend on the type
of module, if you use separate USB to serial converter, what parameters
are selected for upload, etc. As result there is no single answer on the
root cause. To find it out you may need to complete couple of
troubleshooting steps.


Note: If you are just starting with ESP, to reduce potential issues
with uploading, select ESP board with integrated USB to serial
converter. This will considerably reduce number of user depended
factors or configuration settings that influence upload process.




Example boards with USB to serial converter build in, that will make
your initial project development easier, are shown below.


[image: Example boards with integrated USB to serial converter]
Example boards with integrated USB to serial converter



If you are using a Generic ESP8266 module, separate USB to serial
converter and connect them by yourself, please make sure you have the
following three things right: 1. Module is provided with enough power,
2. GPIO0, GPIO15 and CH_PD are connected using pull up / pull down
resistors, 3. Module is put into boot loader mode.

For specific details please refer to section on Generic ESP8266 module.
Example modules without USB to serial converter on board are shown below.


[image: Example ESP8266 modules without USB to serial converter]
Example ESP8266 modules without USB to serial converter






Initial Checks

In order to troubleshoot “espcomm_sync failed” error, please proceed
step by step through the checklist below. This list is organized
starting with most common and simple to more complex issues.


	Start with reading exact message displayed in debug window of Arduino
IDE. In many cases it provides direct information where the issue is.





[image: "espcomm\_open failed" error]
“espcomm_open failed” error



For instance message above suggests that Arduino IDE is unable to open a
serial port COM3. Check if you have selected port where your module is
connected to.


[image: Serial port selection]
Serial port selection




	If a module is connected to the serial port but not responding as a
valid ESP8266 device, the message will read slightly different (see
below). If you have other modules connected to your PC, make sure
that you are uploading code to ESP8266 and not to e.g. Arduino UNO.





[image: Serial port selection]
Serial port selection




	To have your PC talking to ESP, select exact ESP type in upload menu.
If selection is incorrect then the upload may fail.





[image: Board selection]
Board selection



Basing on selected board type, Arduino IDE will apply specific “reset
method” to enter the board into boot loading mode. Reset methods are
board specific. Some boards do not have the h/w in place to support
reset by Arduino IDE. If this is the case, you need to enter such board
into boot loading mode manually.


	Upload may be also failing due to too high speed. If you have long or
poor quality USB cable, try reducing selection under Upload Speed.





[image: Serial speed selection]
Serial speed selection






Advanced Checks


	If you are still facing issues, test if module is indeed entering the
boot loading mode. You can do it by connecting secondary USB to
serial converter and checking the message displayed. Attach RX and
GND pins of converter to TX and GND pin of ESP as shown on example
below (get fzz
source).





[image: Secondary USB to serial converter hookup]
Secondary USB to serial converter hookup



Then open a terminal at 74880 baud, and look what message is reported
when ESP is being reset for programming. Correct message looks as
follows:

ets Jan  8 2013,rst cause:2, boot mode:(1,7)

If you see similar message but different values then decode them using
Boot Messages and Modes. The
key information is contained in first digit / three right-most bits of
the boot mode message as shown below.


[image: Decoding of boot mode]
Decoding of boot mode



For instance message boot mode (3,3) indicates that pins GPIO2 and
GPIO0 are set HIGH and GPIO15 is set LOW. This is configuration for
normal
operation of
module (to execute application from flash), not for boot
loading
(flash programming).


Note: Without having this step right you will not be able to upload
your module over a serial port.





	You have confirmed that module is in boot loading mode but upload
still fails. If you are using external USB to serial converter, then
check if it operates correctly by looping it back. This is quite
simple check. Just connect TX and RX of your converter together like
on picture below. Then open Serial Monitor and type some characters.
If everything is fine, then you should see what you type immediately
printed back on the monitor. For an ESP with USB to serial converter
on board, this check may involve breaking some PCB traces. I would
not do it unless being desperate. Instead try steps below.





[image: USB to serial converter loop back]
USB to serial converter loop back




	Next step to try, if not done already, is checking detailed debug
messages. Go to File > Preferences, enable Show verbose output
during: upload and try uploading again. For successful upload this
log should look similar to example shown below:




C:\Users\Krzysztof\AppData\Local\Arduino15\packages\esp8266\tools\esptool\0.4.8/esptool.exe -vv -cd ck -cb 115200 -cp COM3 -ca 0x00000 -cf C:\Users\KRZYSZ~1\AppData\Local\Temp\build7e44b372385012e74d64fb272d24b802.tmp/Blink.ino.bin    esptool v0.4.8 - (c) 2014 Ch. Klippel <ck@atelier-klippel.de>       setting board to ck       setting baudrate from 115200 to 115200       setting port from COM1 to COM3       setting address from 0x00000000 to 0x00000000       espcomm_upload_file       espcomm_upload_mem       setting serial port timeouts to 1000 ms   opening bootloader   resetting board   trying to connect       flush start       setting serial port timeouts to 1 ms       setting serial port timeouts to 1000 ms       flush complete       espcomm_send_command: sending command header       espcomm_send_command: sending command payload       read 0, requested 1   trying to connect       flush start       setting serial port timeouts to 1 ms       setting serial port timeouts to 1000 ms       flush complete       espcomm_send_command: sending command header       espcomm_send_command: sending command payload       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data       espcomm_send_command: receiving 2 bytes of data   Uploading 226368 bytes from to flash at 0x00000000       erasing flash       size: 037440 address: 000000       first_sector_index: 0       total_sector_count: 56       head_sector_count: 16       adjusted_sector_count: 40       erase_size: 028000       espcomm_send_command: sending command header       espcomm_send_command: sending command payload       setting serial port timeouts to 15000 ms       setting serial port timeouts to 1000 ms       espcomm_send_command: receiving 2 bytes of data       writing flash   ..............................................................................................................................................................................................................................   starting app without reboot       espcomm_send_command: sending command header       espcomm_send_command: sending command payload       espcomm_send_command: receiving 2 bytes of data   closing bootloader       flush start       setting serial port timeouts to 1 ms       setting serial port timeouts to 1000 ms       flush complete

Upload log may be longer depending on number of connection attempts made
by esptool. Analyze it for any anomalies to configuration you have
selected in Arduino IDE, like different serial port, reset method, baud
rate, etc. Resolve all noted differences.




Reset Methods

If you got to this point and still see espcomm_sync failed, then now
you need to bring in the heavy guns.

Connect scope or logic analyzer to GPIO0, RST and RXD pins of the ESP to
check what’s happening.

Then compare your measurements with wave-forms collected for circuits
below. They document two standard methods of resetting ESP8266 for
upload, that you can select in Arduino IDE - ck and
nodemcu.


Ck

Circuit below has been prepared to collect wave-forms for ck reset
method (get fzz source). It is
simpler than for nodemcu reset and therefore often used
to wire up generic ESP modules on a breadboard. Check it against your
wiring when comparing your measurements against wave-forms below.


[image: Sample circuit to check ck method]
Sample circuit to check ck method



The following wave-forms below show voltage signals on GPIO0 and RST
pins of the ESP board when uploading the firmware.

Close up of ck reset method signal sequence at the beginning of upload
is shown below.


[image: Reset Method: ck, close up at the beginning of upload]
Reset Method: ck, close up at the beginning of upload



Next picture shows complete upload of
Blink.ino [https://github.com/esp8266/Arduino/blob/master/libraries/esp8266/examples/Blink/Blink.ino]
example at 921600 baud. This is quite high speed, so the upload takes
only about 8s.


[image: Reset Method: ck, complete upload]
Reset Method: ck, complete upload



Please note that when esptool is not able to initialize upload at the
first time, then it retries reset procedure. Case of one such retry is
shown on wave-form below.


[image: Reset Method: ck, complete upload]
Reset Method: ck, complete upload



Each retry is reported in upload log as follows:

resetting board
trying to connect
    flush start
    setting serial port timeouts to 1 ms
    setting serial port timeouts to 1000 ms
    flush complete
    espcomm_send_command: sending command header
    espcomm_send_command: sending command payload
    read 0, requested 1





Presented circuit has one important limitation when it comes to work
with Arduino IDE. After opening Serial Monitor (Ctrl-Shift-M), both RTS
and DTR lines are permanently pulled down. As RTS line is connected to
REST input of ESP, the module is hold in reset state / not able to run.
Therefore after uploading module, you need to disconnect both lines or
use different serial terminal program that is not pulling down RTS and
DTR lines. Otherwise the module will get stuck waiting for releasing the
REST signal and you will see nothing on the Serial Monitor.

As for different serial terminal program you can check Arduino IDE
add-on Serial Monitor for
ESP8266 [https://github.com/esp8266/Arduino/issues/1360] developed
by user [@mytrain](https://github.com/mytrain) and discussed in
#1360 [https://github.com/esp8266/Arduino/issues/1360].

If you prefer external terminal program, then for Windows users we can
recommend free and handy
Termite [https://www.compuphase.com/software_termite.htm].




Nodemcu

Nodemcu reset method is named after
NodeMCU [https://github.com/nodemcu/nodemcu-devkit] board where it
has been introduced for the first time. It overcomes limitations with
handling of RTS and DTR lines discussed for ck reset method
above.

Sample circuit to measure wave-form is shown below (get fzz
source).


[image: Sample circuit to check nodemcu reset method]
Sample circuit to check nodemcu reset method



Close up of voltage signals on GPIO0 and RST pins at the beginning of
firmware upload is shown below.


[image: Reset Method: nodemcu, close up at the beginning of upload]
Reset Method: nodemcu, close up at the beginning of upload



Please note that the reset sequence is about 10x shorter comparing to
ck reset (about 25ms vs. 250ms).

Next picture covers complete upload of
Blink.ino [https://github.com/esp8266/Arduino/blob/master/libraries/esp8266/examples/Blink/Blink.ino]
example at 921600 baud. Except for difference of the reset signal
sequence, the complete upload looks similar to that of ck.


[image: Reset Method: nodemcu, complete upload]
Reset Method: nodemcu, complete upload



A sample wave-form below shows another upload of
Blink.ino [https://github.com/esp8266/Arduino/blob/master/libraries/esp8266/examples/Blink/Blink.ino]
example at 921600 baud, but with two reset retries.


[image: Reset Method: nodemcu, reset retries]
Reset Method: nodemcu, reset retries



If you are interested how nodemcu reset method is implemented, then
check circuit below. As indicated it does not pull to ground RTS and DTR
lines once you open Serial Monitor in Arduino IDE.


[image: Implementation of nodemcu reset]
Implementation of nodemcu reset



It consists of two transistors and resistors that you can locate on
NodeMCU board on right. On left you can see complete circuit and the
truth table how RTS and DTR signals of the serial interface are
translated to RST and GPIO0 on the ESP. For more details please refer to
nodemcu [https://github.com/nodemcu/nodemcu-devkit] repository on
GitHub.






I’m Stuck

Hopefully at this point you were able to resolve espcomm_sync failed issue and now enjoy quick and reliable uploads of your ESP modules.

If this is still not the case, then review once more all discussed steps in the checklist below.

Initial Checks


	[ ] Is your module connected to serial port and visible in IDE?


	[ ] Is connected device responding to IDE? What is exact message in debug window?


	[ ] Have you selected correct ESP module type in Board menu? What is the selection?


	[ ] Have you tried to reduce upload speed? What speeds have you tried?




Advanced Checks


	[ ] What message is reported by ESP at 74880 baud when entering boot loading mode?


	[ ] Have you checked your USB to serial converter by looping it back? What is the result?


	[ ] Is your detailed upload log consistent with settings in IDE? What is the log?




Reset Method


	[ ] What reset method do you use?


	[ ] What is your connection diagram? Does it match diagram in this FAQ?


	[ ] What is your wave-form of board reset? Does it match wave-form in this FAQ?


	[ ] What is your wave-form of complete upload? Does it match wave-form in this FAQ?




Software


	[ ] Do you use the latest stable version of esp8266 / Arduino [https://github.com/esp8266/Arduino]? What is it?


	[ ] What is the name and version of your IDE and O/S?




If you are stuck at certain step, then post this list on ESP8266 Community Forum [https://www.esp8266.com/] asking for support.




Conclusion

With variety of available ESP8266 modules and boards, as well as
possible connection methods, troubleshooting of upload issues may take
several steps.

If you are a beginner, then use boards with integrated power supply and
USB to serial converter. Check carefully message in debug window and act
accordingly. Select your exact module type in IDE and try to adjust
upload speed. Check if board is indeed entering boot loading mode. Check
operation of your USB to serial converter with loop back. Analyze
detailed upload log for inconsistencies with IDE settings.

Verify your connection diagram and wave-form for consistency with
selected reset method.

If you get stuck, then ask community [https://www.esp8266.com/] for
support providing summary of all completed checks.


[image: Test stand used during checking of ck reset method]
Test stand used during checking of ck reset method



Test stand used for checking of ck reset method is shown above.

No any ESP module has been harmed during preparation of this FAQ item.

FAQ list :back:
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Introduction

Your ESP is self restarting. You don’t know why and what to do about it.

Do not panic.

In most of cases ESP provides enough clues on serial monitor, that you
can interpret to pin down the root cause. The first step is then
checking what ESP is saying on serial monitor when it crashes.




What ESP has to Say

Start off by opening a Serial Monitor (Ctrl+Shift+M) to observe the
output. Typical crash log looks as follows:


[image: Typical crash log]
Typical crash log



Before rushing to copy and paste displayed code to Google, reflect for a
while on the nature of observed restarts:


	Does ESP restart on random basis, or under certain conditions, like
serving a web page?


	Do you see always the same exception code and stack trace or it
changes?


	Does this issue occur with unmodified standard example code (Arduino
IDE > File > Examples)?




If restarts are random or the exception code differs between restarts,
then the problem may be caused by h/w. If the issue occurs for standard
examples and stable esp8266 /
arduino [https://github.com/esp8266/Arduino] core, them the issue is
almost certainly caused by h/w.




Get Your H/W Right

If you suspect the h/w, before troubleshooting the s/w, make sure to get
your h/w right. There is no much sense in diagnosing the s/w if you
board is randomly crashing because of not enough power, missing boot
strapping resistors or loose connections.

If you are using generic ESP modules, please follow
recommendations on power supply and
boot strapping resistors.

For boards with integrated USB-to-serial converter and power supply,
usually it is enough to connect it to an USB hub that provides standard
0.5A and is not shared with other USB devices.

In any case, make sure that your module is able to stably run standard
example sketches that establish Wi-Fi connection like, e.g.,
HelloServer.ino [https://github.com/esp8266/Arduino/tree/master/libraries/ESP8266WebServer/examples/HelloServer].




Enable compilation warnings

Most common issues may be resolved by enabling compilation warnings and fixing them.

For Arduino IDE, select File -> Preferences:


	Make sure Show verbose output during: compilation is enabled


	Set Compiler warnings to More or All




For PlatformIO, all warnings should already be enabled by default.

Notice that the default configuration of Arduino IDE inhibits all compilation warnings.
For the ESP8266 platform, some warnings should be treated as errors, otherwise it may cause unexpected issues at runtime:

int func() {
}

int other() {
  return func();
}





Should fail to build with the following message:

return-value.cpp: In function ‘int func()’:
return-value.cpp:2:1: error: no return statement in function returning non-void [-Werror=return-type]
    2 | }
      | ^
compilation terminated due to -Wfatal-errors.
cc1plus: some warnings being treated as errors





Notice that -Werror=return-type is the default starting with Core 3.0.2 w/ GCC 10.3




What is the Cause of Restart?

You have verified that the ESP h/w is healthy but it still restarts.
This is how ESP reacts to abnormal behavior of application. If something
is wrong, it restarts itself to tell you about it.

There are two typical scenarios that trigger ESP restarts:


	Exception - when the code attempts an illegal
operation,
like trying to write to non-existent memory location.


	Watchdog - if the code locks
up [https://en.wikipedia.org/wiki/Watchdog_timer], staying too long
in a loop or processing any other task without any pauses, which would
prevent vital processes like Wi-Fi communication from running.




Please check below how to recognize exception and
watchdog scenarios and what to do about it.


Exception

Typical restart because of exception looks like follows:


[image: Exception cause decoding]
Exception cause decoding



Start with looking up exception code in the Exception Causes
(EXCCAUSE)
table to understand what kind of issue it is. If you have no clues what
it’s about and where it happens, then use Arduino ESP8266/ESP32
Exception Stack Trace
Decoder [https://github.com/me-no-dev/EspExceptionDecoder] to find
out in which line of application it is triggered. Please refer to Check
Where the Code Crashes point below
for a quick example how to do it.

NOTE: When decoding exceptions be sure to include all lines between
the ---- CUT HERE ---- marks in the output to allow the decoder to also
provide the line of code that’s actually causing the exception.




Watchdog

ESP provides two watchdog timers (wdt) that observe application for lock
up.


	Software Watchdog - provided by
SDK [https://bbs.espressif.com/viewforum.php?f=46], that is part
of esp8266 / arduino [https://github.com/esp8266/Arduino] core
loaded to module together with your application.


	Hardware Watchdog - built-in ESP8266 hardware, acting if the
software watchdog is disabled for too long, in case it fails, or if
it is not provided at all.




Restart by particular type of watchdog is clearly identified by ESP on
serial monitor.

An example of application crash triggered by software wdt is shown
below.


[image: Example of restart by s/w watchdog]
Example of restart by s/w watchdog



Restart by the software watchdog is generally easier to troubleshoot
since log includes the stack trace. The trace can be then used to find
particular line in code where wdt has been triggered.

Reset by hardware watchdog timer is shown on picture below.


[image: Example of restart by h/w watchdog]
Example of restart by h/w watchdog



Hardware wdt is the last resort of ESP to tell you that application is
locked up (if s/w wdt timer is disabled or not working).

Please note that for restarts initialized by h/w wdt, there is no stack
trace to help you identify the place in code where the lockup has
happened. In such case, to identify the place of lock up, you need to
rely on debug messages like Serial.print distributed across the
application. Then by observing what was the last debug message printed
out before restart, you should be able to narrow down part of code
firing the h/w wdt reset. If diagnosed application or library has debug
option then switch it on to aid this troubleshooting.






Exception Decoder

Decoding of ESP stack trace is now easy and available to everybody
thanks to great Arduino ESP8266/ESP32 Exception Stack Trace
Decoder [https://github.com/me-no-dev/EspExceptionDecoder] developed
by @me-no-dev.

Installation for Arduino IDE is quick and easy following the
installation [https://github.com/me-no-dev/EspExceptionDecoder#installation]
instructions.

If you don’t have any code for troubleshooting, use the example below:

void setup()
{
  Serial.begin(115200);
  Serial.println();
  Serial.println("Let's provoke the s/w wdt firing...");
  //
  // provoke an OOM, will be recorded as the last occurred one
  char* out_of_memory_failure = (char*)malloc(1000000);
  //
  // wait for s/w wdt in infinite loop below
  while(true);
  //
  Serial.println("This line will not ever print out");
}

void loop(){}





Enable the Out-Of-Memory (OOM) debug option (in the Tools > Debug Level
menu), compile/flash/upload this code to your ESP (Ctrl+U) and start Serial
Monitor (Ctrl+Shift+M).  You should shortly see ESP restarting every couple
of seconds and Soft WDT reset message together with stack trace showing
up on each restart.  Click the Autoscroll check-box on Serial Monitor to
stop the messages scrolling up.  Select and copy the stack trace, including
the last failed alloc call: ... line, go to the Tools and open the
ESP Exception Decoder.


[image: Decode the stack trace, steps 1 and 2]
Decode the stack trace, steps 1 and 2



Now paste the stack trace to Exception Decoder’s window. At the bottom
of this window you should see a list of decoded lines of sketch you have
just uploaded to your ESP. On the top of the list, like on the top of
the stack trace, there is a reference to the last line executed just
before the software watchdog timer fired causing the ESP’s restart.
Check the number of this line and look it up on the sketch. It should be
the line Serial.println("Let's provoke the s/w wdt firing..."), that
happens to be just before while(true) that made the watchdog fired
(ignore the lines with comments, that are discarded by compiler).


[image: Decode the stack trace, steps 3 through 6]
Decode the stack trace, steps 3 through 6



Armed with Arduino ESP8266/ESP32 Exception Stack Trace
Decoder [https://github.com/me-no-dev/EspExceptionDecoder] you can
track down where the module is crashing whenever you see the stack trace
dropped. The same procedure applies to crashes caused by exceptions.


Note, to decode the exact line of code where the application
crashed, you need to use ESP Exception Decoder in context of sketch
you have just loaded to the module for diagnosis. Decoder is not
able to correctly decode the stack trace dropped by some other
application not compiled and loaded from your Arduino IDE.







Improving Exception Decoder Results

Due to the limited resources on the device, our default compiler optimizations
focus on creating the smallest code size (.bin file). The GCC compiler’s
option -Os contains the base set of optimizations used. This set is fine for
release but not ideal for debugging.

Our view of a crash is often the Stack Dump
which gets copy/pasted into an Exception Decoder.
For some situations, the optimizer doesn’t write caller return addresses to the
stack. When we crash, the list of functions called is missing. And when the
crash occurs in a leaf function, there is seldom if ever any evidence of who
called.

With the -Os option, functions called once are inlined into the calling
function. A chain of these functions can optimize down to the calling function.
When the crash occurs in one of these chain functions, the actual location in
the source code is no longer available.

When you select Debug Optimization: Lite on the Arduino IDE Tools menu, it
turns off optimize-sibling-calls. Turning off this optimization allows more
caller addresses to be written to the stack, improving the results from the
Exception Decoder. Without this option, the callers involved in the crash may be
missing from the Decoder results. Because of the limited stack space, there is
the remote possibility that removing this optimization could lead to more
frequent stack overflows. You only want to do this in a debug setting. This
option does not help the chained function issue.

When you select Debug Optimization: Optimum, you get an even more complete
stack trace. For example, chained function calls may show up. This selection
uses the compiler option -Og. GCC considers this the ideal optimization for
the “edit-compile-debug cycle” … “producing debuggable code.” You can read the
specifics at GCC’s Optimize Options [https://gcc.gnu.org/onlinedocs/gcc/Optimize-Options.html]

When global optimization creates build size issues or stack overflow issues,
select Debug Optimization: None, and use a targeted approach with
#pragma GCC optimize("Og") at the module level. Or, if you want to use a
different set of optimizations, you can set optimizations through build options.
Read more at Global Build Options.

For non-Arduino IDE build platforms, you may need to research how to add build
options. Some build platforms already use -Og for debug builds.

A crash in a leaf function may not leave the caller’s address on the stack.
The return address can stay in a register for the duration of the call.
Resulting in a crash report identifying the crashing function without a
trace of who called. You can encourage the compiler to save the caller’s
return address by adding an inline assembly trick
__asm__ __volatile__("" ::: "a0", "memory"); at the beginning of the
function’s body. Or instead, for a debug build conditional option, use the
macro DEBUG_LEAF_FUNCTION() from #include <debug.h>. For compiler
toolchain 3.2.0 and above, the -Og option is an alternative solution.

In some cases, adding #pragma GCC optimize("Og,no-ipa-pure-const") to a
module as well as using DEBUG_LEAF_FUNCTION() in a leaf function were
needed to display a complete call chain. Or use
#pragma GCC optimize("Os,no-inline,no-optimize-sibling-calls,no-ipa-pure-const")
if you require optimization -Os.




Other Causes for Crashes


	Interrupt Service Routines
	By default, all functions are compiled into flash, which means that the
cache may kick in for that code. However, the cache currently can’t be used
during hardware interrupts. That means that, if you use a hardware ISR, such as
attachInterrupt(gpio, myISR, CHANGE) for a GPIO change, the ISR must have the
IRAM_ATTR attribute declared. Not only that, but the entire function tree
called from the ISR must also have the IRAM_ATTR declared.
Be aware that every function that has this attribute reduces available memory.

In addition, it is not possible to execute delay() or yield() from an ISR,
or do blocking operations, or operations that disable the interrupts, e.g.: read
a DHT.

Finally, an ISR has very high restrictions on timing for the executed code, meaning
that executed code should not take longer than a very few microseconds. It is
considered best practice to set a flag within the ISR, and then from within the loop()
check and clear that flag, and execute code.



	Asynchronous Callbacks
	Asynchronous CBs, such as for the Ticker or ESPAsync* libs, have looser restrictions
than ISRs, but some restrictions still apply.
It is not possible to execute delay() or yield() from an asynchronous callback.
Timing is not as tight as an ISR, but it should remain below a few milliseconds. This
is a guideline. The hard timing requirements depend on the WiFi configuration and
amount of traffic. In general, the CPU must not be hogged by the user code, as the
longer it is away from servicing the WiFi stack, the more likely that memory corruption
can happen.



	Memory, memory, memory
	Running out of heap is the most common cause for crashes. Because the build process for
the ESP leaves out exceptions (they use memory), memory allocations that fail will do
so silently. A typical example is when setting or concatenating a large String. If
allocation has failed internally, then the internal string copy can corrupt data, and
the ESP will crash.

In addition, doing many String concatenations in sequence, e.g.: using operator+()
multiple times, will cause memory fragmentation. When that happens, allocations may
silently fail even though there is enough total heap available. The reason for the
failure is that an allocation requires finding a single free memory block that is large
enough for the size being requested. A sequence of String concatenations causes many
allocations/deallocations/reallocations, which makes “holes” in the memory map. After
many such operations, it can happen that all available holes are too small to comply
with the requested size, even though the sum of all holes is greater than the requested
size.

So why do these silent failures exist? On the one hand, there are specific interfaces that
must be adhered to. For example, the String object methods don’t allow for error handling
at the user application level (i.e.: no old-school error returns).
On the other hand, some libraries don’t have the allocation code accessible for
modification. For example, std::vector is available for use. The standard implementations
rely on exceptions for error handling, which is not available for the ESP, and in any
case there is no access to the underlying code.

Instrumenting the code with the OOM debug option and calls to
ESP.getFreeHeap() / ESP.getHeapFragmentation() /
ESP.getMaxFreeBlockSize() will help the process of finding memory issues.

Now is time to re-read about the exception decoder.





Some techniques for reducing memory usage



	Don’t use const char * with literals. Instead, use const char[] PROGMEM. This is particularly true if you intend to, e.g.: embed html strings.


	Don’t use global static arrays, such as uint8_t buffer[1024]. Instead, allocate dynamically. This forces you to think about the size of the array, and its scope (lifetime), so that it gets released when it’s no longer needed. If you are not certain about dynamic allocation, use std libs (e.g.: std:vector, std::string), or smart pointers. They are slightly less memory efficient than dynamically allocating yourself, but the provided memory safety is well worth it.


	If you use std libs like std::vector, make sure to call its ::reserve() method before filling it. This allows allocating only once, which reduces mem fragmentation, and makes sure that there are no empty unused slots left over in the container at the end.








	Stack
	The amount of stack in the ESP is tiny at only 4KB. For normal development in large systems, it
is good practice to use and abuse the stack, because it is faster for allocation/deallocation, the scope of the object is well defined, and deallocation automatically happens in reverse order as allocation, which means no mem fragmentation. However, with the tiny amount of stack available in the ESP, that practice is not really viable, at least not for big objects.


	Large objects that have internally managed memory, such as String, std::string, std::vector, etc, are ok on the stack, because they internally allocate their buffers on the heap.


	Large arrays on the stack, such as uint8_t buffer[2048] should be avoided on the stack and should be dynamically allocated instead (consider smart pointers).


	Objects that have large data members, such as large arrays, should also be avoided on the stack, and should be dynamically allocated (consider smart pointers).











If at the Wall, Enter an Issue Report

Using the procedure above you should be able to troubleshoot all the
code you write. It may happen that ESP is crashing inside some library
or code you are not familiar enough to troubleshoot. If this is the case
then contact the application author by writing an issue report.

Follow the guidelines on issue reporting that may be provided by the
author of code in his / her repository.

If there are no guidelines, include in your report the following:


	[ ] Exact step-by-step instructions to reproduce the issue


	[ ] Your exact hardware configuration including the schematic


	[ ] If the issue concerns a standard, commercially available ESP board
with power supply and USB interface, without extra h/w attached, then
provide just the board type or a link to its description


	[ ] Configuration settings in Arduino IDE used to upload the
application


	[ ] Error log & messages produced by the application (enable
debugging for more details)


	[ ] Decoded stack trace


	[ ] Copy of your sketch


	[ ] Copy of all the libraries used by the sketch (if you are using
standard libraries available in the Arduino Library Manager,
then provide just version numbers)


	[ ] Version of esp8266 /
Arduino [https://github.com/esp8266/Arduino] core


	[ ] Name and version of your programming IDE and O/S




With plenty of ESP module types available, several versions of libraries
or esp8266 / Arduino [https://github.com/esp8266/Arduino] core,
types and versions of O/S, you need to provide exact information on what
your application is about. Only then, people willing to look into your
issue may be able to compare it to a configuration they are familiar with.
If you are lucky, they may even attempt to reproduce your issue on their
own equipment!
This will be far more difficult if you provide only vague details,
so somebody would need to ask you to find out what is really happening.

On the other hand, if you flood your issue report with hundreds lines of
code, you may also have difficulty finding somebody willing to analyze
it. Therefore, reduce your code to the bare minimum that is still causing
the issue. This will also help to isolate the issue and pin down
the root cause.




Conclusion

Do not be afraid to troubleshoot ESP exception and watchdog restarts.
Esp8266 / Arduino [https://github.com/esp8266/Arduino] core provides
detailed diagnostics that will help you pin down the issue. Before
checking the s/w, get your h/w right. Use ESP Exception
Decoder [https://github.com/me-no-dev/EspExceptionDecoder] to find
out where the code fails. If you do you homework and are still unable to
identify the root cause, submit an issue report. Provide enough details.
Be specific and isolate the issue. Then ask community for support. There
are plenty of people that like to work with ESP and willing to help with
your problem.
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This Arduino library doesn’t work on ESP. How do I make it working?


	Introduction


	Identify the Issues


	Fix it Yourself


	Compilation Errors


	Exceptions / Watchdog Resets


	Functionality Issues


	Conclusion





Introduction

You would like to use this Arduino library with ESP8266 and it doesn’t
perform. It is not listed among libraries verified to work with
ESP8266.
You couldn’t find any evidence on internet that it is compatible.

What are the odds to make it working?




Identify the Issues

Start with looking for all the symptoms that it is not compatible with
ESP8266. Ideally use example sketches provided with the library. Then
list all the issues you are able to identify.

You are likely to see one or more of the following: * Compilation drops
errors * There are no issues with compilation but application restarts
because of exception or watchdog (wdt) * Application seems to work, but
does not function as expected, e.g. calculation results are incorrect.

Armed with the list of issues, contact the library author asking for
comments. If issues are legitimate, then ask for his / her support to
implement it for ESP8266. Being specific you have bigger chances
convincing the author to help you either by updating the library or
guiding you how to resolve the issues.




Fix it Yourself

If library author is unable to provide support, then assess the chances
of fixing it yourself.


Compilation Errors

Issue: Compiler complains about usage of AVR registers (PORTx, PINx,
TCR1A, etc).

Solution: Check if usage of registers is well localized in a few
functions, try to replace GPIO registers usage with digitalRead /
digitalWrite, timer registers usage with timerX_ functions. If usage of
AVR registers happens all over the code, this library might not be worth
the effort. Also may be worth checking if someone got the library
working on ARM (Due/STM), PIC, etc. If this is the case, maybe there
already is a version of the library which uses Arduino APIs instead of
raw registers.

Issue: Compiler complains about <avr/pgmspace.h>.

Solution: modify the library by adding conditional include of ESP’s
pgmspace.h.

#ifdef ESP8266
  #include <pgmspace.h>
#else
  #include <avr/pgmspace.h>
#endif








Exceptions / Watchdog Resets

To troubleshoot resets follow FAQ item My ESP crashes running some
code.




Functionality Issues

Issue: Application works but returns weird numerical values.

Solution:: Check the usage of int type in the library. On AVRs
integers are 16 bit, and on ESPs they are 32 bit (just like on ARM).

Issue: Some device with time critical control like a servo drive or a
strip of LEDs does not operate smoothly and tends to randomly change
position or displayed pattern.

Solution:: Check for usage of interrupts that may get in conflict with
Wi-Fi activity of ESP8266. You may temporarily disable Wi-Fi
communication WiFi.mode(WIFI_OFF); to check if it helps.






Conclusion

Identify compatibility issues and ask library author for support. If
left on your own, then check for usage of controller’s low level access
functionality. Use Esp Exception
Decoder [https://github.com/me-no-dev/EspExceptionDecoder] if
confronted with exceptions / watchdogs resets.

The good news is that the number of libraries which aren’t supported on
the ESP8266 is shrinking. Community of ESP8266 enthusiasts is growing.
If you are unable to resolve the issues yourself, there are very good
odds that you will be able to find somebody else to help you.
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How to resolve “Board generic (platform esp8266, package esp8266) is unknown” error?

This error may pop up after switching between
staging [https://github.com/esp8266/Arduino#staging-version-] and
stable [https://github.com/esp8266/Arduino#stable-version-] esp8266
/ Arduino package installations, or after upgrading the package version.


[image: Board nodemcu2 (platform esp8266, package esp8266) is unknown error]


If you face this issue, you will not be able to compile any sketch for
any ESP8266 module type.

Read below what is the error root cause or jump straight to the
resolution


The Root Cause

This issue is attributed to Arduino IDE Boards Manager not cleaning up
previous package installation before a new one is applied. As this is
not done, then it is user responsibility to remove previous package
before applying a new one.

To prevent it from happening, if you are changing between staging
and stable, first press Remove button to delete currently used
installation.


[image: If changing between staging and stable, remove currently installed package]


There is no need to remove the installed package if you are changing it
to another version (without switching between staging and stable).


[image: No need to remove installed package if changing its version]


Depending on selected module the error message is slightly different.
For instance, if you choose Generic ESP8266 Module, it will look as
follows:

Board generic (platform esp8266, package esp8266) is unknown
Error compiling for board Generic ESP8266 Module.





Below is an example messages for
WeMos:

Board d1_mini (platform esp8266, package esp8266) is unknown
Error compiling for board WeMos D1 R2 & mini.





… and another one for Adafruit Feather
HUZZAH:

Board huzzah (platform esp8266, package esp8266) is unknown
Error compiling for board Adafruit HUZZAH ESP8266.





If the issue already happens, then uninstalling and re-installing the
package with Boards Manager typically will not fix it.

Uninstalling and re-installing the Arduino IDE will not fix it as well.

Well, OK, fine. You will be able to fix it with Boards Manager. To do
so, you need to carefully go step by step through the effort of removing
new and then the old package. Once done you can install again the new
package. Did I mention that in between you need to change twice
JOSN [https://github.com/esp8266/Arduino#installing-with-boards-manager]
in Additional Boards Manager URLs?

Fortunately there is a quicker and more effective fix. See below.




How to Fix it?

Issue resolution is as simple as deleting a folder with older esp8266 /
Arduino installation.

Procedure is identical on Windows, Linux and Mac OS. The only difference
is folder path. For instance, on Mac, it will be
/Users/$USER/Library/Arduino15/packages/esp8266/hardware/esp8266.
Example below shows the path for Windows.


	Check location of installation folder by going to File >
Preferences (Ctrl+,). The folder location is at the very bottom of
the Preferences window.





[image: Checking of Arduino IDE Preferences]



	Click provided link to open the folder. For Windows 7 it will look as
follows:





[image: Contents of Arduino IDE preferences folder]



	Navigate further down to
Arduino15\packages\esp8266\hardware\esp8266 directory. Inside you
will find two folders with different esp8266 / Arduino package
installations.





[image: Checking of contents of esp8266 / Arduino package folder]



	Delete the older folder. Restart Arduino IDE, select your ESP module
and the error should be gone.




Note: If you are not sure which folder to delete, then remove both of
them. Restart Arduino IDE, go to Tools > Board: > Boards Manager and
install the esp8266 / Arduino package again. Select ESP8266 module and
the issue should be resolved.




More Information

This issue has been reported quite frequently in
Issues [https://github.com/esp8266/Arduino/issues] section of
esp8266 / Arduino repository. The most appreciated solution was provided
by [@anhhuy0501](https://github.com/anhhuy0501) in
#1387 [https://github.com/esp8266/Arduino/issues/1387#issuecomment-204865028].

If you are interested in more details, please refer to
#2297 [https://github.com/esp8266/Arduino/issues/2297],
#2156 [https://github.com/esp8266/Arduino/issues/2156],
#2022 [https://github.com/esp8266/Arduino/issues/2022],
#1802 [https://github.com/esp8266/Arduino/issues/1802],
#1514 [https://github.com/esp8266/Arduino/issues/1514],
#1387 [https://github.com/esp8266/Arduino/issues/1387],
#1377 [https://github.com/esp8266/Arduino/issues/1377],
#1251 [https://github.com/esp8266/Arduino/issues/1251],
#1247 [https://github.com/esp8266/Arduino/issues/1247],
#948 [https://github.com/esp8266/Arduino/issues/948]







            

          

      

      

    

  

    
      
          
            
  
Board generator

The board generator is a python script originally intended to ease the
Arduino IDE’s boards.txt configuration file about the multitude of
available boards, especially when common parameters have to be updated for
all of them.

This script is also used to manage uncommon options that are currently not
available in the IDE menu.


	How can I run the script ?


	What can I do with it ?


	When do I need to update it ?


	Why is my pull-request failing continuous-integration ?





How can I run the script ?

Python needs to be installed on your system.

The script is located in the tools subdirectory of the core’s root installation.
It needs to be run from the root directory,

$ tools/boards.txt.py





C:\...> tools\boards.txt.py
C:\...> python tools\boards.txt.py





Running without parameters will show the command line help.  They are
generally self-explanatory.  Running with the parameters will show no output but will generate a new boards.txt file (and a backup boards.txt.orig).

The core root directory varies depending on your development environment.  In Windows, core root is found under your home directory; for Arduino it is in AppDataLocalArduino15packagesesp8266hardwareesp82662.4.2for PlatformIO it is in .platformiopackagesframework-arduinoespressif8266.




What can I do with it ?

As of today you can:


	in the IDE: change the default serial programming speed of any board


	in the IDE: add new serial programming speed


	increase available flash space by disabling floats in *printf functions


	change led pin LED_BUILTIN for the two generic boards


	create an abridged boards.txt file







When do I need to mess with it ?

The board generator is used to automate generation of configuration files
when possible.  It needs to be edited for:


	All information for specific boards.  This is the only place where a new
board (definition, description) can be updated or added to the existing
list.


	Memory mapping for ldscripts (flash and spiffs size combinations)







Why is my pull-request failing continuous-integration ?

The generator is able to update a number of files (see list in help), and
global coherency can be checked by the continuous integration facilities.

After a modification in the generator, it is mandatory to regenerate all
files (option --allgen) and add them in the pull-request.




How to create an abridged boards.txt file

The list of boards presented by the IDE has gotten quite long. You can reduce
the ESP8266 boards shown by the IDE to a favorites list. This can
be done by generating a new boards.txt file using the --filter <file>
option.

Start by getting a current list of boards supported by boards.txt.py.
This command will write a list of supported board names to favorites.txt.

./tools/boards.txt.py --boardnames >favorites.txt





Edit favorites.txt, keeping the name of the boards you want generated in
boards.txt.

to generate a new abridged boards.txt run:

./tools/boards.txt.py --boardsgen --filter favorites.txt





You can turn the process around by creating a list of boards, you do not want
to be generated. To do this we use the --xfilter <file> option.

to generate this abridged boards.txt run:

./tools/boards.txt.py --boardsgen --xfilter favorites.txt





Yet another option, you can split the boards between boards.txt and
boards.local.txt.

The commands below will generate a boards.txt file that omits the boards named
in favorites.txt, and generates a boards.local.txt ( via option --boardslocalgen ) that only contains boards
named in favorites.txt.

./tools/boards.txt.py --boardsgen --xfilter favorites.txt
./tools/boards.txt.py --boardslocalgen --filter favorites.txt





Additional Notes:


	The boards.txt file will always contain the generic and esp8285 boards.


	If boards.txt file exist and no backup copy named boards.txt.orig exist, the current boards.txt will be renamed to boards.txt.orig. Otherwise, the existing boards.txt is over-written when you generate a new boards.txt file. Similar behavior for when generating a new boards.local.txt.


	The boards in the boards.txt file will be in the order they were listed in your favorites file, specified by option --filter <file>.


	It is outside the scope of this document, but you could manually edit any boards.txt file to have fewer boards. One last observation, the Arduino IDE appears to need at least one board in a board.txt file.
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How to specify global build defines and options

To create globally usable macro definitions for a Sketch, create a file
with a name based on your Sketch’s file name followed by .globals.h
in the Sketch folder. For example, if the main Sketch file is named
LowWatermark.ino, its global .h file would be
LowWatermark.ino.globals.h. This file will be implicitly included
with every module built for your Sketch. Do not directly include it in
any of your sketch files or in any other source files. There is no need
to create empty/dummy files, when not used.

This global .h also supports embedding compiler command-line options
in a unique “C” block comment. Compiler options are placed in a “C”
block comment starting with /*@create-file:build.opt@. This
signature line must be alone on a single line. The block comment ending
*/ should also be alone on a single line. In between, place your
compiler command-line options just as you would have for the GCC @file
command option.

Actions taken in processing comment block to create build.opt


	for each line, white space is trimmed


	blank lines are skipped


	lines starting with *, //, or # are skipped


	the remaining results are written to build tree/core/build.opt


	multiple /*@create-file:build.opt@ */ comment blocks are not
allowed


	build.opt is finished with a -include ... command, which
references the global .h its contents were extracted from.




Example Sketch: LowWatermark.ino

#include <umm_malloc/umm_malloc.h>  // has prototype for umm_free_heap_size_min()

void setup() {
  Serial.begin(115200);
  delay(200);
#ifdef MYTITLE1
  Serial.printf("\r\n" MYTITLE1 MYTITLE2 "\r\n");
#else
  Serial.println("ERROR:  MYTITLE1 not present");
#endif
  Serial.printf("Heap Low Watermark %u\r\n", umm_free_heap_size_min());
}

void loop() {}





Global .h file: LowWatermark.ino.globals.h

/*@create-file:build.opt@
// An embedded build.opt file using a "C" block comment. The starting signature
// must be on a line by itself. The closing block comment pattern should be on a
// line by itself. Each line within the block comment will be space trimmed and
// written to build.opt, skipping blank lines and lines starting with '//', '*'
// or '#'.

 * this line is ignored
 # this line is ignored
-DMYTITLE1="\"Running on \""
  -O3
//-fanalyzer
-DUMM_STATS_FULL=1
*/

#ifndef LOWWATERMARK_INO_GLOBALS_H
#define LOWWATERMARK_INO_GLOBALS_H

#if !defined(__ASSEMBLER__)
// Defines kept away from assembler modules
// i.e. Defines for .cpp, .ino, .c ... modules
#endif

#if defined(__cplusplus)
// Defines kept private to .cpp and .ino modules
//#pragma message("__cplusplus has been seen")
#define MYTITLE2 "Empty"
#endif

#if !defined(__cplusplus) && !defined(__ASSEMBLER__)
// Defines kept private to .c modules
#define MYTITLE2 "Full"
#endif

#if defined(__ASSEMBLER__)
// Defines kept private to assembler modules
#endif

#endif








Separate production and debug build options

If your production and debug build option requirements are different,
adding mkbuildoptglobals.extra_flags={build.debug_port} to
platform.local.txt will create separate build option groups for
debugging and production. For the production build option group, the “C”
block comment starts with /*@create-file:build.opt@, as previously
defined. For the debugging group, the new “C” block comment starts with
/*@create-file:build.opt:debug@. You make your group selection
through “Arduino->Tools->Debug port” by selecting or disabling the
“Debug port.”

Options common to both debug and production builds must be included in
both groups. Neither of the groups is required. You may also omit either
or both.

Reminder with this change, any old “sketch” with only a “C” block
comment starting with /*@create-file:build.opt@ would not use a
build.opt file for the debug case. Update old sketches as needed.

Updated Global .h file: LowWatermark.ino.globals.h

/*@create-file:build.opt:debug@
// Debug build options
-DMYTITLE1="\"Running on \""
-DUMM_STATS_FULL=1

//-fanalyzer

// Removing the optimization for "sibling and tail recursive calls" may fill
// in some gaps in the stack decoder report. Preserves the stack frames
// created at each level as you call down to the next.
-fno-optimize-sibling-calls
*/

/*@create-file:build.opt@
// Production build options
-DMYTITLE1="\"Running on \""
-DUMM_STATS_FULL=1
-O3
*/

#ifndef LOWWATERMARK_INO_GLOBALS_H
#define LOWWATERMARK_INO_GLOBALS_H

#if defined(__cplusplus)
#define MYTITLE2 "Empty"
#endif

#if !defined(__cplusplus) && !defined(__ASSEMBLER__)
#define MYTITLE2 "Full"
#endif

#ifdef DEBUG_ESP_PORT
// Global Debug defines
// ...
#else
// Global Production defines
// ...
#endif

#endif








Aggressively cache compiled core

This feature appeared with the release of Arduino IDE 1.8.2. The feature
“Aggressively Cache Compiled core” refers to sharing a single copy of
core.a across all Arduino IDE Sketch windows. This feature is on by
default. core.a is an archive file containing the compiled objects
of ./core/esp8266/*. Created after your 1ST successful compilation.
All other open sketch builds use this shared file. When you close all
Arduino IDE windows, the core archive file is deleted.

This feature is not compatible with using global defines or compiler
command-line options. Without mediation, bad builds could result, when
left enabled. When #define changes require rebuilding core.a and
multiple Sketches are open, they can no longer reliably share one cached
core.a. In a simple case: The 1st Sketch to be built has its version
of core.a cached. Other sketches will use this cached version for
their builds.

There are two solutions to this issue:


	Do nothing, and rely on aggressive cache workaround built into the
script.


	Turn off the “Aggressively Cache Compiled core” feature, by setting
compiler.cache_core=false.





Using “compiler.cache_core=false”

There are two ways to turn off the “Aggressively Cache Compiled core”
feature: This can be done with the Arduino IDE command-line or a text
editor.

Using the Arduino IDE command-line from a system command line, enter the
following:

arduino --pref compiler.cache_core=false --save-prefs





For the text editor, you need to find the location of
preferences.txt. From the Arduino IDE, go to File->Preferences.
Make note of the path to prefereces.txt. You cannot edit the file
while the Arduino IDE is running. Close all Arduino IDE windows and edit
the file preferences.txt. Change compiler.cache_core=true to
compiler.cache_core=false and save. Then each sketch will maintain
its own copy of core.a built with the customization expressed by
their respective build.opt file.




The “workaround”

When the “Aggressively Cache Compiled core” feature is enabled and the
global define file is detected, a workaround will turn on and stay on.
When you switch between Sketch windows, core will be recompiled and the
cache updated. The workaround logic is reset when Arduino IDE is
completely shutdown and restarted.

The workaround is not perfect. These issues may be of concern:


	Dirty temp space. Arduino build cache files left over from a previous
run or boot.


	Arduino command-line options:


	override default preferences.txt file.


	override a preference, specifically compiler.cache_core.






	Multiple versions of the Arduino IDE running




Dirty temp space

A minor concern, the workaround is always on. Not an issue for build
accuracy, but core.a maybe rebuild more often than necessary.

Some operating systems are better at cleaning up their temp space than
others at reboot after a crash. At least for Windows®, you may need to
manually delete the Arduino temp files and directories after a crash.
Otherwise, the workaround logic may be left on. There is no harm in the
workaround being stuck on, the build will be correct; however, the core
files will occasionally be recompiled when not needed.

For some Windows® systems the temp directory can be found near
C:\Users\<user id>\AppData\Local\Temp\arduino*. Note AppData is
a hidden directory. For help with this do an Internet search on
windows disk cleanup. Or, type disk cleanup in the Windows®
taskbar search box.

With Linux, this problem could occur after an Arduino IDE crash. The
problem would be cleared after a reboot. Or you can manually cleanup the
/tmp/ directory before restarting the Arduino IDE.

Arduino command-line option overrides

If you are building with compiler.cache_core=true no action is
needed. If false the script would benefit by knowing that.

When using either of these two command-line options:

./arduino --preferences-file other-preferences.txt
./arduino --pref compiler.cache_core=false





Hints for discovering the value of compiler.cache_core, can be
provided by specifying mkbuildoptglobals.extra_flags=... in
platform.local.txt.

Examples of hints:

mkbuildoptglobals.extra_flags=--preferences_sketch            # assume file preferences.txt in the sketch folder
mkbuildoptglobals.extra_flags=--preferences_sketch "pref.txt" # is relative to the sketch folder
mkbuildoptglobals.extra_flags=--no_cache_core
mkbuildoptglobals.extra_flags=--cache_core
mkbuildoptglobals.extra_flags=--preferences_file "other-preferences.txt" # relative to IDE or full path





If required, remember to quote file or file paths.

Multiple versions of the Arduino IDE running

You can run multiple Arduino IDE windows as long as you run one version
of the Arduino IDE at a time. When testing different versions,
completely exit one before starting the next version. For example,
Arduino IDE 1.8.19 and Arduino IDE 2.0 work with different temp and
build paths. With this combination, the workaround logic sometimes fails
to enable.

At the time of this writing, when Arduino IDE 2.0 rc5 exits, it leaves
the temp space dirty. This keeps the workaround active the next time the
IDE is started. If this is an issue, manually delete the temp files.






Custom build environments

Some custom build environments may have already addressed this issue by
other means. If you have a custom build environment that does not
require this feature and would like to turn it off, you can add the
following lines to the platform.local.txt used in your build
environment:

recipe.hooks.prebuild.2.pattern=
build.opt.flags=








Other build confusion


	Renaming a file does not change the last modified timestamp, possibly
causing issues when adding a file by renaming and rebuilding. A good
example of this problem would be to have then fixed a typo in file
name LowWatermark.ino.globals.h. You need to touch (update
timestamp) the file so a “rebuild all” is performed.


	When a .h file is renamed in the sketch folder, a copy of the old
file remains in the build sketch folder. This can create confusion if
you missed an edit in updating an #include in one or more of your
modules. That module will continue to use the stale version of the
.h until you restart the IDE or other major changes that would
cause the IDE to delete and recopy the contents from the source
Sketch directory. Changes on the IDE Tools board settings may cause a
complete rebuild, clearing the problem. This may be the culprit for
“What! It built fine last night!”
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